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PREFACE 
 

The Volpe National Transportation Systems Center (Volpe Center) of the United States 
Department of Transportation’s Research and Innovative Technology Administration has 
developed a modeling system to assist the National Highway Traffic Safety Administration 
(NHTSA) in the evaluation of potential new Corporate Average Fuel Economy (CAFE) 
standards.  Given externally-developed inputs, the modeling system estimates how 
manufacturers could apply additional fuel-saving technologies in response to new CAFE 
standards, and estimates how doing so would, relative to a given baseline scenario, increase 
vehicle costs, reduce national fuel consumption and carbon dioxide emissions, and result in other 
effects and benefits to society.  The modeling system can also be used to estimate the stringency 
at which an attribute-based CAFE standard satisfies various criteria.  For example, the system 
can estimate the stringency that produces a specified average required fuel economy level, or that 
maximizes net benefits to society. 
 
This report documents the design and function of the CAFE Compliance and Effects Modeling 
System as of November 14, 2011; specifies the content, structure, and meaning of inputs and 
outputs; and provides instructions for the installation and use of the modeling system. 
 
The authors of this report are Mark Shaulov, Kevin Green, Ryan Harrington, Joe Mergel, Donald 
Pickrell, and John Van Schalkwyk. 
 
The authors acknowledge the technical contributions of individuals who have been involved in 
guiding recent changes to the modeling system, including Ken Katz, Gregory Powell, Jim 
Tamm, and Lixin Zhao of NHTSA.  The authors further acknowledge former DOT staff who 
participated in the development of earlier versions of the modeling system, including Gregory 
Ayres, Phil Gorney, Kristina Lopez-Bernal, José Mantilla, Arthur Rypinski, and Kenneth 
William. 
 
The authors further acknowledge the technical contributions of individuals who have reviewed 
detailed results of the model (and/or earlier versions of the model) and/or provided specific 
suggestions regarding the model’s design.  Among these individuals are Steve Plotkin and 
Michael Wang of the Department of Energy’s Argonne National Laboratory, Jeff Alson, William 
Charmley, Ben Ellies, David Haugen, Ari Kahan, Richard Rykowski, and Todd Sherwood of the 
U.S. Environmental Protection Agency (EPA), Gary Rogers of FEV Engine Technology, Inc., 
David Boggs, Anrico Casadei, Scott Ellsworth, and Sandy Stojkovski of Ricardo, Inc., Jamie 
Hulan of Transport Canada, and Jonathan Rubin of the University of Maine. 
 
NHTSA is making this draft documentation available at this time to facilitate review of and 
comment on the agency’s analysis supporting proposed CAFE standards for model years 2017 
and beyond, and to facilitate planned peer review of the CAFE Compliance and Effects 
Modeling System, which has undergone a range of modifications since NHTSA last arranged a 
formal peer review of the system.  The agency anticipates some further revisions—in particular, 
the integration of a vehicle choice model currently under development—prior to undertaking a 
new formal peer review; such revisions will be reflected in updates to documentation provided to 
support the planned peer review. 
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SURVv ........................ average survival rate at vintage v 
SOx ............................ sulfur oxides 
SUV ........................... sport utility vehicle 
t ................................. calendar year 
v ................................. vehicle vintage 
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VALUEfuel .................. value of saved fuel 
VMT ........................... vehicle miles traveled 
Volume ...................... volume after which technology learning effects are realized 
VVLT ......................... variable valve lift and timing 
VVT ........................... variable valve timing 
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 Introduction 
 
The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence and 
Security Act of 2007 (EISA), requires the National Highway Traffic Safety Administration 
(NHTSA), an agency within the U.S. Department of Transportation (DOT), to promulgate and 
enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA has been administering 
these standards since 1975. 
 
The Volpe National Transportation Systems Center (Volpe Center) provided technical support to 
the Department in connection with the establishment of the CAFE program in the 1970s, and has 
continued to provide such support since that time. The Volpe Center is a Federal fee-for-service 
organization within DOT's Research and Innovative Technology Administration (RITA). 
 
In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s 
analysis of options for future CAFE standards. Objectives included, but were not limited to, the 
following: the ability to utilize detailed projections of light vehicle fleets to be produced for sale 
in the United States, the ability to efficiently estimate how manufacturers could apply available 
technologies in response to CAFE standards, the ability to quickly evaluate various options for 
future CAFE standards, and the ability to estimate a range of outcomes (in particular, changes in 
fuel consumption and emissions) resulting from such standards. 
 
Since 2002, the Volpe Center has made many changes to this modeling system. Some changes 
were made in response to comments submitted to NHTSA in connection with CAFE 
rulemakings, and in response to a formal peer review of the system. Some changes were made 
based on observations by NHTSA and Volpe Center technical staff. As NHTSA began 
evaluating attribute-based CAFE standards (i.e., standards under which CAFE requirements 
depend on the mix of vehicles produced for U.S. sale), significant changes were made to enable 
evaluation of such standards. At the same time, the system was expanded to provide the ability to 
perform uncertainty analysis by randomly varying many inputs. Later, the system was further 
expanded to provide automated statistical calibration of attribute-based standards, through 
implementation of Monte Carlo techniques, as well as automated estimation of stringency levels 
that meet specified characteristics (such as maximizing estimated net benefits to society). In 
2007, NHTSA and Volpe Center staff worked with technical staff of the U.S. Environmental 
Protection Agency (EPA) on major changes to the range of fuel-saving technologies 
accommodated by the model, as well as the logical pathways for applying such technologies.  In 
2008, NHTSA and Volpe Center staff collaborated on further revisions, particularly with respect 
to the representation of available fuel-saving technologies, support for the reexamination of 
which was provided by Ricardo, Inc. 
 
In support of the 2010 rulemaking, a multi-year technology application feature was introduced 
into the modeling system.  Additionally, for the 2011 rulemaking, a feature to evaluate voluntary 
overcompliance has been added as well. 
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 System Design 
 
 Overall Structure 
 
The basic design of the CAFE Compliance and Effects Modeling System developed by the 
Volpe Center is as follows: The system first estimates how manufacturers might respond to a 
given CAFE scenario, and from that the system estimates what impact that response will have on 
fuel consumption, emissions, and economic externalities. A CAFE scenario involves 
specification of the form, or shape, of the standards (e.g., flat standards, linear or logistic 
attribute-based standards, scope of passenger and nonpassenger regulatory classes), and 
stringency of the CAFE standard in each model year to be analyzed. 
 
Manufacturer compliance simulation and effects estimation encompass numerous subsidiary 
elements. Compliance simulation begins with a detailed initial forecast, provided by the user, of 
the vehicle models offered for sale during the simulation period. The compliance simulation then 
attempts to bring each manufacturer into compliance with CAFE standards defined in an input 
file developed by the user; for example, CAFE standards that increase in stringency by 4 percent 
per year for 5 consecutive years, and so forth. The model sequentially applies various 
technologies to different vehicle models in each manufacturer’s product line in order to simulate 
how a manufacturer might make progress toward compliance with CAFE standards. Subject to a 
variety of user-controlled constraints, the model applies technologies based on their relative cost-
effectiveness, as determined by several input assumptions regarding the cost and effectiveness of 
each technology, the cost of CAFE-related civil penalties, and the value of avoided fuel 
expenses. For a given manufacturer, the compliance simulation algorithm applies technologies 
either until the manufacturer achieves compliance, or until the manufacturer exhausts all 
available technologies, or, if the manufacturer is assumed to be willing to pay civil penalties, 
until paying civil penalties becomes more cost-effective than increasing vehicle fuel economy. 
The user may disable the civil penalty paying option for manufacturers expected to be unwilling 
to pay them, thus effectively “forcing” the manufacturer to add additional technology even once 
it might otherwise be preferable to pay penalties (considering the cost to add further technology 
as compared to the estimated value of the resultant saved fuel). At this stage, the system assigns 
an incurred technology cost and updated fuel economy to each vehicle model, as well as any 
civil penalties incurred by each manufacturer. 
 
This point marks the system’s transition between compliance simulation and effects calculations. 
At the conclusion of the compliance simulation for a given model year, the system contains a 
new fleet of vehicles with new prices, fuel types (e.g., diesel, electricity), fuel economy values, 
and curb weights that have all been updated to reflect the application of technologies in response 
to CAFE requirements. For each vehicle model in this fleet, the system then estimates the 
following: lifetime travel, fuel consumption, and carbon dioxide and criteria pollutant emissions. 
After aggregating model-specific results, the system estimates the magnitude of various 
economic externalities related to vehicular travel (e.g., noise) and energy consumption (e.g., the 
economic costs of short-term increases in petroleum prices). 
 
Different categorization schemes are relevant to different types of effects. For example, while a 
fully disaggregated fleet is retained for purposes of compliance simulation, vehicles are grouped 
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by type of fuel and regulatory class for the energy, carbon dioxide and criteria pollutant 
calculations, and by safety and regulatory classes for the additional fatalities calculations. The 
system may be expanded in the future to represent CAFE-induced market responses (i.e., mix 
shifting), in which case such calculations would group vehicles by market segment.  Therefore, 
this system uses model-by-model categorization and accounting when calculating most effects, 
and aggregates results only as required for efficient reporting. 
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 CAFE Compliance Simulation 
 
S1.1 Compliance Simulation Algorithm 
 
Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of these 
scenarios is defined in the “scenarios” input file described in Section A.5 of the Appendix. Each 
scenario describes an overall CAFE program in terms of the program’s coverage, applicability of 
multi-fuel vehicles, the structure and stringency of the standards applicable to passenger and 
nonpassenger automobiles, and the adjustments for improvements in air conditioning. The 
system is normally used to examine and compare at least two scenarios.  The first scenario is 
identified as the baseline scenario, usually defined as the world in the absence of new CAFE 
standards (which itself can be considered in a variety of ways), providing results to which results 
for any other scenarios are compared. Although many scenarios can be examined with each run 
of the model, for simplicity in this overview, we will only describe one scenario occurring in one 
model year. 
 
The compliance simulation applies technology to each manufacturer’s product line based on the 
CAFE program described by the current scenario and the assumed willingness of each 
manufacturer to pay civil penalties rather than complying with the program. The first step in this 
process involves definition of the fleet’s initial state—that is, the volumes, prices, and attributes 
of all vehicles as projected without knowledge of future CAFE standards—during the study 
period, which can cover one or more consecutive model years (MYs). The second step involves 
evaluating the applicability of each available technology to each vehicle model, engine, and 
transmission in the fleet. The third and final step involves the repeated application of 
technologies to specific vehicle models, engines, and transmissions in each manufacturer’s fleet. 
For a given manufacturer, this step terminates when CAFE standards have been achieved or all 
available technologies have been exhausted. Alternatively, if the user specifies that some or all 
manufacturers should be considered willing to pay civil penalties for noncompliance, this step 
terminates when it would be less expensive to pay such penalties than to continue applying 
technology. Furthermore, if the system has been configured to evaluate voluntary 
overcompliance, this step would not terminate until all cost-effective solutions, for all 
manufacturers, were applied, beyond what is necessary to meet the CAFE standard. 
 
S1.1.1 Initial State of the Fleet 
 
The fleet’s initial state is developed using information contained in the vehicle models, engine, 
and transmission worksheets described in Appendix A. The set of worksheets uses identification 
codes to link vehicle models to appropriate engines, transmissions, and preceding vehicle 
models.  Figure 1 provides a simplified example illustrating the basic structure and 
interrelationship of these three worksheets, focusing primarily on structurally important inputs. 
These identification codes make it possible to account for the use of specific engines or 
transmissions across multiple vehicle models. They also help the compliance simulation 
algorithm to realistically “carry over” technologies between model years. 
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State 

MY11 MY12 MY11 MY12

1 Veh1 20.95 11,516 10,963 27,500 28,875 1 2

2 Veh2 21.78 93,383 97,767 23,000 24,150 1 3

3 Veh3 18.33 46,880 49,367 31,250 32,813 2 4

4 Veh4 22.02 65,054 68,505 24,250 25,463 3 3

5 Veh5 18.51 21,843 25,838 31,500 33,075 4 4

1 Eng1 G 6 3.5 2

2 Eng2 G 8 4 2

3 Eng3 G 6 3.5 4

4 Eng4 G 8 4 4

1 M5 C 5 M

2 A4 T 4 A

3 A5 T 5 A

4 A6 T 6 A

Engine Worksheet

Trn
ID Name Type Gears Control

Transmission Worksheet

NameEng
ID

Valves per
CylinderDisplacementCylFuel

Veh
ID

Sales MSRP

Vehicle Models Worksheet

Transmission
Code

Engine
CodeFEModel
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S1.2 Vehicle Technology Application within the CAFE Model 
 
Vehicle technologies are a set of possible improvements available for the vehicle fleet. The 
vehicle technologies, referred to below simply as ‘technologies’, are defined by the user in the 
technology input file for the model (see Appendix A). As a part of the definition for each 
technology there is an associated cost for the technology, an improvement factor (in terms of 
percent reduction of fuel consumption), the introduction year for the technology, whether it is 
applicable to a given class of vehicle, grouping (by technology group – engine, transmission, 
etc.), and phase-in parameters (the amount of fleet penetration allowed in a given year). Also 
defined in the technology inputs file are cost synergies and improvement synergies. 
 
Having defined the fleet’s initial state, the system applies technologies to each manufacturer’s 
fleet based on the CAFE program for the current model year. The set of technologies 
accommodated by the model is discussed in the Preliminary Regulatory Impact Analysis (PRIA) 
and Technical Support Document (TSD) for the 2017-2025 Notice of Proposed Rulemaking 
(NPRM) regarding CAFE standards for passenger cars and light trucks produced for sale in the 
United States in model years 2017-20251. 
 
As discussed in the PRIA and TSD, the set of technologies, and the methods for considering their 
application, include all of those discussed in the 2012-2016 final rule documentation2 albeit with 
updated fuel efficiency effectiveness estimates as well as newly defined technologies for the 
2017-2025 timeframe.  The technologies discussed in 2012-2016 final rule were based on a 2002 
National Academy of Sciences report.3  That study estimated that the applicability of different 
technologies would vary based on vehicle type. Since the publication of the 2002 NAS study, 
NHTSA and EPA have agreed on technology-related estimates extending through MY2025, 
based on a range of newer studies and research, and NHTSA has developed corresponding inputs 
for use in the CAFE model.    The development of these technology estimates is discussed in the 
preamble to the proposed rule, and in the supporting technical support document and regulatory 
impact analysis.  Although the model now represents a wider range of technologies than the 2002 
NAS study, and uses different logical sequences for considering their addition to manufacturers’ 
fleets, the model retains the ability for differentiation based on vehicle type. 
 
S1.2.1 Vehicle Technology Class 
 
The CAFE model uses twelve technology classes as shown in Table 1: 
 

Table 1. CAFE Technology Vehicle Classes 
Class Description 
Subcompact PC Subcompact passenger car. 
Subcompact Perf PC Subcompact performance oriented passenger car 
Compact PC Compact passenger car 
Compact Perf PC Compact performance oriented passenger car 

                                                
1 Available at http://www.nhtsa.gov/fuel-economy. 
2 75 FR 25324 (May 7, 2010). 
3 National Research Council, ‘‘Effectiveness and Impact of Corporate Average Fuel Economy (CAFE) Standards,’’ 
National Academy Press, Washington, DC (2002).  Available at 
http://www.nap.edu/openbook.php?isbn=0309076013 (last accessed Nov. 13, 2011). 



DRAFT – December 2011 

7 

Midsize PC Midsized passenger car 
Midsize Perf PC Midsized performance oriented passenger car 
Large PC Large passenger car 
Large Perf PC Large performance oriented passenger car 
Small LT Small sport utility vehicles and pickups 
Midsize LT Midsize sport utility vehicles and pickups 
Large LT Large sport utility vehicles and pickups 
Minivan Minivans 

 
S1.2.2 Technology Groups 
 
The CAFE Model organizes technologies into groups, which allows the model to seek the next 
“best” technology application in any of these groups.4 There are seven groups defined: engine 
technologies, transmission technologies, electrical accessory technologies, mass reduction 
technologies, low rolling resistance tires technologies, dynamic load reduction technologies, and 
aerodynamic load reduction technologies. The table below lists the technologies represented by 
the system, and the grouping we have applied to enable the system to follow a logical 
incremental path within any given group without being unnecessarily prevented from 
considering technologies in other groups. This “parallel path” approach is discussed below. 
 

Table 2. Technology Group Assignments 
Technology Group Group Members5 
Vehicle Engine 
Technology Group 
(EngMod) 

Low Friction Lubricants - Level 1 (LUB1) 
Engine Friction Reduction - Level 1 (EFR1) 
Low Friction Lubricants and Engine Friction Reduction - Level 2 (LUB2_EFR2) 
Variable Valve Timing (VVT): 
VVT - Coupled Cam Phasing on SOHC (CCPS) 
VVT - Intake Cam Phasing (ICP) 
VVT - Dual Cam Phasing (DCP) 
Cylinder Deactivation: 
Cylinder Deactivation on SOHC (DEACS) 
Cylinder Deactivation on DOHC (DEACD) 
Cylinder Deactivation on OHV (DEACO) 
Variable Valve Lift & Timing: 
Discrete Variable Valve Lift (DVVL) on SOHC (DVVLS) 
Discrete Variable Valve Lift (DVVL) on DOHC (DVVLD) 
Continuously Variable Valve Lift (CVVL) (CVVL) 
Variable Valve Actuation - CCP and DVVL on OHV (VVA) 
Stoichiometric Gasoline Direct Injection (GDI) (SGDI) 
Stoichiometric Gasoline Direct Injection (GDI) on OHV (SGDIO) 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) 
Small Displacement (TRBDS1_SD) 
Medium Displacement (TRBDS1_MD) 

                                                
4 Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective.  The 
system assumes that the manufacturer will seek to progress through the technology decision trees in a manner that 
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b) 
reductions in civil penalties owed for noncompliance with CAFE standards, and (c) the value vehicle purchasers are 
estimated to place on fuel economy. 
5 Some technologies were evaluated during the initial development of the modeling system; however, they were later 
excluded from analysis.  In Table 2, these technologies appear in gray text. 
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Large Displacement (TRBDS1_LD) 
Turbocharging and Downsizing - Level 2 (24 bar BMEP) 
Small Displacement (TRBDS2_SD) 
Medium Displacement (TRBDS2_MD) 
Large Displacement (TRBDS2_LD) 
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) 
Small Displacement (CEGR1_SD) 
Medium Displacement (CEGR1_MD) 
Large Displacement (CEGR1_LD) 
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) 
Small Displacement (CEGR2_SD) 
Medium Displacement (CEGR2_MD) 
Large Displacement (CEGR2_LD) 
Advanced Diesel6 
Small Displacement (ADSL_SD) 
Medium Displacement (ADSL_MD) 
Large Displacement (ADSL_LD) 

Vehicle Transmission 
Technology Group 
(TrMod) 

6-Speed Manual/Improved Internals (6MAN) 
High Efficiency Gearbox (Manual) (HETRANSM) 
Improved Auto. Trans. Controls/Externals (IATC) 
6-Speed Trans with Improved Internals (NAUTO) 
6-speed Dual Clutch Transmission (DCT) 
8-Speed Trans (Auto or DCT) (8SPD) 
High Efficiency Gearbox (Auto or DCT) (HETRANS) 
Shift Optimizer (SHFTOPT) 

Electrical Accessory 
Technology Group 
(ELEC) 
Includes Hybrid Technologies 

Electric Power Steering (EPS) 
Improved Accessories - Level 1 (IACC1) 
Improved Accessories - Level 2 (IACC2) 
12V Micro-Hybrid (MHEV) 
Integrated Starter Generator (ISG) 
Strong Hybrid - Level 1 (SHEV1) 
Conversion from SHEV1 to SHEV2 (SHEV1_2) 
Strong Hybrid - Level 2 (SHEV2) 
Plug-in Hybrid - 30 mi range (PHEV1) 
Plug-in Hybrid (PHEV2) 
Electric Vehicle (Early Adopter) - 75 mile range (EV1) 
Electric Vehicle (Early Adopter) - 100 mile range (EV2) 
Electric Vehicle (Early Adopter) - 150 mile range (EV3) 
Electric Vehicle (Broad Market) - 150 mile range (EV4) 
Fuel Cell Vehicle (FCV) 

Mass Reduction 
Technology Group 
(MSM) 

Mass Reduction - Level 1 (MR1) 
Mass Reduction - Level 2 (MR2) 
Mass Reduction - Level 3 (MR3) 
Mass Reduction - Level 4 (MR4) 
Mass Reduction - Level 5 (MR5) 

Low Rolling Resistance Tires 
Technology Group 
(ROLL) 

Low Rolling Resistance Tires - Level 1 (ROLL1) 
Low Rolling Resistance Tires - Level 2 (ROLL2) 
Low Rolling Resistance Tires - Level 3 (ROLL3) 

Dynamic Load Reduction 
Technology Group 
(DLR) 

Low Drag Brakes (LDB) 
Secondary Axle Disconnect (SAX) 

Aerodynamic Reduction 
Technology Group 

Aero Drag Reduction, Level 1 (AERO1) 
Aero Drag Reduction, Level 2 (AERO2) 

                                                
6 Replacing a gasoline engine with a diesel engine. 
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(AERO) 
 
Input estimates for each of these technologies are specified in the technologies input file, and are 
specific to each of the CAFE technology vehicle classes, as shown in the following table. Table 3 
lists some of the input assumptions specified in this file7. 
 

Table 3. Technology Input Assumptions 
Input Definition 
Applicable If the technology is available for applicability 
TechType Technology group of which the technology is a member 
FC Overall reduction (%) of fuel consumption 
FCg Reduction of fuel consumption applicable to a gasoline component of a vehicle after being 

converted into a PHEV 
FCg Share Percentage of time a vehicle is expected to run on the gasoline fuel after being converted into a 

PHEV 
Cost-Table Fully learned-out table of costs by model year8 (in 2009 dollars) 
Year Available First model year the technology is available for applicability 
Year Retired Last model year the technology is available for applicability 
Delta Weight (%) Percentage by which the vehicle's weight changes after technology is applied 
 
Among other things, the technology input assumptions define applicability, cost, fuel 
consumption reduction factors, and define the technology group of which the technology is a 
member. 
 
S1.2.3 Technology Applicability 
 
The technology input assumptions have two means of defining technology applicability. One 
means is with the Applicability field. If the field is set to “TRUE”, then the technology is 
available for the particular class of vehicle, otherwise, the technology is unavailable. 
 
The other applicability control in the input assumptions are the Year Available and Year Retired 
fields. If the year being evaluated by the CAFE Model is prior to the setting in the year available 
field or after the year retired field, then the technology will be unavailable for the particular class 
of vehicle. 
 
Besides those mentioned, there are also other technology applicability factors within the CAFE 
Model. For example, there are controls for individual vehicles in the market data file that can 
override the controls here (see Appendix C). There are also dynamic considerations made while 
the model is running based on vehicle configuration (e.g. cylinder deactivation is not applied to 
vehicles with manual transmissions), as well as technology combination factors (e.g.  DVVLD is 
incompatible with CVVL). 
 
S1.2.4 Technology Fuel Consumption Reduction Factors 
 

                                                
7 Additional technology assumptions are further discussed in Appendix A. 
8 Because mass reduction is applied as a percentage of curb weight, the corresponding cost estimates are in dollars 
per pound of incremental change in curb weight. 
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The technology input assumptions—specified in an input file supplied by the user—define the 
fuel consumption reduction factors FC and FCg. The reduction in fuel consumption values are 
on a gallons-per-mile basis and represent a percent reduction in fuel consumption. The formula 
to find the increase in fuel economy (miles-per-gallon) of a vehicle with fuel consumption 
reduction factors from one or more technologies is: 
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where FEorig is the original fuel economy for the vehicle, and FCnReduction0,1,…n are the fuel 
consumption reduction factors. 
 
Whenever the modeling system converts a vehicle to a Plug-In Hybrid, that vehicle is 
assumed to operate on gasoline and electricity fuel types simultaneously. In such a case the 
FC field represents the overall improvement in the combined (gasoline + electricity) vehicle 
fuel economy.  The FCg field specifies what the improvement in the gasoline-only 
component of the vehicle’s fuel economy would be9, while the FCg Share field specifies the 
assumed amount of time in gasoline-only operation for the vehicle. 
 
S1.2.5 Technology Cost 
 
The technology input assumptions—specified in an input file supplied by the user—define a 
fully “learned-out” table of year-by-year technology costs Cost Table. 
 
Some technology costs have a cost basis associated with them.  For instance, for mass reduction 
technologies, the technology input costs must be multiplied by the reduction of vehicle curb 
weight, in pounds, to get the full cost of applying the technology.  Similarly some engine 
technologies have costs determined on a per-cylinder or per-bank (configuration) basis.  The 
model uses the ‘Aux’ column to identify when technologies have an associated underlying cost 
basis. 
 
Further discussion of the technology input assumptions can be found in Appendix A. 
 
S1.2.6 Technology Synergies 
 
Technology synergies exist when the combination of two technologies yields a fuel consumption 
reduction which differs from what would be derived directly from equation (1) for fuel 
consumption reduction. The synergy can be positive (e.g. increased reduction of fuel 
consumption) or negative (decreased reduction of fuel consumption). The model also uses some 
cost “synergies” to ensure correct cost accounting as the model proceeds down the decision trees. 
 
Synergy relationships between technologies are captured in the two synergies table in the 
technology input file. The system reads the information from the table and, for each technology, 
                                                
9 When being converted to a Plug-In Hybrid, the vehicle’s fuel economy while operating on gasoline may 
potentially increase due to improvements in regenerative breaking associated with a bigger battery. Presently, 
however, it is assumed that no such improvement exists, and the FCg field is listed as zero (0). 
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stores the synergy factors between that technology and all other technologies. For cases where 
there is no synergy relationship, there will be no listing in the table, and the synergy factor will 
be zero (0.0). In cases where there are synergies, that applicable factor is added to the fuel 
consumption reduction or to the cost value. 
 
In the case of fuel consumption reduction synergies, negative synergies lessen the fuel 
consumption reductions of a technology, the system assumes technologies will not combine to 
degrade fuel economy (i.e., to produce negative reductions in fuel consumption). For synergies 
involving technology costs, the final result is allowed to become negative. 
 
The layout of the synergy table in the technology input file is discussed in Section A.2.1 of 
Appendix A. 
 
S1.2.7 Backfill of Technologies 
 
In some cases, technologies will be bypassed because they are not cost-effective. If the model 
applies a technology that resides later in the sequence, the model will ‘backfill’ any bypassed 
technologies in order to fully account for technology costs and effects, each of which are 
specified on an incremental basis. This backfill will not occur if the technology is not applicable 
to the vehicle. In the case where the backfill would backtrack through branches in the sequence, 
the model would first resolve any limitations and applicability issues. If the branch still exists, it 
would examine which is the less expensive branch to use. 
 
The algorithm next determines the applicability of each technology to each vehicle model, 
engine, and transmission. If the technology is available in the current model year, the system 
identifies the technology as potentially applicable. However, technology “overrides” can be 
specified for specific vehicle models, engines, and transmissions in the corresponding input 
files.10 If any such overrides have been specified, the algorithm reevaluates applicability as 
shown in Figure 2. 
 

                                                
10 These overrides, described in Appendix C.2 on page 59, provide a means of accounting for engineering and other 
issues not otherwise represented by input data or the overall system. 
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Figure 2. Technology Applicability Determination 

 
S1.2.8 Technology Sequencing and Branching 
 
The sequence of applying technology works in the following way: Within each group, the 
technology sequence of application proceeds as shown in the technology input file. There are 
some points where the sequence path can branch onto a different course, as discussed below. The 
groups are independent of each other, although there may be some interactions. 
 
S1.2.8.1 Sequencing and Branching within a Technology Group 
 
Within each technology group, the choice of technologies that can be applied may vary from 
vehicle to vehicle based on the baseline configuration of the vehicle or on the previous 
application of technologies. Both the engine and transmission technology groups have optional 
paths. The choice of which path depends upon a variety of factors which include the vehicle 
class, the vehicle configuration, technology override settings for that vehicle, previous 
applications of technology, technology availability (year available) and phase-in restrictions. 
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When left with a choice of two or more technologies, cost-effectiveness is used to choose the 
technology to apply. 
 
S1.2.8.2 Bypassing a Technology 
 
In cases where a technology is already installed in the baseline vehicle configuration or is 
unavailable for other reasons (e.g., it is not compatible with this vehicle class), then that 
technology is simply bypassed in the technology path. For example, if engine friction reduction 
has previously been installed, then the next available engine technology after low -cost lubricants 
on a vehicle with overhead valves (OHV) is cylinder deactivation. 
 
Branching within a technology group sequence occurs for the following reasons: 1) normal 
branch where there are two or more different (and mutually incompatible) technology choices – 
the model can choose one or another path; 2) limitations of technology choice based on vehicle 
configuration; 3) combination of both. 
 
An example of normal branching is DVVLD and CVVL in the engine technology group. 
 
An example of the limitations would be within the engine technology group, as shown in Figure 
3, below, where there is a separate path for engines with overhead valves (OHV) engines, single 
overhead cam engines (SOHC) and for engines with dual overhead cams (DOHC). 
 
S1.2.8.3 Engine Technology Sequencing and Branching 
 
Within the engine technology sequence, shown in Figure 3, there are three major sequence paths: 
single overhead cam (SOHC); dual overhead cam (DOHC); and overhead valve (OHV). The 
choice of path for a vehicle model is based on the base engine attributes. There are further 
branches within the DOHC branch. The choice of which branch to take is based on availability 
for the specific vehicle as well as the vehicle class; phase-in constraints; and, finally, cost-
effectiveness. 
 
Further down within the engine technology sequence is another branch, which culminates in a 
choice between dieselization and a strong hybrid path. The choice of which branch is, again, 
based on availability for the specific vehicle as well as the vehicle class; phase-in constraints; 
and, finally, cost-effectiveness. 
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Figure 3. Engine Technology Group Technology Sequence 
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S1.2.8.4 Transmission Technology Sequencing 
 
Within the transmission technology sequence, shown in Figure 4, there are two separate paths, 
one used for automatic transmissions, and the other for manual transmissions.  Depending on the 
initial characteristics of a vehicle, one sequence or the other will be followed. 
 

 
Figure 4. Transmission, Electrification/Accessory, and Hybrid Technology Decision Tree  
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S1.2.8.5 Electrical Accessory & Strong Hybrid Technology Sequencing 
 
The electrical accessory technology sequence has no branches, as shown in Figure 4. The 
technologies on the electrical accessory path can be applied to a vehicle any time, provided they 
meet engineering and phase-in constraints. However, the technologies in the strong hybrid path 
(i.e. strong hybrids, plug-in hybrids and electric vehicles) can only be applied once the engine 
(with the exception of the Advanced Diesel technology), transmission and electrification paths 
have been exhausted. Thus the engine, transmission an electrification technologies are 
considered “enablers” that must be installed on a vehicle prior to the application of the strong 
hybrid technologies. It is important to note that once the engine and transmission paths have been 
fully applied, the model may skip ahead of the electrical accessory technologies, and apply a 
strong hybrid, backfilling any skipped electrification technologies in the process. 
 
S1.2.8.6 Vehicle (Other) Technology Sequencing 
 
The rest of the technology sequences (mass reduction, low rolling resistance tires, dynamic load 
reduction, and aerodynamic load reduction), shown in Figure 5, have no branches.  However, 
with the exception of dynamic load reduction technologies, before the modeling system is able to 
apply a technology appearing later on the decision tree, the preceding technologies must be 
applied to a vehicle. 
 

 
Figure 5.  Vehicle Technology Decision Tree 
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S1.3 Compliance Simulation Loop 
 
If a given technology is still considered applicable after considering any overrides, the algorithm 
again re-evaluates applicability based the following engineering conditions: 
 

Table 4. Engineering Conditions for Technology Applicability 
Technology Constraint 
All technologies Do not apply if already present on the vehicle. 
Low-Friction Lubricants Do not apply if engine oil is better than 5W30 
Variable Valve Timing Family Do not apply to diesel or rotary engines.  
Variable Valve Lift and Timing 
Family 

Do not apply to diesel or rotary engines. Do not apply to vehicles with VVLT 
technology already in place. Once a VVLT (continuous or discrete) are 
applied, the other VVLT cannot be applied. 

Cylinder Deactivation Do not apply to engines with inline configuration, and/or fewer than 6 
cylinders. Do not apply to turbocharged and downsized, diesel or rotary 
engines.  Do not apply to vehicles with manual transmissions. 

Turbocharging and downsizing Do not apply to diesel or rotary engines.  
Turbocharging and downsizing, 
Level 2 

Do not apply if vehicle has a manual transmission with fewer than 6 gears or 
an automatic/DCT transmission with fewer than 8 gears. 

Cooled Exhaust Gas 
Recirculation (Level 1 & 2) 

Do not apply if vehicle has a manual transmission with fewer than 6 gears or 
an automatic/DCT transmission with fewer than 8 gears. 

Stoichiometric GDI Do not apply to diesel or rotary engines. 
 
Having determined the applicability of each technology to each vehicle model, engine, and/or 
transmission, the compliance simulation algorithm begins the process of applying technologies 
based on the CAFE standards applicable during the current model year. This involves repeatedly 
evaluating the degree of noncompliance, identifying the “best next” (as described above) 
technology available on each of the parallel technology paths mentioned above, and applying the 
best of these. Figure 6 gives an overview of the process. If, considering all regulatory classes, the 
manufacturer owes no CAFE civil penalties, then the algorithm applies no technologies beyond 
any carried over from the previous model year, because the manufacturer is already in 
compliance with the standard. If the manufacturer does owe CAFE civil penalties, then the 
algorithm first finds the best next applicable technology in each of the technology groups (e.g., 
engine technologies), and applies the same criterion to select the best among these. If this 
manufacturer is assumed to be unwilling to pay CAFE civil penalties (or, equivalently, if the user 
has set the system to exclude the possibility of paying civil penalties as long as some technology 
can still be applied), then the algorithm applies the technology to the affected vehicles. If the 
manufacturer is assumed to be willing to pay CAFE fines and applying this technology would 
have a lower “effective cost” (discussed below) than simply paying penalties, then the algorithm 
also applies the technology. In either case, the algorithm then reevaluates the manufacturer’s 
degree of noncompliance. If, however, the manufacturer is assumed to be willing to pay CAFE 
civil penalties and doing so would be less expensive than applying the best next technology, then 
the algorithm stops applying technology to this manufacturer’s products. After this process is 
repeated for each manufacturer. It is then repeated again for each modeling year. Once all 
modeling years have been processed, the compliance simulation algorithm concludes. 
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Figure 6. Compliance Simulation Algorithm 

 
Whether or not the manufacturer is assumed to be willing to pay CAFE penalties, the algorithm 
uses CAFE penalties not only to determine whether compliance has been achieved, but also to 
determine the relative attractiveness of different potential applications of technologies. 
Whenever the algorithm is evaluating the potential application of a technology, it considers the 
effective cost of applying that technology to the group of vehicles in question, and chooses the 
option that yields the lowest effective cost.11 The effective cost is used for evaluating the relative 
attractiveness of different technology applications, not for actual cost accounting. The effective 

                                                
11 Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given 
engine, that engine might be used by a station wagon in the domestic passenger automobile fleet, a large car in the 
imported passenger automobile fleet, and a minivan in the nonpassenger automobile fleet. If the manufacturer’s 
domestic and imported passenger automobile fleets both comply with the corresponding standard, the algorithm 
accounts for the fact that upgrading this engine will incur costs and realize fuel savings for all three of these vehicle 
models, but will only yield reductions of CAFE fines for the nonpassenger fleet. 
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cost is defined as the change in total technology costs incurred by the manufacturer plus the 
change in CAFE penalties incurred by the manufacturer minus the value of any reduction of fuel 
consumed by vehicles sold by the manufacturer. The calculation can span multiple modeling 
years. If the candidate technology was enabled for application in a previous year and not used, 
then it can remain as a candidate to be applied and then carried forward to the current model 
year. The impact of the technology application in each of these years is summed to obtain the 
effective cost. 
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where PresentMY is the current modeling year, BaseMY is the first year of the potential 
application of the technology (can be less than or equal to PresentMY), ΔTECHCOST is simply 
the product of the unit cost of the technology, WELFARELOSSi is the loss of value to the 
consumer resulting from the reduction in travel range of electric vehicles, and the total sales (Nj) 
of the affected cohort of vehicles (j) for all years involved in the candidate technology 
application. The value of the reduction in fuel consumption achieved by applying the technology 
in question to all vehicles i in cohort j is calculated as follows:12 
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where SURVv is the car and truck average probability that a vehicle of that vintage will remain in 
service, MIv is the car and truck average number of miles driven in a year at a given vintage v, 
VMTGROWTHMY+v is the growth factor to apply to the base miles driven in the current model 
year MY at the given vintage v, FT is the fuel type the vehicle operates on (gasoline, diesel, or 
electricity), (FEFT)i and (FE'FT)i are the vehicle’s fuel economy for a specific fuel type prior to 
and after the pending application of technology, (FSFT)i and (FS'FT)i are the vehicle’s assumed 
share of operating on a specific fuel type prior to and after the pending application of technology, 
GAPFT is the relative difference between on-road and laboratory fuel economy for a specific fuel 
type, Ni is the sales volume for model i in the current model year MY, (PRICEFT)MY+v is the price 
of the specific fuel type in year MY+v, and PB is a “payback period”, or number of years in the 
future the consumer is assumed to take into account when considering fuel savings. As discussed 
in Section A.3 of Appendix A, SURVv, MIv, VMTGROWTHMY+v, (PRICEFT)MY+v, and GAPFT are 

                                                
12 This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer 
is assumed to expect to be able impose without losing sales. 
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all specified in the parameters input file, while the values for PB are specified in the market data 
input file (see Section A.1.1 in Appendix A). 
 
In equation (2), FINE is the change in total CAFE penalties (i.e., accounting for all regulatory 
classes in the current CAFE scenario and model year). Typically, FINE is negative because 
applying a technology would increase CAFE.13 FINE is calculated by evaluating the following 
before and after the pending technology application, and taking the difference between the 
results: 
 

 ( )MIN ,0F C
C

FINE k CREDIT= − ∑  (4) 

 
Here, kF is in dollars per mpg (e.g., $55/mpg) and specified in the scenarios file. 
 
Within each regulatory class C, the net amount of CAFE credit created (noncompliance causes 
credit creation to be negative, which implies the use of CAFE credits or the payment of CAFE 
penalties) is calculated by subtracting the CAFE level achieved by the class from the standard 
applicable to the class, and multiplying the result by the number of vehicles in the class. Taking 
into account attribute-based CAFE standards, this is expressed as follows:  
 
 ( ) ( )STD , CAFE ,C C C C C C C CCREDIT N= −⎡ ⎤⎣ ⎦N A N FE  (5) 

 
where AC is a vector containing the value of the relevant attribute for each vehicle model in 
regulatory class C, CAFEC is the CAFE level for regulatory class C (e.g., if the standard depends 
on curb weight, AC contains each vehicle model’s curb weight), FEC is a vector containing the 
fuel economy level of each vehicle model in regulatory class C, NC is the total sales volume for 
regulatory class C, NC is a vector containing the sales volume for each vehicle model in 
regulatory class C, and STDC(NC ,AC) is a function defining the standard applicable to regulatory 
class C. Figure 7 gives an overview of the logic the algorithm follows in order to identify the 
best next technology application for each technology group. 
 
Within a given technology group, the algorithm considers technologies in the order in which they 
appear. If the phase-in limit for a given technology has been reached, the algorithm proceeds to 
the next technology. If not, the algorithm determines whether or not the technology remains 
applicable to any sets of vehicles, evaluates the effective cost of applying the technology to each 
such set, and identifies the application that would yield the lowest effective cost. 
 
As shown in Figure 7, the algorithm repeats this process for each technology group, and then 
selects the technology application yielding the lowest effective cost. As discussed above, the 
algorithm operates subject to expectations of the willingness of each manufacturer to pay fines. 
COSTeff is determined, as above, by equations (2), (3), and (4), irrespective of the manufacturer’s 
willingness to pay fines. 
 

                                                
13 Exceptions can occur, for example, if mass reduction is applied under a CAFE system in which attribute standards 
are weight-based rather than footprint-based. 
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At the end of each year in the model year loop, the vehicle/technologies combinations that can be 
candidates for application in multi-year processing are identified. 
 

 
Figure 7. Determination of "Best Next" Technology Application 
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 Calculation of Effects 
 
This chapter describes the way the CAFE modeling system estimates the effects of potential new 
CAFE standards on energy use, as well as on emissions of greenhouse gases and other air 
pollutants. These effects are caused by improvements in the fuel economy of individual vehicle 
models that manufacturers make in response to the imposition of higher CAFE standards. This 
section also describes how these energy use and environmental impacts are translated into 
estimates of economic benefits or costs, and identifies which of these economic impacts are 
borne privately by vehicle owners and by society as a whole. 
 
The effects on energy use and emissions from tightening or reforming CAFE standards are 
estimated separately for each individual vehicle model and vintage (or model year) over its 
expected life span in the U.S. vehicle fleet. A vehicle model’s life span extends from the initial 
model year when it is produced and sold, through the year when vehicles produced during that 
model year have reached the maximum age assumed in the CAFE model.14 Each of the effects of 
raising CAFE standards is measured by the difference in the value of a variable – such as total 
gallons of fuel consumed by a vehicle model and vintage over its lifetime – with its baseline fuel 
economy level, and its estimated fuel economy if that model were instead required to comply 
with a stricter CAFE standard.  A vehicle model’s baseline fuel economy level is usually (but not 
necessarily) defined as the level of fuel economy it would be expected to have if the CAFE 
standard currently in effect its vehicle class (automobiles or light trucks) remained in effect for 
the future model year when it is produced.  
 
Although these effects are calculated for individual vehicle models, vintages, and future calendar 
years over their respective lifetimes, they are typically reported at the aggregate level for all 
vehicle models in a CAFE class (domestic automobiles, import automobiles, and light trucks) 
produced during each model year affected by a proposed standard.  Cumulative impacts for each 
CAFE class and model year over its expected life span are reported both in undiscounted terms 
and as their present value discounted to the calendar year when each model year is produced. 
 
 
 Light-Duty Vehicle Production and Lifetimes  
 
The forecast number of new vehicles of a specific model k produced and sold during a given 
model year MY is: 
 
 , ,k MY MY k MYn N P=  (6) 

 
Where NMY denotes total sales of all models produced during that model year, and Pk,MY is the 
proportion of total production and sales during that model year that is accounted for by model k. 
The forecast number of new vehicles of each specific model k produced and sold during future 
model years was based on a custom long range forecast of vehicle production purchased from 
CSM Worldwide (CSM).   This forecast, which provided projections of vehicle sales by both 
                                                
14 We adopt the simplifications that vehicle model years and calendar years are identical, and that all vehicles 
produced during a model year are sold and placed into service during the corresponding calendar year. 
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manufacturer and market segment, was combined with data from a variety of other sources to 
create the projections of production and sales by vehicle model and future model year.  The 
development of model-level production and sales forecasts involved a complex multistep 
procedure, which is described in detail in Chapter 1 of the Joint TSD. 
 
The number of vehicles of a specific model and model year (or vintage) that remains in service 
during each subsequent calendar year is calculated by multiplying the number originally 
produced by estimates (model inputs) of the proportion expected to remain in service at each age 
up to an assumed maximum lifetime. Thus the number of vehicles of model k produced during 
model year MY that remain in use during a future calendar year t, or nk,MY,t, is: 
 
 

, , , ,k MY t k MY k an n s=  (7) 

 
where sk,a denotes the proportion of vehicles of model k expected to remain in use at the age (a) 
that vehicles produced during model year MY will have reached during calendar year t.  The age 
of a vehicle model produced in model year MY during calendar year tis defined as:  
 
 a = t – MY.15 (8) 
 
The CAFE model currently accommodates different schedules of survival rates by vehicle age 
for passenger cars light trucks, as reported in A.3.1.  Based on analysis of recent registration 
data, the maximum ages of passenger automobiles and light trucks are estimated to be 26 years 
and 36 years, respectively.16  
 
Each vehicle model k produced during a model year MY is designated as operating on a specific 
fuel type or employing a specific technology; all units of that model produced during a model 
year are assumed to be of the same fuel or technology type.  The CAFE model currently 
recognizes five fuel or technology types: gasoline, diesel, flexible-fuel vehicles (or FFVs, which 
are capable of operating on gasoline or on gasoline blended with up to 85% ethanol), plug-in 
hybrid electric vehicles (or PHEVs, which can operate on either gasoline or electricity generated 
off-board and stored in on-board batteries), and electric vehicles (or EVs, which operate only on 
electricity generated off-board and stored in on-board batteries).  The fractions of total mileage 
for which FFVs operate on gasoline and ethanol-blend fuels, and the fractions of total mileage 
for which PHEVs operate on gasoline and stored electricity, are inputs to the model.  
 
  

                                                
15 We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when t=MY. Thus, for 
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015. Because we do not 
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to 
survive to each age, a vehicle’s age is depends only on the difference between its model year (MY) and the calendar 
year (t) for which these calculations are performed, and not on their specific values. 
16 These are defined as the ages when the number of vehicles of a model year that remain in service has declined to 
fewer than 2% of those originally produced.  
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 Vehicle Use and Total Lifetime Mileage 
 
The CAFE model employs the widely-documented relationship between vehicle age and 
declining average vehicle use to estimate the number of miles that individual vehicle models are 
driven annually and in total over their expected lifetimes.  Initial estimates of the relationship 
between vehicle age and average annual miles driven were tabulated from the sample of 
approximately 140,000 household vehicles included in the 2001 National Household Travel 
Survey (NHTS).17  Separate schedules of average annual miles driven by age of vehicle were 
developed for passenger automobiles and light trucks.  
 
Two adjustments are applied to these mileage schedules to forecast the average number of miles 
that vehicles produced during future model years will be driven each year over their expected 
lifetimes.  First, the estimates of annual miles driven by passenger cars and light trucks during 
2001 are adjusted to reflect assumed future growth in average vehicle use.18  The average 
number of miles driven by cars and light trucks of all ages is assumed to grow by 1.1% per year 
from 2001 until 2030, and to increase by 0.5% annually after 2030.  
 
Second, the estimates of average annual miles driven by cars and light trucks of each age derived 
from the NHTS (and adjusted for expected future growth as described above) are further adjusted 
by applying the estimated elasticity of vehicle use with respect to fuel cost per mile to the 
difference in inflation-adjusted gasoline price per gallon between 2001 (when the NHTS data on 
vehicle use were collected) and each subsequent calendar year.  This adjustment employs actual 
gasoline prices for the years 2002-2010, forecasts for 2011-2035 reported in the U.S. Energy 
Information Administration’s Annual Energy Outlook 2011, and extrapolations of gasoline 
prices beyond the year 2035 developed by EPA.19  This adjustment assumes an elasticity of 
annual vehicle use with respect to fuel cost per mile of -0.10, corresponding to a fuel economy 
rebound effect of 10%.  
 
Thus the average number of miles driven by surviving vehicles of model k and model year MY 
during calendar year t, or mk,MY,t,CAFE, is given by: 
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where mtype,t-MY,2001 is the average annual mileage for a car or light truck that was of age t-MY 
during 2001, r is the rate of growth in average annual miles per vehicle beginning in 2001, t-
2001 is the number of years that have elapsed between 2001 and calendar year t, εm,cpm is the 
                                                
17 For a description of the survey and methods for estimating annual vehicle use, see 2001 National Household 
travel Survey User’s Guide, Version 3, January 2004, available at 
http://nhts.ornl.gov/2001/usersguide/UsersGuide.pdf (last accessed November 30, 2011). 
18 Increases in the average number of miles cars and trucks are driven each year have been an important source of 
historical growth in total car and light truck use, and are expected to represent an important source of future growth 
in total light-duty vehicle travel as well.   
19 See U.S. Energy Information Administration, Annual Energy Outlook 2011, Reference Case, “Petroleum Product 
Prices,” available at http://www.eia.gov/oiaf/aeo/tablebrowser/#release=AEO2011&subject=0-AEO2011&table=12-
AEO2011&region=0-0&cases=ref2011-d020911a (last accessed November 30, 2011).  
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elasticity of annual vehicle use with respect to fuel cost per mile, ck,MY,t,CAFE is fuel cost per mile 
during year t for a car or light truck model k, and ck,t-MY,2001 is fuel cost per mile for a car or light 
truck that was of age t-MY during 2001.  The CAFE subscript on mk,MY,t,CAFE indicates that the 
value of this expression depends on the CAFE standard that was in effect during model year MY, 
as equation (10) below makes clear. 
 
The CAFE subscript on mk,MY,t,CAFE in equation (9) indicates the value of this expression depends 
on the CAFE standard that was in effect during model year MY, as equation (10) below makes 
clear.  Because the value of mtype,t-MY,t,2001 in equation (9) differs between cars and light trucks, 
the value of mk,MY,t,CAFE will take one of two values, depending on whether model k is classified 
as an automobile or a light truck.  
 
The value of fuel cost per mile for vehicle model k of model year MY during each year t of its 
expected lifetime, denoted Ck,MY,t,CAFE in equation (9), depends on both the price per gallon of 
gasoline during year t and the actual fuel economy model k achieves in on-road driving.  
Specifically, 
 

)1(,,
,,, gapmpg

PC
CAFEMYk

t
CAFEtMYk −

=  (10) 

 
 
where Pt is the inflation-adjusted price per gallon of gasoline forecast for year t, and mpgk,MY,CAFE 
is the rated fuel economy that model k achieves for model year MY with the assumed CAFE 
standard in effect.	
   	
  Each model’s rated fuel economy is assumed to be determined during the 
model year when it is produced, and to remain fixed throughout its lifetime.  However, its actual 
on-road fuel economy is assumed to fall short of that rating by the on-road fuel economy “gap” 
(a model input, currently assumed to be 20%).  

Equations (9) and (10) together indicate that the average number of miles that surviving vehicles 
of a model k and model year MY are driven during each year t of their lifetimes depends on their 
fuel economy.  The fuel economy that each vehicle model is projected to achieve can differ 
between the baseline market forecast for model year MY, which assumes that the CAFE standard 
prevailing during the previous model year would be extended to apply to model year MY, and 
any alternative CAFE standard that is considered for model year MY.   
 
As a consequence, the average number of miles that vehicles of model k and model year MY are 
driven during year t will also differ between the baseline market forecast and an alternative 
CAFE standard, depending on whether its manufacturer elects to increase that model’s fuel 
economy as part of its strategy to comply with the alternative standard.  This difference reflects 
the fuel economy rebound effect, which occurs because buyers of new vehicles respond to the 
reduction in their operating costs that results from their higher fuel economy by driving slightly 
more.20 
                                                
20 Average annual vehicle use under both the baseline market forecast of fuel economy and a higher CAFE standard 
are calculated by reference to the schedules of average annual mileage by age derived from the 2001 NHTS, as 
equations (9) and (10) indicate,  Thus the difference between a model’s annual use under those two scenarios differs 
slightly from the estimate that would have resulted from first calculating annual use under the baseline market 
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The total number of miles driven by all vehicles of a specific model and vintage (model year) 
during each calendar year they remain in the fleet is then calculated by multiplying the 
appropriate estimate  of annual miles driven per vehicle by the number of vehicles of that model 
year remaining in service during that year. Thus the total miles driven during year t by the 
surviving vehicles of model k that were originally produced during model year MY,  denoted 
Mk,MY,t,CAFE, is calculated as: 
 
 CAFEtMYktMYkCAFEtMYk mnM ,,,,,,,, =  (11) 

 
where mk,MY,t,CAFE is  as defined above.  
 
 
 Fuel Consumption and Savings 
 
Fuel consumption by vehicles of each model and vintage during a future year depends on the 
total mileage that the surviving vehicles are driven during that year, as well as on the fuel 
efficiency they obtain in actual driving.   As indicated previously, the fuel economy levels that 
new vehicles achieve in real-world driving falls significantly short of the rated fuel economy 
levels that are used to assess manufacturers’ compliance with CAFE standards.  
 
The number of gallons of each type of fuel (or gasoline gallon equivalents of fuel energy, in the 
case of electricity) consumed by vehicles of model k and model year MY during year t, denoted 
gk,MY,t,fuel, is calculated from: 
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where sk,MY,CAFE,fuel is the share of miles that model k produced in model year MY operates on 
each type of fuel, mpgk,MY,CAFE,fuel is its fuel economy in miles per gallon (or miles per gasoline 
gallon equivalent, in the case of electricity) on each type of fuel, and gapfuel (a model input) 
indicates the proportional difference between the fuel economy of vehicles using that fuel as 
measured for CAFE purposes and their actual on-road fuel economy.21 
 
The CAFE models estimates use of four different types of fuel energy: gasoline, diesel, E85 (a 
blend of 85% ethanol and 15% gasoline), and electricity.  Dedicated gasoline, diesel, and electric 
vehicle models will each have mileage shares of 100% for the fuel they are designed to utilize, 
and 0% mileage shares for all other fuels.  FFVs are currently assumed to operate on E85 for 
15% of their annual mileage each year over their lifetimes, while PHEVs are assumed to operate 

                                                                                                                                                       
forecast of MPG from the 2001 NHTS, and then adding the increase in use estimated by applying the rebound effect 
to the reduction in fuel cost per mile resulting from the increase in its fuel economy between the baseline forecast 
and a higher CAFE standard. 
21 TWe assume that a vehicle’s fuel economy is constant over its lifetime, and that the test versus on-road fuel 
economy gap for each fuel is identical for all vehicle types and ages using that fuel.  
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on electricity for 50% of their annual mileage and on gasoline for the remaining 50%.  These 
values are inputs to the CAFE model, and can be adjusted by the user.  
 
As equation (12) indicates, many of the factors determining a vehicle model’s consumption of 
different fuels can vary depending on the CAFE standard that is in effect during the model year it 
is produced.  Specifically, the shares of miles for which it operates on different fuels, its fuel 
economy when using each different fuel, and as discussed previously, its average annual mileage 
can each differ between the baseline market forecast and any alternative CAFE level that the 
model is used to analyze.  These differences occur because manufacturers will increase the fuel 
economy of some models in response to increases in CAFE standards from their baseline level, 
and may convert some gasoline-powered models to diesel, FFVs, or PHEVs.   
 
 
Total use of each type of fuel during year t by all vehicles in use that were originally produced 
during a single model year is the sum of fuel consumed by the surviving vehicles of each model 
operating on that type of fuel.  Denoting this quantity GMY,t,CAFE,fuel, it is computed as: 
 

∑=
k

fuelCAFEtMYkfuelCAFEtMY gG ,,,,,,,  (13) 

 
Similarly, total consumption of each type of fuel by all vehicle models produced during a model 
year over their expected lifetimes, denoted GMY,CAFE,fuel, is given by: 
  

∑∑=
t k

fuelCAFEtMYkfuelCAFEMY gG ,,,,,,  (14) 

 
As with annual consumption of different types of fuels by individual vehicle models, total annual 
consumption of each fuel by all vehicle models will differ depending on the CAFE standard that 
prevailed during the model year when they were originally produced.  The change in fuel use 
that results from imposing a different CAFE standard is always measured relative to expected 
fuel use with some baseline or comparison standard in effect.   
 
The usual assumption employed in the CAFE model is that the baseline fuel economy levels for 
vehicles produced during a future model year would be those that manufacturers would provide 
if the most recently adopted standard were extended to apply to future model years.  Thus for 
example, the baseline fuel economy levels projected for vehicles produced during model years 
2017-25 are estimated under the assumption that the recently-adopted CAFE standards for model 
year 2016 cars and light trucks would be extended to apply to model years 2017-25.  Estimated 
fuel consumption with the 2016 CAFE standard assumed to remain in effect for model years 
after 2016 provides the baseline for measuring reductions in fuel use expected to result from 
adopting higher CAFE standards for model years 2017-25.  
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The change in total consumption of each fuel type during year t from imposing a higher CAFE 
standard for model year MY than that assumed to be in effect under the baseline forecast is given 
by: 
 

fuelBASEtMYfuelCAFEtMYfuelCAFEtMY GGG ,,,,,,,,, −=Δ  (15) 

 
Similarly, the savings in total consumption of each type of fuel by all vehicle models produced 
during a model year over their expected lifetimes is computed as: 
 

∑∑∑ −==Δ
t

fuelBASEtMY
t

fuelCAFEtMY
t

fuelCAFEtMYfuelCAFEMY GGGG ,,,,,,,,,,,  (16) 

 
Combined consumption and savings of all fuel types, as calculated from equations (13) through 
(16), are reported in both unadjusted gallons and gasoline gallon equivalents.  The former 
calculation simply sums total gallons of gasoline, diesel, and E85, and adds the gasoline gallon 
equivalent of electricity use by PHEVs and EVs.  These are the measures that are typically 
reported as “fuel consumption” and “fuel savings” in regulatory analyses produced using the 
CAFE model.  In addition, the model calculates the gasoline gallon equivalents of diesel and E85 
using their volumetric energy densities relative to that of gasoline, adds gasoline consumption in 
gallons and the gasoline gallon equivalent of electricity use, and reports their sum as total fuel 
consumption in gasoline gallon equivalents. 
 
 
 Greenhouse Gas Emissions 
 
Fuel savings from imposing stricter CAFE standards will result in lower emissions of carbon 
dioxide (CO2), the primary greenhouse gas emitted during the refining, distribution, and 
combustion of transportation fuels.22 Lower fuel consumption reduces carbon dioxide emissions 
directly, because the largest source of these emissions from transportation activity is fuel use by 
internal combustion engines. The CAFE model calculates CO2 emissions from vehicle operation 
by multiplying the number of gallons of fuel consumed by the carbon content per gallon of fuel, 
and then applying the ratio of carbon dioxide emissions generated per unit of carbon consumed 
during the combustion process.23  
 
  

                                                
22 Carbon dioxide emissions account for more than 97% of total greenhouse gas emissions from the refining and use 
of transportation fuels; see U.S. Environmental Protection Agency, Draft Inventory of GHG Emissions and Sinks 
(1990-1999), Tables ES-1 and ES-4, http://www.epa.gov/globalwarming/publications/emissions/us2001/energy.pdf. 
23 The carbon content of gasoline used in the CAFE model is a weighted average of those for different types of 
gasoline in use.  Although the model does not explicitly account for incomplete conversion of carbon to carbon 
dioxide, input values specifying carbon content can be adjusted accordingly (i.e., reduced to 99-99.5% of actual 
carbon content). 
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Emissions of carbon dioxide resulting from fuel consumption by all vehicle models produced in 
model year MY during year t, denoted CO2veh

MY,t,CAFE, are calculated from their consumption of 
each fuel type as:   
 

( )∑ ⎟
⎠

⎞
⎜
⎝

⎛=
fuel

fuelfuelfuelCAFEtMYCAFEtMY
veh CdGCO

12
442 ,,,,,  (17) 

 
where dfuel is the mass density of a fuel (measured in grams per gallon), Cfuel is the fraction of 
each fuel’s mass that represents carbon, and (44/12) is the ratio of the molecular weight of 
carbon dioxide to that of elemental carbon. This ratio measures the mass of carbon dioxide that is 
produced by complete combustion of mass of carbon contained in each gallon of fuel.  Vehicles 
operating on electricity are assumed to generate no CO2 emissions during vehicle use.  
   
As with the model’s calculations of fuel consumption, estimates of annual CO2 emissions from 
fuel use are summed over the calendar years that cars and light trucks produced during each 
model year are projected to remain in use to obtain estimates of lifetime emissions. Specifically, 
lifetime CO2 emissions from fuel consumption by cars or light trucks produced during model 
year MY are given by:  
 

∑=
t

CAFEtMYCAFEMY
veh COCO ,,, 22  (18) 

 
where t ranges from MY to MY plus the maximum age of a car or light truck.   
 
By reducing the volume of fuel consumed, raising CAFE standards will also affect carbon 
dioxide emissions from refining and distributing liquid fuels, as well as from generating 
electricity.  Carbon dioxide emissions occur during the production of petroleum-based fuels as a 
result of energy use for petroleum extraction, transportation, storage, and refining, as well as 
during storage and distribution of refined fuel.  Producing the chemical feedstocks or agricultural 
products from which non-petroleum fuels such as ethanol are derived also entails energy use and 
generates CO2 emissions, as does refining, storing, and distributing those fuels.  Generating 
electricity for use by PHEVs and EVs using fossil energy sources such as coal or natural gas also 
produces CO2 emissions.  
 
The CAFE model calculates reductions in carbon dioxide emissions from each stage of liquid 
fuel production and distribution using estimates of emissions in each stage of these processes per 
unit of fuel energy supplied.  These estimates are converted to a per-gallon basis using the 
energy content per gallon of gasoline, diesel, and ethanol, and multiplied by the volume of each 
fuel consumed to estimate total carbon dioxide emissions  from fuel production and distribution.  
Emissions from generating electricity are estimated from electricity consumption by PHEVs and 
EVs together with average CO2 emissions per unit of energy generated, assuming the U.S. 
average mix of fuel sources and transmission distances.  
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Total CO2 emissions from producing and distributing fuel consumed by vehicles of model year 
MY during year t of their lifetimes, denoted CO2ref

MY,t,CAFE, is given by: 
 

( )∑ ++=
fuel

fuel
d

fuel
r

fuel
f

fuelCAFEtMYCAFEtMY
ref COCOCOGCO 2222 ,,,,,  (19) 

 
where CO2f

fuel represents carbon dioxide emissions from feedstock production or extraction per 
gallon of each type of fuel, CO2r

fuel represents emissions per gallon of each type of fuel refined, 
and CO2d

fuel represents carbon dioxide emissions per gallon from transportation, storage, and 
distribution of liquid fuels.  For electricity, the sum of these three emission rates is replaced by a 
single rate, CO2 emissions per gasoline gallon equivalent of electrical energy generated.  This 
rate depends on the mix of fuels that is assumed to be used for generating electricity, and can be 
adjusted by the model user. 
 
Annual CO2 emissions generated by fuel production and distribution are then summed over the 
lifetimes of automobiles and light trucks produced during each model year: 
 

∑=
t

CAFETMYCAFEMY
ref COCO ,,, 22  (20) 

 
where t again ranges from MY to (MY+26) for cars or (MY+36) for light trucks.   
 
Finally, CO2 emissions from fuel consumption are combined with emissions generated during 
the fuel supply process to yield total CO2 emissions from fuel production and consumption by 
vehicles produced during a model year over their expected lifetimes.  Total lifetime emissions 
attributable to cars or light trucks produced during model year MY are: 
 

CAFEMY
ref

CAFEMY
veh

CAFEMY
tot COCOCO ,,, 222 +=  (21) 

 
The presence of the CAFE subscript on total emissions indicates that these depend on the 
specific CAFE standard in effect, because that standard affects the fuel economy of individual 
vehicle models and their lifetime total fuel consumption. The change in CO2 emissions expected 
to result from imposing a new CAFE standard for that model year is calculated as the difference 
in total lifetime emissions of cars or light trucks produced in that model year with the new 
standard in effect, and their total emissions with the baseline CAFE standard in effect: 
 
 

BASEMY
tot

CAFEMY
tot

CAFEMY
tot COCOCO ,,, 222 −=Δ  (22) 

 
Because imposing a higher CAFE standard reduces fuel consumption over the lifetimes of 
vehicles produced during the model years it affects, and CO2 emissions are a direct product of 
the volume of fuel produced and consumed, imposing a higher CAFE standard also reduces their 
lifetime CO2 emissions. 
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 Air Pollutant Emissions 
 
Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants, by-
products of fuel combustion that are also emitted during the production and distribution of fuel. 
Criteria pollutants that are emitted in significant quantities by light-duty motor vehicles include 
carbon monoxide, various hydrocarbon compounds, nitrogen oxides, sulfur dioxide, and fine 
particulate matter.   
 
The increased use of vehicle models with improved fuel economy that occurs through the fuel 
economy rebound effect causes increased emissions of most criteria pollutants, since federal 
standards regulate permissible emissions of these pollutants on a per-mile basis.24  In contrast, 
reductions in the volume of fuel consumed that result from requiring higher fuel economy cause 
emissions of criteria pollutants during fuel production and distribution to decline.  The net 
change in total emissions of each criteria pollutant that results from imposing a higher CAFE 
standard depends on the relative magnitudes of changes in emissions from vehicle use and from 
fuel refining and distribution.  
 
The CAFE model calculates emissions of most criteria pollutants resulting from vehicle 
operation by multiplying the number of miles driven by vehicles of a model year during each 
year they remain in service by per-mile emission rates for each pollutant, which are derived from 
EPA’s Motor Vehicle Emissions Simulator (MOVES).  These emission rates differ among 
automobiles and light trucks operating on different fuel types; PHEVs operating on electricity 
and EVs are assumed to generate no emissions of criteria air pollutants during vehicle use.  
Total emissions of a criteria pollutant from the use of cars or light trucks produced during model 
year MY during year t of their lifetimes, denoted Eveh

MY,t, are thus: 
 

∑∑ −=
fuel k

fuelMYtkfuelCAFEMYkCAFEtMYkCAFEtMY
veh esME ,,,,,,,,,,  (23) 

 
where, as in equation (12) above, Mk,MY,t,CAFE	
   	
   is	
   total miles driven during year t by vehicles of 
model k originally produced during model year MY, and	
  sk,MY,CAFE,fuel	
  is the share of those miles 
that model k operates on each type of fuel.25   
 
In equation (23), ek,t-MY,fuel is the per-mile rate at which vehicles of  model k emit a criteria air 
pollutant during year t when using each type of fuel.  These emission rates can depend on a 
vehicle model’s age and accumulated mileage, and during year t, vehicles produced during 
model year MY will have reached age (t-MY).26  Emission rates from vehicle use also depend on 

                                                
24 The exception is sulfur dioxide, which is estimated from the sulfur content of each type of fuel using a procedure 
exactly analogous to the estimation of CO2 emissions from the carbon content of each fuel type.   
25 As in equation (12), the CAFE subscript on s indicates that the type of fuel on which a vehicle model produced 
during a specific model year operates can depend on the CAFE standard in effect for that model year.   
26 The emission rates derived from MOVES are projected to be identical for all model years after 2011, and to 
remain constant over those vehicles’ lifetimes.  
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fuel type, although vehicles using electricity are assumed to produce no emissions during their 
operation.  
 
As with fuel use and CO2 emissions, annual emissions of each criteria air pollutant are summed 
over the future years that vehicle models originally produced during each model year are 
expected to be in service, in order to produce estimates of their total lifetime emissions: 
 

∑=
t

CAFEtMY
veh

CAFEMY
veh EE ,,,  (24) 

 
where as usual, t begins at a value of MY and increases to MY plus the maximum lifetimes 
assumed for automobiles and light trucks.  
 
Emissions of criteria air pollutants that occur during fuel refining and distribution are estimated 
by applying emission factors for each pollutant per gallon of fuel refined to the total volumes of 
gasoline, diesel, and ethanol projected to be consumed during future years.  Emissions from 
generating electricity used by PHEVs and EVs are calculated using emission factors for each 
criteria air pollutant per unit of electricity generated.  In contrast to CO2 emissions, which are 
included regardless of where petroleum extraction and fuel refining occur throughout the world, 
only domestic emissions of criteria air pollutants are included.   
 
Thus emissions of each criteria air pollutant from producing and distributing the fuel consumed 

by cars or light trucks of model year MY during year t of their lifetimes, denoted Eref
MY,t,CAFE, are: 

 
 ))[,,,, fuel

d
fuelfuel

r
fuelfuelfuel

f

t
fuelCAFEtmyCAFEMY

ref erefreGE ++=∑  (25) 

 
where ef

fuel, er
fuel, and ed

fuel are emissions of a criteria air pollutant per gallon of fuel supplied that 
occur during feedstock production or extraction, fuel refining, and transportation, storage, and 
distribution of refined fuel.  Because different fuels utilize different feedstocks, refining 
processes, and distribution networks, each of these factors can differs by type of fuel.  The 
parameter rfuel indicates the fraction of each type of fuel that is refined domestically (using either 
domestically-produced or imported feedstocks), while ffuel indicates fraction of domestic refining 
that utilizes domestically-produced feedstocks.   
 
For vehicles operating on electricity, the bracketed expression in equation (25) is replaced by a 
single factor measuring criteria pollutant emissions per gasoline gallon equivalent of electricity 
generated.  As with CO2 emissions, the values of these emission factors for each criteria air 
pollutant depend on the fuel mix assumed to be used for generating electricity, and can be 
adjusted accordingly by the model user.  All electricity consumed by PHEVs and EVs is 
assumed to be generated domestically.	
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Emissions of each criteria pollutant attributable to producing and distributing the fuel consumed 
by cars or light trucks initially produced during model year MY over their lifetimes are:  
 

∑=
t

CAFETMY
ref

CAFEMY
ref EE ,,,  (26) 

 
Finally, total emissions of each criteria pollutant over the lifetimes of cars or light trucks of 
model year MY are the sum of emissions that occur as a result of their lifetime use, and emissions 
from producing and distributing the fuel they consume over their lifetimes: 
 

CAFEMY
ref

CAFEMY
veh

CAFEMY
tot EEE ,,, +=  (27) 

 
Again, the presence of the CAFE subscript in equation (27) indicates that vehicles’ lifetime 
emissions depend on the CAFE standard in effect during the model year they are produced, 
through its effect on their fuel economy, usage, and fuel consumption.   
 
As a consequence, total lifetime emissions of each criteria air pollutant by cars and light trucks 
produced during future model years will differ between the baseline CAFE standard and any 
alternative standard that is specified.  The model calculates the effect of imposing a higher CAFE 
standard on emissions of criteria air pollutants as the difference between lifetime emissions by 
cars and light trucks produced during each model year it would affect, and those vehicles’ 
emissions under the baseline CAFE standard:  
 

BASEMY
tot

CAFEMY
tot

CAFEMY
tot EEE ,,, −=Δ  (28) 

 
 Private versus Social Costs and Benefits 
 
Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs, many 
of which affect buyers of those vehicles directly. Depending upon how manufacturers attempt to 
recoup the costs they incur for improving the fuel efficiency of selected models, buyers are likely 
to face higher prices for some – and perhaps even most – new vehicle models. Purchasers of 
models whose fuel economy is improved benefit from the resulting savings in the cost of fuel 
their vehicles consume, from any increase in the range they can travel before needing to refuel, 
and from the added driving they do as a result of the rebound effect. Depending on the 
technology manufacturers use to improve fuel economy and its consequences for vehicle power 
and weight, these benefits may be partly offset by a slight decline in the performance of some 
new models. 
 
At the same time, the reduction in fuel production and use resulting from improved fuel economy 
produces certain additional benefits and costs to society as a whole. Potential social benefits 
from reduced fuel use include any value that society or the U.S. economy attaches to saving fuel 
over and above its private value to new vehicle buyers, lower emissions of air pollutants and 
greenhouse gases generated by from fuel production, distribution, and consumption, and reduced 
economic costs associated with U.S. imports of crude petroleum and refined fuel. By causing 
some additional driving through the rebound effect, improving fuel economy can also increase a 
variety of social costs, including the economic value of health effects and property damages 
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caused by increased air pollution, the value of time delays to motorists from added traffic 
congestion, added costs of injuries and property damage resulting from more frequent traffic 
accidents, and economic costs from higher levels of traffic noise. 
 
The following sections discuss how each of these benefits and costs can result from improving 
the fuel economy of new vehicles, the factors affecting their likely magnitudes, and how their 
values are commonly measured or estimated. 0 provides examples of specific unit economic 
values and other parameters used to estimate the aggregate value of these various benefits and 
costs, explains how these sample values were derived, and reports the specific sources from 
which they were obtained. 
 
S5.1 Benefits and Costs to New Vehicle Buyers 
 
S5.1.1 Increases in New Vehicle Prices 
 
Depending upon how manufacturers attempt to recover the costs they incur in complying with 
CAFE regulations, purchase prices for some new models are likely to increase. Because we 
assume that manufacturers fully recover all costs they incur for installing fuel economy 
technologies to comply with CAFE in the form of higher prices for some models, the total 
increase in vehicle sales prices has already been accounted for in estimating technology costs to 
manufacturers. Nevertheless, the total value of these price increases represent a cost of CAFE 
regulation from the viewpoint of buyers of vehicle models whose prices rise. 
 
In addition to increases in the prices paid by buyers who elect to purchase these models even at 
their higher prices, higher prices result in losses in welfare or consumer surplus to buyers who 
decide to purchase different models instead. These losses are extremely complex to estimate if 
prices change for a large number of models, and in any case are likely to be small even in total. 
Thus we do not attempt to estimate their value. 
 
S5.1.2 The Value of Fuel Savings 
 
The CAFE modeling system estimates the economic value of fuel savings to buyers of new 
vehicle models whose fuel economy is improved by applying the forecast (an input to the model) 
of future retail fuel prices to each year’s estimated fuel savings for those models. The annual fuel 
savings for a model during each year of its lifetime in the vehicle fleet is multiplied by the 
number of those initially sold that are expected to remain in use during that year to determine the 
total annual value of fuel savings to buyers of that model. 
 
The forecast retail price of fuel per gallon—including federal and average state fuel and other 
taxes—during that year is used to estimate the value of these fuel savings as viewed from the 
perspective of their buyers. Based on evidence from previous studies of consumer purchases of 
automobiles and durable appliances, we assume that new vehicle buyers value these savings over 
the approximate number of years (an input to the model) they expect to own a new vehicle, and 
that they discount these expected savings to the year in which they purchase new vehicles. 
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S5.1.3 Benefits from Additional Driving 
 
The rebound effect also results in additional benefits to new vehicle buyers in the form of 
consumer surplus from the increased driving it produces. These benefits arise from the value to 
drivers and passengers of the social and economic opportunities made available to them by 
additional traveling. As evidenced by the fact that they elect to make more frequent or longer 
trips when improved fuel economy reduces the cost of driving, the benefits from this additional 
travel exceed the costs drivers and their passengers incur in making more frequent or longer 
trips. The amount by which these benefits from additional travel exceed its cost to them—which 
has been reduced by improved fuel economy—represents the increase in consumer surplus 
associated with additional rebound effect driving. 
 
The system estimates the value of these benefits using the conventional approximation of one 
half of the product of the decline in fuel cost per mile driven and the resulting increase in the 
annual number of miles driven. This value is calculated for each year that a model whose fuel 
economy is improved remains in the fleet, multiplied by the number of vehicles of that model 
expected to remain in use during each year of its lifetime, and discounted to its present value as 
of the year it was purchased. Given typical input values (e.g, for fuel prices), this benefit is 
relatively small by comparison to most other economic impacts of raising CAFE standards. 
 
S5.1.4 The Value of Extended Refueling Range 
 
Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also 
increase their driving range per tank of fuel. By reducing the frequency with which drivers 
typically refuel their vehicles, and by extending the upper limit of the range they can travel 
before requiring refueling, improving fuel economy thus provides some additional benefits to 
their owners.27 No direct estimates of the value of extended vehicle range are readily available, 
so the CAFE model calculates the reduction in the annual number of required refueling cycles 
that results from improved fuel economy. The change in required refueling frequency for vehicle 
models with improved fuel economy reflects the increased driving associated with the rebound 
effect, as well as the increased driving range stemming from higher fuel economy. 
 
S5.1.5 Changes in Performance and Utility 
 
The system currently assumes that the costs and effects of fuel-saving technologies reflect the 
application of these technologies in a manner that holds vehicle performance and utility constant.  
Therefore, the system currently does not estimate changes in vehicle performance or utility. 
 
S5.1.6 Social Benefits and Costs from Increased Fuel Economy 
 
S5.1.6.1 The “Social Value” of Fuel Savings 
 
The economic value to society of the annual fuel savings resulting from stricter CAFE standards 
is also assessed by applying estimated future fuel prices to each year’s estimated fuel savings. 

                                                
27 If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a 
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices. 



DRAFT – December 2011 

36 

Unlike the value of fuel savings to vehicle buyers themselves, however, the pre-tax price per 
gallon is used in assessing the value of fuel savings to the economy as a whole. This is because 
reductions in payments of state and federal taxes by purchasers of fuel will be exactly offset by 
reduced spending on the construction and maintenance of streets and highways that fuel taxes are 
mainly used to finance, and thus do not reflect a net savings in resources to the economy. 
 
When estimating the nationwide aggregate economic benefits and costs from CAFE regulation, 
we include this “social” value of fuel savings rather than their private value to vehicle buyers. In 
computing the social value of fuel savings, we include their annual value over the entire 
expected lifetimes of vehicle models whose fuel economy is improved, reflecting the presumably 
longer-term horizon of society as a whole compared to that of vehicle buyers, who may be 
concerned with fuel savings only over the time they expect to own newly-purchased vehicles. 
 
S5.1.6.2 Economic Benefits from Reduced Petroleum Imports 
 
Importing petroleum into the United States is widely believed to impose significant costs on 
households and businesses that are not reflected in the market price for imported oil, and thus are 
not borne by consumers of refined petroleum products. These costs include three components: 
(1) higher costs for oil imports resulting from the combined effect of U.S. import demand and 
OPEC market power on the world oil price; (2) the risk of reductions in U.S. economic output 
and disruption of the domestic economy caused by sudden reductions in the supply of imported 
oil; and (3) costs for maintaining a U.S. military presence to secure imported oil supplies from 
unstable regions, and for maintaining the Strategic Petroleum Reserve (SPR) to cushion against 
price increases. By reducing domestic demand for gasoline, tighter CAFE standards can reduce 
petroleum imports, and thus reduce these social costs to the extent that their magnitude varies 
with the volume of U.S. oil imports. Any reduction in their magnitude represents an additional 
category of economic benefits from tighter fuel economy standards. 
 
In this analysis, the reduction in petroleum imports resulting from higher light truck CAFE 
standards is estimated by assuming that the resulting savings in gasoline use during each future 
year is translated directly into a corresponding reduction in the annual volume of U.S. oil imports 
during that same year. The value to the U.S. economy of reducing petroleum imports -- in the 
form of lower crude oil prices and reduced risks of oil supply disruptions – is estimated by 
applying the sum of the previously reported estimates of these benefits to the estimated annual 
reduction in oil imports. 
 
S5.1.6.3 Valuing Changes in Environmental Impacts 
 
The CAFE modeling system estimates the economic value of the net change in emissions of 
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides, 
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton of 
emissions of each of these pollutants. As indicated previously, emissions of criteria pollutants 
can rise or fall when fuel economy increases, so the economic costs of these emissions can 
increase or decline in response to higher CAFE standards. 
 



DRAFT – December 2011 

37 

The model estimates changes in damage costs caused by carbon dioxide emissions by 
multiplying the magnitude of the change in emissions by the estimated value of damages per unit 
of emissions. 
 
S5.1.7 Social Costs of Added Driving 
 
In addition to increasing emissions of criteria pollutants, any added driving associated with the 
fuel economy rebound effect may contribute to increased traffic congestion, motor vehicle 
accidents, and highway noise. Additional vehicle use can contribute to traffic congestion and 
delays partly by increasing recurring congestion on heavily-traveled facilities during peak travel 
periods, depending on how the additional travel is distributed over the day and on where it 
occurs. Added driving can also increase the frequency of incidents such as collisions and 
disabled vehicles that cause prolonged delays, although the extent to which it actually does do 
will again depend partly on when and where the added travel occurs. Finally, added vehicle use 
from the rebound effect may also increase traffic noise, which causes inconvenience, irritation, 
and potentially even discomfort to occupants of other vehicles, pedestrians and other bystanders, 
and residents or occupants of surrounding property. 
 
The CAFE modeling system uses estimates of the increases in external costs – that is, the 
marginal social costs – from added congestion, property damages and injuries in traffic 
accidents, and noise levels caused by additional vehicle usage. It does so by applying estimates 
of the increases in these costs that result from each added mile of travel by different types of 
vehicles (passenger and nonpassenger automobiles) to the increase in the total number of miles 
driven projected to result from the rebound effect. 
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Appendix A Model Inputs 
 
The CAFE Compliance and Effects Modeling System utilizes a set of data files used as input to 
the analysis.  All input files are specified in Microsoft® Excel format and are outline in Table 5 
below.  The user can define and edit all inputs to the system.  For example, the system does not 
require market data constructed using confidential business information. 
 

Table 5. Input Files 
Input File Contents 

Market Data 
(Manufacturers Worksheet) 

Contains an indexed list of manufacturers available during the study period, along 
with manufacturer’s willingness to pay fines and other manufacturer-specific 
modeling settings. 

Market Data 
(Vehicles Worksheet) 

Contains an indexed list of vehicle models available during the study period, along 
with sales volumes, fuel economy levels, prices, other attributes, domestic labor 
utilization, references to specific engines and transmissions used, and optional 
settings related to technology applicability, designation as a passenger or 
nonpassenger automobile, and coverage of vehicles with GVWR above 8,500 
pounds. 

Market Data 
(Engines Worksheet) 

Contains an indexed list of engines available during the study period, along with 
various engine attributes and optional settings related to technology applicability. 

Market Data 
(Transmissions Worksheet) 

Contains an indexed list of transmissions available during the study period, along 
with various transmission attributes and optional settings related to technology 
applicability. 

Technologies Specifies estimates of the availability, cost, and effectiveness of various 
technologies, specific to various vehicle categories. 

Parameters 
Provides inputs used to calculate travel demand, fuel consumption, carbon dioxide 
and criteria pollutant emissions, and economic externalities related to highway travel 
and petroleum consumption. 

Emissions Rates Provides inputs used to project the emissions rates of various pollutants. 

Scenarios Specifies coverage, structure, and stringency of CAFE standards for scenarios to be 
simulated. 

EIS Parameters Provides additional inputs necessary for calculating VMT and fuel use for the EIS.  
This input file is required for EIS modeling only. 

EIS Tailpipe Emissions Provides inputs necessary for calculating tailpipe emissions for the EIS .  This input 
file is required for EIS modeling only. 
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A.1 Market Data File 
 
The market data file contains four worksheets:  Manufacturers, Vehicles, Engines and 
Transmissions.  Taken together, the manufacturers, vehicle models, engines, and transmissions 
worksheets provide “initial state” historical and/or forecast data for the light vehicle fleet.  The 
sections below describe each worksheet in greater detail. 
 
A.1.1 Manufacturers Worksheet 
 
The manufacturers input worksheet contains a list of all manufacturers that produce vehicle 
models offered for sale during the study period.  Each manufacturer has a unique code and is 
represented by a unique manufacturer name.  For each manufacturer, the manufacturer code, 
name, cost allocation strategy, discount rate, payback periods, and willingness to pay CAFE 
fines must all be specified.  Available credits, if applicable, should be expressed in Vehicle/MPG 
and is applied directly as a credit (positive or negative) to the CAFE level for the given 
manufacturer in the given model year.  If no available credits are to be specified, a value of zero 
(0.0) can be used or the cell can be left blank. 
 

Table 6. Manufacturers Worksheet 

 
 

Category Column Units Definition/Notes
Manufacturer Code integer Unique number assigned to each manufacturer.
Manufacturer Name text Name of the manufacturer.

Cost Allocation Strategy integer

The cost allocation strategy the manufacturer will use for allocating costs.
  0 = allocate technology costs on an as-incurred basis
  1 = distribute technology costs and fines based on the share of aggregate sales 
revenue
  2 = not used
  3 = distribute technology costs and fines evenly

Discount Rate number Represents the manufacturer specific discount rate, which factors into the 
effective cost calculation.

Payback Period number The number of years required for an initial investment to be repaid in the form of 
future benefits or cost savings.

Payback Period
(After Compliance)

number The payback period to use after the manufacturer reached compliance.

Optimize text Y = consider the manufacturer during optimization
N = do not consider the manufacturer during optimization

2009 text
2010 text

2024 text
2025 text
2009 vehicle-mpg
2010 vehicle-mpg

2024 vehicle-mpg
2025 vehicle-mpg
2009 vehicle-mpg
2010 vehicle-mpg

2024 vehicle-mpg
2025 vehicle-mpg
2009 vehicle-mpg
2010 vehicle-mpg

2024 vehicle-mpg
2025 vehicle-mpg

text Y = apply manufacturer's credits to the baseline scenario
N = do not apply manufacturer's credits to the baseline scenario
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Credits Apply to Baseline

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Domestic Automobiles.

Represents the manufacturer's willingness to pay fines.
  Y = pay fines instead of applying ineffective technologies
  N = apply ineffective technologies instead of paying fines

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Imported Automobiles.

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Light Trucks.
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A.1.2 Vehicles Worksheet 
 
The vehicles worksheet contains information regarding each vehicle model offered for sale 
during the study period.  Each vehicle model is represented as a single row of input data. Data in 
Table 7, Table 8, and Table 9 list the different columns of information specified in the vehicle 
models file.  To make the information readable, the Vehicle Models tables are presented 
vertically and divided into sections. 
 
In the “General” category, the vehicle code, manufacturer, model, nameplate, engine code, 
transmission code, and origin must be specified for each vehicle model.  The engine and 
transmission codes must refer to a valid engine and transmission, respectively, for the relevant 
manufacturer in the engines and transmissions worksheets.  Vehicle’s fuel economy and assumed 
share of operating on a specific fuel are specified in the “Fuel Economy” section.  Known or 
projected sales are specified in the “Sales” section for each model year in which the model is 
offered.  The known or projected MSRP should be specified in its corresponding section for each 
model year in which the vehicle model is offered for sale.  In the “Regulatory Classification” 
section, the regulatory, technology, and safety class assignments for each vehicle must be 
specified. 
 

Table 7. Vehicles Worksheet (1) 

 

Category Column Units Definition/Notes
Vehicle Code integer Unique number assigned to each vehicle.
Manufacturer text The manufacturer of the vehicle.
Model text Name of the vehicle model.
Nameplate text The nameplate of the vehicle.
Engine Code integer The engine code of the engine that the vehicle uses.
Transmission Code integer The transmission code of the transmission that the vehicle uses.
Origin text D = domestic; I = imported
Fuel Economy (Gasoline) number
Fuel Economy (Diesel) number

Fuel Economy (Ethanol-85) number

Fuel Economy (Electricity) number

Fuel Economy (Hydrogen) number

Fuel Share (Gasoline) number
Fuel Share (Diesel) number
Fuel Share (Ethanol-85) number
Fuel Share (Electricity) number
Fuel Share (Hydrogen) number
MY2009 units
MY2010 units

MY2024 units
MY2025 units
MY2009 dollars
MY2010 dollars

MY2024 dollars
MY2025 dollars

Regulatory Class text
The regulatory assignment of the vehicle.
  PC = the vehicle should be regulated as a passenger automobile
  LT = the vehicle should be regulated as a light truck

Technology Class text The technology class of the vehicle.

Safety Class text

The safety class assignment of the vehicle.
  PC = the vehicle belongs to a passenger automobile safety class
  LT = the vehicle belongs to a light truck/SUV safety class
  CM = the vehicle belongs to a light CUV/minivan safety class

Market Segment integer The market segment of the vehicle (between 1 and 24).
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The percent share that the vehicle runs on each fuel type.

The CAFE fuel economy rating of the vehicle for each fuel type.

Vehicle's projected production for sale in the US.

Vehicle's projected average MSRP (sales-weighted, including options).…

…
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Within the “Vehicle” category, it is important that each vehicle model's class, style, structure, 
drive, footprint, curb weight, GVWR, and fuel capacity be specified.  For any hybrid vehicle 
models, it is necessary to specify the type of hybridization as well.  If a vehicle also operates on 
electricity, the electric power and range need to be available as well.  In the “Planning & 
Assembly” section, the redesign and refresh years must be comma separated and contain all 
known previous and projected future redesign and refresh years. 
 

Table 8. Vehicles Worksheet (2) 

 
 
The applicability of technologies considered on a vehicle model basis (as opposed, for example, 
on an engine basis) can be controlled for each vehicle model by using the “Technology 
Applicability” category.  This section must be completed to prevent double counting of 
technologies. 
 

Table 9. Vehicles Worksheet (3) 

 
 

Category Column Units Definition/Notes
Class text Vehicle class.
Style text Vehicle style.
Structure text Vehicle structure (e.g., ladder or unibody).

Drive text Vehicle drive (e.g., A=all-wheel drive, F=front-wheel drive, R=rear-wheel drive, 
4=four-wheel drive).

Footprint sq. feet The vehicle footprint; wheelbase times average track width.

Curb Weight pounds
Total weight of the vehicle, including batteries, lubricants, and other expendable 
supplies, but excluding the driver, passengers, and other payloads (SAE J1100).

GVWR pounds Gross Vehicle Weight Rating; weight of loaded vehicle, including passengers and 
cargo.

Seating (Max) integer The number of usable seat belts before folding and removal of seats (where 
accomplished without specific tools).

Fuel Capacity gallons The capacity of the vehicle's fuel tank in gallons of diesel fuel or gasoline; MJ 
(LHV) of other fuels (or chemical battery energy).

Type of Hybrid/Electric 
Vehicle

text Hybridization type of the vehicle, if any.

Electric Power number The power rating (equivalent to engine horsepower) for an electric vehicle.
Electric Range number The range of an electric vehicle, in miles, when operating on a battery.
Refresh Years model year Comma separated list of previous and future refresh years of the vehicle.
Redesign Year model year Comma separated list of previous and future redesign years of the vehicle.

Hybridization

Planning and 
Assembly
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Category Column Units Definition/Notes
EPS text
IACC1 text
IACC2 text
MHEV text
ISG text
SHEV1 text
SHEV1_2 text
SHEV2 text
PHEV1 text
PHEV2 text
EV1 text
EV2 text
EV3 text
EV4 text
FCV text
MR1 text
MR2 text
MR3 text
MR4 text
MR5 text
ROLL1 text
ROLL2 text
ROLL3 text
LDB text
SAX text
AERO1 text
AERO2 text
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<blank> = the technology is not used on the vehicle
USED = the technology is used on the vehicle
SKIP = the technology is not applicable to the vehicle
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A.1.3 Engines Worksheet 
 
Similar to the vehicles input sheet, the engines worksheet contains a list of all engines used in 
vehicle models offered for sale during the study period.  For each manufacturer, the engine code 
is a unique number assigned to each such engine.  This code is referenced in the engine code 
field on the vehicles worksheet.  For each engine, the engine code, manufacturer, configuration, 
fuel, cycle, aspiration, valve actuation/timing, valve lift, number of cylinders, number of valves 
per cylinder, and horsepower must all be specified.  As in the vehicles worksheet, the technology 
applicability for any engine technology must be specified for any specific engine. 
 

Table 10. Engines Worksheet 

 
 

Category Column Units Definition/Notes
Engine Code integer Unique number assigned to each engine.
Manufacturer text The manufacturer of the engine.
Configuration text Configuration of the engine.

Fuel text
One or more fuel types with which the engine is compatible:
G = gasoline only; D = diesel only; E85 = ethanol-85 only; G+E85 = flex fuel 
engine, running on gasoline and ethanol-85

Engine Oil Viscosity text Ratio between the applied shear stress and the rate of shear, which measures the 
resistance of flow of the engine oil (as per SAE Glossary of Automotive Terms).

Cycle text Combustion cycle of the engine.
Fuel Delivery System text The mechanism that delivers fuel to the engine.

Aspiration text Breathing or induction process of the engine (as per SAE Automotive 
Dictionary).

Valvetrain Design text Design of the total mechanism from camshaft to valve of an engine that actuates 
the lifting and closing of a valve (as per SAE Automotive Dictionary).

Valve Actuation/Timing text Valve opening and closing points in the operating cycle (SAE J604).

Valve Lift text The manner in which the valve is raised during combustion (as per SAE 
Automotive Dictionary).

Cylinders integer Number of engine cylinders.
Valves/Cylinder integer Number of valves per cylinder.
Deactivation text Weighted (FTP+highway) aggregate degree of deactivation.
Displacement liters Total volume displaced by a piston in a single stroke.
Max. Horsepower number Maximum horsepower of the engine (horsepower).
Max. Torque number Maximum torque of the engine (pound-foot).
LUB1 text
EFR1 text
LUB2_EFR2 text
CCPS text
DVVLS text
DEACS text
ICP text
DCP text
DVVLD text
CVVL text
DEACD text
SGDI text
DEACO text
VVA text
SGDIO text
TRBDS1_SD text
TRBDS1_MD text
TRBDS1_LD text
TRBDS2_SD text
TRBDS2_MD text
TRBDS2_LD text
CEGR1_SD text
CEGR1_MD text
CEGR1_LD text
CEGR2_SD text
CEGR2_MD text
CEGR2_LD text
ADSL_SD text
ADSL_MD text
ADSL_LD text

<blank> = the technology is not used on the engine
USED = the technology is used on the engine
SKIP = the technology is not applicable to the engine
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A.1.4 Transmissions Worksheet 
 
Similar to the vehicles and engines input sheets, the transmissions worksheet contains a list of all 
transmissions used in vehicle models offered for sale during the study period.  For each 
manufacturer, the transmission code is a unique number assigned to each such transmission.  
This code is referenced in the transmission code field on the vehicles worksheet.  For each 
transmission, the transmission code, manufacturer, type, and number of forward gears must all 
be specified.  As in the vehicles worksheet, the technology applicability for any transmission 
technology must be specified for any specific transmission. 
 

Table 11. Transmissions Worksheet 

 
 
  

Category Column Units Definition/Notes
Transmission Code integer Unique number assigned to each transmission.
Manufacturer text The manufacturer of the transmission.
Type text Type of the transmission.
Number of Forward Gears integer Number of forward gears the transmission has.
6MAN text
HETRANSM text
IATC text
NAUTO text
DCT text
8SPD text
HETRANS text
SHFTOPT text
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<blank> = the technology is not used on the transmission
USED = the technology is used on the transmission
SKIP = the technology is not applicable to the transmission
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A.2 Technologies File 
 
The technologies input file contains assumptions regarding the fuel consumption benefit, cost, 
applicability, and availability of different vehicle, engine, and transmission technologies during 
the study period.  Input assumptions are specific to each of the following vehicle technology 
classes:  subcompact cars, subcompact performance cars, compact cars, compact performance 
cars, midsize cars, midsize performance cars, large cars, large performance cars, minivans, small 
pickups and SUVs, midsize pickups and SUVs, and large pickups and SUVs.  Input assumptions 
that are common among all technology classes are listed on a separate technologies definitions 
tab.  Below, Table 12 shows sample technologies definitions for all classes while Table 13 shows 
sample technology assumptions for subcompact cars. 
 
For each technology, Table 12 contains the following: 

• Index:  Specifies the index of the technology, which loosely reflects the sequence to 
follow when populating technology groups. 

• Technology:  Represents the full technology name. 

• Abbr.:  Represents the technology abbreviation used in output files. 

• TechType:  Specifies the technology group to which the technology belongs. 

• Phase-in Values (PV-1 to PV-17):  Specifies the percentage of the entire fleet to which 
the technology can be applied, for each model year. 

• Early Replacement Penalty Cost Table (ERC-1 to ERC-10)28:  Provides a table of “early 
replacement” penalty costs for the technology. 

 
For each technology, Table 13 contains (again, as an example, for subcompact cars) the 
following: 

• Index:  Specifies the index of the technology, which loosely reflects the sequence to 
follow when populating technology groups. 

• Technology:  Represents the full technology name. 

• Abbr.:  Represents the technology abbreviation used in output files. 

• TechType:  Specifies the technology group to which the technology belongs. 

• Applicable:  Specifies if the technology is available for applicability in a given 
technology class. 

• Year Avail.:  Specifies the first year the technology is available for applicability. 

• Year Retired:  Specifies the last year the technology is available for applicability. 

                                                
28 Additional discussion of stranded capital may be found in Chapter 5 of the TSD. 
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• Electric Range:  Specifies what the range, in miles, of an electric vehicle would be when 
operating on a battery, as a result of applying the technology.  This field should only be 
specified for PHEV and EV technologies. 

• Delta Weight (%):  Specifies the percentage by which the vehicle's weight changes as a 
result of applying the technology. 

• Delta Weight (lbs):  Specifies the amount of pounds by which the vehicle's weight 
changes as a result of applying the technology. 

• Loss of Value:  Specifies what the loss in value to the consumer would be after applying 
the technology. 

• FC:  Specifies the overall fuel consumption improvement estimate of the technology. 

• FCg:  Specifies the fuel consumption improvement estimate to apply to the gasoline fuel 
economy value (applicable to plug-in HEVs only). 

• FCg Share:  Specifies the percentage of time the vehicle is expected to run on the 
gasoline fuel after applying the technology (applicable to plug-in HEVs only). 

• Cost Table:  Provides a table of learned out cost estimates for the technology, for each 
model year. 
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Table 12. Technologies Definitions (Sample) 

 

Index Technology Abbr.  TechType PV-1 PV-2 … PV-16 PV-17 ERC-1 ERC-2 … ERC-9 ERC-10
1 Low Friction Lubricants - Level 1 LUB1 EngMod 30% 40% 100% 100%
2 Engine Friction Reduction - Level 1 EFR1 EngMod 30% 40% 100% 100%
3 Low Friction Lubricants and Engine Friction Reduction - Level 2LUB2_EFR2 EngMod 0% 0% 96% 100%
4 Variable Valve Timing (VVT) - Coupled Cam Phasing (CCP) on SOHCCCPS EngMod 15% 25% 100% 100%
5 Discrete Variable Valve Lift (DVVL) on SOHCDVVLS EngMod 15% 25% 100% 100%
6 Cylinder Deactivation on SOHC DEACS EngMod 15% 25% 100% 100%
7 Variable Valve Timing (VVT) - Intake Cam Phasing (ICP)ICP EngMod 15% 25% 100% 100%
8 Variable Valve Timing (VVT) - Dual Cam Phasing (DCP)DCP EngMod 15% 25% 100% 100%
9 Discrete Variable Valve Lift (DVVL) on DOHCDVVLD EngMod 15% 25% 100% 100%
10 Continuously Variable Valve Lift (CVVL) CVVL EngMod 15% 25% 100% 100%
11 Cylinder Deactivation on DOHC DEACD EngMod 15% 25% 100% 100%
12 Stoichiometric Gasoline Direct Injection (GDI)SGDI EngMod 15% 25% 100% 100%
13 Cylinder Deactivation on OHV DEACO EngMod 15% 25% 100% 100%
14 Variable Valve Actuation - CCP and DVVL on OHVVVA EngMod 15% 25% 100% 100%
15 Stoichiometric Gasoline Direct Injection (GDI) on OHVSGDIO EngMod 15% 25% 100% 100%
16 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Small DisplacementTRBDS1_SD EngMod 15% 25% 100% 100%
17 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Medium DisplacementTRBDS1_MD EngMod 15% 25% 100% 100%
18 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Large DisplacementTRBDS1_LD EngMod 15% 25% 100% 100%
19 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Small DisplacementTRBDS2_SD EngMod 0% 0% 75% 75%
20 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Medium DisplacementTRBDS2_MD EngMod 0% 0% 75% 75%
21 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Large DisplacementTRBDS2_LD EngMod 0% 0% 75% 75%
22 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Small DisplacementCEGR1_SD EngMod 0% 0% 75% 75%
23 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Medium DisplacementCEGR1_MD EngMod 0% 0% 75% 75%
24 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Large DisplacementCEGR1_LD EngMod 0% 0% 75% 75% $72.65 $64.51 $8.06 $0.00
25 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Small DisplacementCEGR2_SD EngMod 0% 0% 45% 50%
26 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Medium DisplacementCEGR2_MD EngMod 0% 0% 45% 50%
27 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Large DisplacementCEGR2_LD EngMod 0% 0% 45% 50%
28 Advanced Diesel - Small DisplacementADSL_SD EngMod 0% 0% 6% 6%
29 Advanced Diesel - Medium DisplacementADSL_MD EngMod 0% 0% 6% 6%
30 Advanced Diesel - Large DisplacementADSL_LD EngMod 0% 0% 6% 6%
31 6-Speed Manual/Improved Internals 6MAN TrMod 15% 25% 100% 100% $35.82 $31.84 $3.98 $0.00
32 High Efficiency Gearbox (Manual) HETRANSM TrMod 0% 0% 96% 100%
33 Improved Auto. Trans. Controls/ExternalsIATC TrMod 15% 25% 100% 100%
34 6-Speed Trans with Improved Internals (Auto)NAUTO TrMod 15% 25% 100% 100% $79.19 $66.94 $7.81 $0.00
35 6-speed DCT DCT TrMod 15% 25% 100% 100% $35.82 $31.84 $3.98 $0.00
36 8-Speed Trans (Auto or DCT) 8SPD TrMod 0% 0% 100% 100% $35.82 $31.84 $3.98 $0.00
37 High Efficiency Gearbox (Auto or DCT)HETRANS TrMod 0% 0% 96% 100%
38 Shift Optimizer SHFTOPT TrMod 0% 0% 100% 100%
39 Electric Power Steering EPS ELEC 5% 20% 100% 100%
40 Improved Accessories - Level 1 IACC1 ELEC 5% 20% 100% 100%
41 Improved Accessories - Level 2 (w/ Alternator Regen and 70% efficient alternator)IACC2 ELEC 0% 0% 100% 100%
42 12V Micro-Hybrid (Stop-Start) MHEV ELEC 15% 25% 100% 100%
43 Integrated Starter Generator ISG ELEC 0% 0% 45% 50%
44 Strong Hybrid - Level 1 SHEV1 ELEC 0% 0% 45% 50%
45 Conversion from SHEV1 to SHEV2 SHEV1_2 ELEC 0% 0% 45% 50%
46 Strong Hybrid - Level 2 SHEV2 ELEC 0% 0% 45% 50%
47 Plug-in Hybrid - 30 mi range PHEV1 ELEC 0% 0% 13% 14%
48 Plug-in Hybrid PHEV2 ELEC 0% 0% 13% 14%
49 Electric Vehicle (Early Adopter) - 75 mile rangeEV1 ELEC 0% 0% 5% 5%
50 Electric Vehicle (Early Adopter) - 100 mile rangeEV2 ELEC 0% 0% 5% 5%
51 Electric Vehicle (Early Adopter) - 150 mile rangeEV3 ELEC 0% 0% 5% 5%
52 Electric Vehicle (Broad Market) - 150 mile rangeEV4 ELEC 0% 0% 9% 10%
53 Fuel Cell Vehicle FCV ELEC 0% 0% 9% 10%
54 Mass Reduction - Level 1 MR1 MR 15% 25% 100% 100%
55 Mass Reduction - Level 2 MR2 MR 15% 25% 100% 100%
56 Mass Reduction - Level 3 MR3 MR 15% 25% 100% 100%
57 Mass Reduction - Level 4 MR4 MR 0% 0% 100% 100%
58 Mass Reduction - Level 5 MR5 MR 0% 0% 90% 100%
59 Low Rolling Resistance Tires - Level 1 ROLL1 ROLL 20% 35% 100% 100%
60 Low Rolling Resistance Tires - Level 2 ROLL2 ROLL 0% 0% 100% 100%
61 Low Rolling Resistance Tires - Level 3 ROLL3 ROLL 0% 0% 0% 0%
62 Low Drag Brakes LDB DLR 20% 35% 100% 100%
63 Secondary Axle Disconnect SAX DLR 15% 25% 100% 100%
64 Aero Drag Reduction, Level 1 AERO1 AERO 30% 40% 100% 100%
65 Aero Drag Reduction, Level 2 AERO2 AERO 0% 0% 100% 100%

…

…
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Technology Information Early Replacement Penalty Cost TablePhase-in Values
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Table 13. Technologies Assumptions (Sample) 

 
 
 
 
 
 
 
  

Index Technology Abbr.  TechType 
 

Applicable 
 Year
Avail. 

 Year
Retired 

Electric 
Range

 Delta
Weight

(% ) 

 Delta
Weight

(lbs) 
 Loss of 
Value FC FCG

FCG 
Share

Cost
2009

Cost
2010 …

Cost
2024

Cost
2025

1 Low Friction Lubricants - Level 1 LUB1 EngMod TRUE 2007 0.5% 4 4 4 4
2 Engine Friction Reduction - Level 1 EFR1 EngMod TRUE 2007 2.0% 15 15 14 14
3 Low Friction Lubricants and Engine Friction Reduction - Level 2LUB2_EFR2 EngMod TRUE 2017 1.0% 16 16 16 15
4 Variable Valve Timing (VVT) - Coupled Cam Phasing (CCP) on SOHCCCPS EngMod TRUE 2007 4.1% 55 54 39 38
5 Discrete Variable Valve Lift (DVVL) on SOHCDVVLS EngMod TRUE 2007 2.8% 48 47 33 33
6 Cylinder Deactivation on SOHC DEACS EngMod TRUE 2007 0.4% 38 37 27 26
7 Variable Valve Timing (VVT) - Intake Cam Phasing (ICP)ICP EngMod TRUE 2007 2.2% 55 54 39 38
8 Variable Valve Timing (VVT) - Dual Cam Phasing (DCP)DCP EngMod TRUE 2007 2.0% 52 51 36 36
9 Discrete Variable Valve Lift (DVVL) on DOHCDVVLD EngMod TRUE 2007 2.8% 48 47 33 33
10 Continuously Variable Valve Lift (CVVL) CVVL EngMod TRUE 2007 3.6% 77 75 54 53
11 Cylinder Deactivation on DOHC DEACD EngMod TRUE 2007 0.4% 38 37 27 26
12 Stoichiometric Gasoline Direct Injection (GDI)SGDI EngMod TRUE 2007 1.6% 79 77 55 54
13 Cylinder Deactivation on OHV DEACO EngMod TRUE 2007 4.7% 244 238 170 167
14 Variable Valve Actuation - CCP and DVVL on OHVVVA EngMod TRUE 2007 2.7% 61 60 42 42
15 Stoichiometric Gasoline Direct Injection (GDI) on OHVSGDIO EngMod TRUE 2007 1.6% 79 77 55 54
16 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Small DisplacementTRBDS1_SD EngMod TRUE 2007 7.2% 572 560 399 394
17 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Medium DisplacementTRBDS1_MD EngMod TRUE 2007 6.7% (15) (10) (21) (17)
18 Turbocharging and Downsizing - Level 1 (18 bar BMEP) - Large DisplacementTRBDS1_LD EngMod TRUE 2007 6.7% 734 716 495 488
19 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Small DisplacementTRBDS2_SD EngMod TRUE 2012 2.9% 12 14 23 5
20 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Medium DisplacementTRBDS2_MD EngMod TRUE 2012 2.9% 310 303 235 212
21 Turbocharging and Downsizing - Level 2 (24 bar BMEP) - Large DisplacementTRBDS2_LD EngMod TRUE 2012 2.9% 522 510 397 358
22 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Small DisplacementCEGR1_SD EngMod TRUE 2012 3.6% 360 352 274 247
23 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Medium DisplacementCEGR1_MD EngMod TRUE 2012 3.6% 360 352 274 247
24 Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - Large DisplacementCEGR1_LD EngMod TRUE 2012 3.6% 360 352 274 247
25 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Small DisplacementCEGR2_SD EngMod TRUE 2017 1.0% 620 605 471 425
26 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Medium DisplacementCEGR2_MD EngMod TRUE 2017 1.0% 620 605 471 425
27 Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - Large DisplacementCEGR2_LD EngMod TRUE 2017 1.0% (413) (396) (269) (285)
28 Advanced Diesel - Small Displacement ADSL_SD EngMod TRUE 2017 5.5% 1115 1080 845 689
29 Advanced Diesel - Medium DisplacementADSL_MD EngMod TRUE 2017 5.5% 1041 1013 875 719
30 Advanced Diesel - Large Displacement ADSL_LD EngMod TRUE 2017 5.5% 2022 1975 1725 1488
31 6-Speed Manual/Improved Internals 6MAN TrMod TRUE 2007 2.0% 336 327 236 232
32 High Efficiency Gearbox (Manual) HETRANSM TrMod TRUE 2017 3.4% 304 296 213 200
33 Improved Auto. Trans. Controls/ExternalsIATC TrMod TRUE 2007 2.3% 74 72 52 51
34 6-Speed Trans with Improved Internals (Auto)NAUTO TrMod TRUE 2007 1.9% (53) (51) (35) (34)
35 6-speed DCT DCT TrMod TRUE 2007 4.0% (156) (149) (104) (101)
36 8-Speed Trans (Auto or DCT) 8SPD TrMod TRUE 2014 3.8% 304 297 212 208
37 High Efficiency Gearbox (Auto or DCT)HETRANS TrMod TRUE 2017 2.2% 304 296 213 200
38 Shift Optimizer SHFTOPT TrMod TRUE 2017 3.3% 2 1 1 1
39 Electric Power Steering EPS ELEC TRUE 2007 1.5% 130 127 92 90
40 Improved Accessories - Level 1 IACC1 ELEC TRUE 2007 1.2% 106 103 75 73
41 Improved Accessories - Level 2 (w/ Alternator Regen and 70% efficient alternator)IACC2 ELEC TRUE 2014 1.8% 65 63 48 45
42 12V Micro-Hybrid (Stop-Start) MHEV ELEC TRUE 2007 1.7% 469 469 253 247
43 Integrated Starter Generator ISG ELEC FALSE 2012 0.0% 0 0 0 0
44 Strong Hybrid - Level 1 SHEV1 ELEC TRUE 2012 2016 14.9% 4365 4306 2818 2622
45 Conversion from SHEV1 to SHEV2 SHEV1_2 ELEC TRUE 2017 10.0% 1425 1395 1092 983
46 Strong Hybrid - Level 2 SHEV2 ELEC TRUE 2017 10.1% 4365 4306 2818 2622
47 Plug-in Hybrid - 30 mi range PHEV1 ELEC TRUE 2020 30 40.7% 0.0% 50.0% 14645 14601 8102 6470
48 Plug-in Hybrid PHEV2 ELEC FALSE 2020 0 0.0% 0 0 0 0
49 Electric Vehicle (Early Adopter) - 75 mile rangeEV1 ELEC FALSE 2017 75 68.5% 5139 5225 2153 828
50 Electric Vehicle (Early Adopter) - 100 mile rangeEV2 ELEC FALSE 2017 100 0.0% 0 0 0 0
51 Electric Vehicle (Early Adopter) - 150 mile rangeEV3 ELEC FALSE 2017 150 0.0% 0 0 0 0
52 Electric Vehicle (Broad Market) - 150 mile rangeEV4 ELEC FALSE 2017 150 3,561$  0.0% 11401 11401 5852 4297
53 Fuel Cell Vehicle FCV ELEC FALSE 2017 0.0% 0 0 0 0
54 Mass Reduction - Level 1 MR1 MR TRUE 2007 0.0% 0.0% 0 0 0 0
55 Mass Reduction - Level 2 MR2 MR TRUE 2007 0.0% 0.0% 0 0 0 0
56 Mass Reduction - Level 3 MR3 MR TRUE 2007 0.0% 0.0% 0 0 0 0
57 Mass Reduction - Level 4 MR4 MR TRUE 2011 0.0% 0.0% 0 0 0 0
58 Mass Reduction - Level 5 MR5 MR TRUE 2016 0.0% 0.0% 0 0 0 0
59 Low Rolling Resistance Tires - Level 1 ROLL1 ROLL TRUE 2007 1.9% 7 7 6 6
60 Low Rolling Resistance Tires - Level 2 ROLL2 ROLL TRUE 2017 2.0% 72 72 46 43
61 Low Rolling Resistance Tires - Level 3 ROLL3 ROLL FALSE 0.0% 0 0 0 0
62 Low Drag Brakes LDB DLR FALSE 2007 0.8% 73 73 70 70
63 Secondary Axle Disconnect SAX DLR TRUE 2007 1.4% 116 113 82 81
64 Aero Drag Reduction, Level 1 AERO1 AERO TRUE 2007 2.3% 58 57 41 40
65 Aero Drag Reduction, Level 2 AERO2 AERO TRUE 2011 2.5% 193 189 146 132

Cost Table

…

…

…

…

…

…

…

FC ImprovementsSubcompact PC Misc AttributesAvailability
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The technologies are organized into technology types specified by TechType field in the fourth 
column.  Each technology type is populated with specific technologies following the sequence 
specified by the Index column.  The sequence of engine and transmission technologies may be 
split to follow slightly different paths, based on the original vehicle, engine, or transmission 
characteristics, or depending on which technologies have already been applied to a vehicle.  For 
example, if the original vehicle uses a manual transmission with fewer than six gears, the 
available technologies would be the 6-speed manual transmission and high efficiency gearbox 
(HETRANSM).  If the original vehicle, however, starts out with a 5-speed automatic 
transmission, the technologies applied would follow the following path: IATC, 6-speed 
automatic transmission (NAUTO), 6-speed DCT, 8-speed automatic transmission, high 
efficiency gearbox (HETRANS), and shift optimizer (SHFTOPT). 
 
A.2.1 Technology Synergies 
 
Technology synergies occur when the combined effect of two technologies is greater than (or 
less than) the fuel consumption reduction for the two technologies combined.  To support 
synergies, the technology input file has synergy sections for cost and fuel improvements. 
Samples from the synergy tables are shown in Table 14 and   
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Table 15 below. 
 
The synergy table is most commonly used for synergistic interactions in vehicle technologies 
from differing technology groups (e.g. between engine technologies and transmission 
technologies).  Synergies within a technology group are already built into the cost and fuel 
reduction values for the technologies.  Therefore, in-group synergies are not likely to occur, 
unless special circumstances arise, such as branching of technology paths. 
 

Table 14. Technology Cost Synergies (Sample) 

 
 
  

Type Technology A Technology B
Subcompact

PC
Subcompact

Perf. PC
Compact

PC
Compact
Perf. PC

Midsize
PC

Midsize
Perf. PC

Large
PC

Large
Perf. PC

Minivan
LT

Small
LT

Midsize
LT

Large
LT

Accounting DEACD CVVL (28)$             (28)$             (28)$       (28)$       (28)$      (28)$       (28)$   (28)$       (28)$      (28)$   (28)$      (28)$   
Accounting TRBDS1_SD DVVLD (10)$             (10)$             (10)$       (10)$       (10)$      (10)$       (10)$   (10)$       (10)$      (10)$   (10)$      (10)$   
Accounting TRBDS1_MD DVVLD (136)$           (136)$           (136)$     (136)$     (136)$    (136)$     (136)$ (136)$     (136)$    (136)$ (136)$    (136)$ 
Accounting TRBDS1_LD DVVLD (149)$           (149)$           (149)$     (149)$     (149)$    (149)$     (149)$ (149)$     (149)$    (149)$ (149)$    (149)$ 
Accounting TRBDS1_SD CVVL (10)$             (10)$             (10)$       (10)$       (10)$      (10)$       (10)$   (10)$       (10)$      (10)$   (10)$      (10)$   
Accounting TRBDS1_MD CVVL (136)$           (136)$           (136)$     (136)$     (136)$    (136)$     (136)$ (136)$     (136)$    (136)$ (136)$    (136)$ 
Accounting TRBDS1_LD CVVL (149)$           (149)$           (149)$     (149)$     (149)$    (149)$     (149)$ (149)$     (149)$    (149)$ (149)$    (149)$ 
Accounting TRBDS1_SD VVA (416)$           (416)$           (416)$     (416)$     (416)$    (416)$     (416)$ (416)$     (416)$    (416)$ (416)$    (416)$ 
Accounting TRBDS1_MD VVA 558$            558$            558$      558$      558$     558$      558$   558$      558$     558$   558$     558$   
Accounting TRBDS1_LD VVA 519$            519$            519$      519$      519$     519$      519$   519$      519$     519$   519$     519$   

Synergies
Synergy values by Vehicle Class

Vehicle classes must be in the same order and the same names as the preceeding worksheets.
Positive values are increase costs, negative values are decrease costs. Blank cells are assumed to be zero.
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Table 15. Technology Fuel Consumption Synergies (Sample) 

 
 
For each technology relation, the above two tables contain the following: 

• Type:  Specifies the synergy type relation between two technologies.  The “accounting” 
type indicates that the synergy relation between two technologies is to provide accounting 
adjustments for the decision trees and is the only synergy type applied to technology 
costs.  The “physical” type indicates that the synergy relation between two technologies 
is to address physical energy losses. 

• Technology A:  Specifies the abbreviation of the first technology in a synergy pair. 

• Technology B:  Specifies the abbreviation of the second technology in a synergy pair. 

• Subcompact PC – Large LT:  Contains values to offset the technology cost or fuel 
consumption when either of technology A or B is being applied when the other is already 
installed. 

 
When a technology is being applied (or is being tested for application), a lookup is performed in 
the “Technology A” and “Technology B” columns of the table.  If found, the vehicle is examined 
to determine if the paired technology (or technologies) have been applied (or are installed as part 
of the base vehicle definition).  If so, the offset value for the applicable vehicle class is obtained, 
summed, and applied to the cost or fuel consumption reduction of the technology being 
examined. 
 
  

Type Technology A Technology B
Subcompact

PC
Subcompact

Perf. PC
Compact

PC
Compact
Perf. PC

Midsize
PC

Midsize
Perf. PC

Large
PC

Large
Perf. PC

Minivan
LT

Small
LT

Midsize
LT

Large
LT

Accounting DEACD CVVL -0.40% -0.40% -0.40% -0.40% -0.70% -0.70% -0.70% -0.70% -0.20% -0.40% -0.20% -0.60%
Accounting TRBDS1_SD DVVLD 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting TRBDS1_MD DVVLD 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting TRBDS1_LD DVVLD 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting TRBDS1_SD CVVL -0.72% -0.72% -0.72% -0.72% -1.13% -1.13% -1.15% -1.15% -1.12% -0.72% -1.12% -0.98%
Accounting TRBDS1_MD CVVL -0.21% -0.21% -0.21% -0.21% -0.33% -0.33% -0.33% -0.33% -0.32% -0.21% -0.32% -0.32%
Accounting TRBDS1_LD CVVL -0.21% -0.21% -0.21% -0.21% -0.33% -0.33% -0.33% -0.33% -0.32% -0.21% -0.32% -0.32%
Accounting TRBDS1_SD VVA 4.79% 4.79% 4.79% 4.79% 6.06% 6.06% 6.62% 6.62% 6.05% 4.78% 6.05% 5.75%
Accounting TRBDS1_MD VVA 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting TRBDS1_LD VVA 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

Synergies
Fuel Consumption Improvement Synergy values by Vehicle Class

Vehicle classes must be in the same order and the same names as the preceeding worksheets.
Positive values are [positive] synergies, negative values are dissynergies. Blank cells are assumed to be zero.
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A.3 Parameters File 
 
The benefits model parameters file contains a variety of input data and assumptions used to 
estimate various impacts of the simulated response of the industry to CAFE standards.  The file 
contains a series of worksheets, the contents of which are summarized below. 
 
A.3.1 Vehicle Age Data 
 
The Vehicle Age Data worksheet contains age-specific (i.e., vintage-specific) estimates of the 
survival rate and annual accumulated mileage applicable to different vehicle categories. 
 

Table 16. Vehicle Age Data Worksheet (sources data shown as samples) 

 
 
Separate survival fractions are used for automobiles and light trucks.  These measure the 
proportion of vehicles originally produced during a model year that remain in service at each age 
(up to 25 years for automobiles and 35 years for light trucks), by which time only a small 
fraction typically remain in service. 
 
A.3.2 Forecast Data 
 
The Forecast Data worksheet contains estimates of future fuel prices, which are used when 
calculating pre-tax fuel outlays and fuel tax revenues. 
 

Table 17. Forecast Data Worksheet (sources data shown as samples) 

 
 
A.3.3 Fuel Economy Data 
 
The fuel Economy Data worksheet contains historic and projected fuel economy levels for 
passenger cars and light trucks, for each fuel type (gasoline, diesel, ethanol-85, electricity, and 
hydrogen).  The associated fuel shares are also provided. 
 

Table 18. Fuel Economy Data Worksheet (sources data show as samples) 

 
 
 
 
 

Category Model Characteristic Units Definition/Notes Source

Survival Rates proportion
Proportion of original vehicle sales that remain in 
service by vehicle age (year 1 to 26 for cars, 1 - 36 for 
trucks)

Base Miles Driven at various fuel 
prices

miles Average annual miles driven by surviving vehicles by 
vehicle age (year 1 to 26 for cars, 1 - 36 for trucks)

V
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ge

 D
at

a U.S. Environmental Protection Agency, Fleet 
Characterization Data for MOBILE6:  Development and 
Use of Age Distributions, Average Annual Mileage 
Accumulation Rates and Projected Vehicle Counts for 
Use in MOBILE6, EPA420-P-99-011, April 1999, 

Category Model Characteristic Units Definition/Notes Source

Retail Fuel Prices $/gallon 2009 $ per gallon, varies by fuel type, forecast by 
calendar year staring with MY-1975

Average Values from AEO 2011 Early Release

Fuel Taxes $/gallon
2009 $ per gallon, varies by fuel type, forecast by 
calendar year staring with MY-2000

calculated from "Federal Fuel Tax" and "Average State 
Fuel Tax" components, obtained from FHWA Highway 
Statistics, Tables FE-21B and MF-121T
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st

D
at

a

Category Model Characteristic Units Definition/Notes Source

Passenger Cars (FE) mpg historic and projected fuel economy levels for 
passenger cars

Passenger Cars (Share) percent historic and projected fuel shares for passenger cars

Light Trucks (FE) mpg historic and projected fuel economy levels for light 
trucks

Light Trucks (Share) percent historic and projected fuel shares for light trucks
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A.3.4 Economic Values 
 
The Economic Values worksheet contains an estimate of the magnitude of the “rebound effect”, 
as well as the rates used to compute the economic value of various direct and indirect impacts of 
CAFE standards, and the discount rate to apply when calculating present value.  As mentioned 
above, the user can define and edit all inputs.  For example, although Table 19 identifies 
available sources of information for economic values, the system does not require that the user 
rely on these sources. 
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Table 19. Economic Values Worksheet (sources data shown as samples) 

 
 

Category Model Characteristic Units Definition/Notes Source

Rebound Effect percent
increase in the annual use of vehicle models in 
response to lower per-mile cost of driving a more fuel-
efficient vehicle

various

Social Discount Rate percent

percent rate by which the dollar value of a benefit or 
cost is reduced when its receipt or payment is 
postponed by one additional year into the future; used 
for calculating socially-valued benefits

Office of Management and Budget, office of 
Information and Regulatory Analysis

Private Discount Rate percent sames as social discount rate, but used for calculating 
consumer-valued benefits

Kf $/mpg the CAFE fine rate

Value of Travel Time per Vehicle $/hour amount that the driver of a vehicle would be willing to 
pay to reduce the time required to make a trip

Volpe estimates

Economic Costs of Oil Imports various economic costs of various oil imports

"Monopsony" Component $/gallon

demand cost for imported oil; increasing domestic 
petroleum demand that is met through higher oil 
imports can cause the world price of oil to rise, and 
conversely that declining imports can reduce the world 
price of oil; determined by a complex set of factors, 
including the relative importance of U.S. imports in the 
world oil market and demand to its world price among 
other participants in the international oil market

Price Shock Component $/gallon

expected value of costs to U.S. economy from 
reduction in potential output resulting from risk of 
significant increases in world petroleum price; includes 
costs resulting from inefficiencies in resource use 
caused by incomplete adjustments to industry output 
levels and mixes of production input when world oil 
price changes rapidly

Military Security Component $/gallon

costs of taxpayers for maintaining a military presence 
to secure the supply of oil imports from potentially 
unstable regions of the world and protect the nation 
against their interruption

Total Economic Costs ($/gallon) $/gallon
total economic costs of oil imports (sum of 
monopsony, price shock, and military security 
components)

Total Economic Costs ($/BBL) $/BBL total economic costs of oil imports, specified in $/BBL

External Costs from Additional 
Vehicle Use Due to "Rebound" 
Effect

$/vehicle-mile

estimates intended to represent costs per vehicle-mile 
of increased travel compared to approximately current 
levels, assuming current distribution of travel by hours 
of the day and facility types

Congestion $/vehicle-mile congestion component of external costs from 
additional vehicle use

Accidents $/vehicle-mile accidents component of external costs from additional 
vehicle use

Noise $/vehicle-mile noise component of external costs from additional 
vehicle use

Emission Damage Costs various additional costs arising from emission damage
Carbon Monoxide $/ton economic costs arising from Carbon Monoxide damage McCubbin & DeLucchi

Volatile Organic Compounds $/ton economic costs arising from Volatile Organic 
Compounds damage

Nitrogen Oxides $/ton economic costs arising from Nitrous Oxides damage
Particulate Matter $/ton economic costs arising from Particulate Matter damage
Sulfur Dioxide $/ton economic costs arising from Sulfur Oxides damage

Annual Growth Rate for Average 
VMT per Vehicle

various annual growth rate for average VMT per vehicle

Base Year for Average Annual 
Usage Data (Primary)

model year primary base year for annual growth rate for average 
VMT per vehicle

Cars percent primary annual growth rate for average VMT per 
vehicle for passenger cars

Trucks percent primary annual growth rate for average VMT per 
vehicle for light trucks

Base Year for Average Annual 
Usage Data (Secondary)

model year secondary base year for annual growth rate for average 
VMT per vehicle

Cars percent secondary annual growth rate for average VMT per 
vehicle for passenger cars

Trucks percent secondary annual growth rate for average VMT per 
vehicle for light trucks

Cost of CO-2 $/metric ton
economic costs arising from Carbon Dioxide damage, 
by calendar year; estimates for low, average, high, or 
very high growth rates are provided

CO-2 Discount Rates percent discount rates to apply to low, average, high, or very 
high Carbon Dioxide estimates

"Gap" between Test and On-Road 
MPG (by Fuel Type)

percent difference between a vehicle's EPA fuel economy rating 
and its actual on-road fuel economy

EPA/OTAQ estimate

Average Refueling Time in Minutes 
(by Fuel Type) minutes

average refueling time a spent by a consumer refueling 
the vehicle tank or recharging the vehicle electric 
battery

Average Tank Volume Refueled percent average tank volume refilled during a refueling stop

Federal Highway Administration, 1997 Highway Cost 
Allocation Study, T. V-23

OMB (1998), p. 72
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Leiby et al.

calculated
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A.3.5 Fuel Properties 
 
The Fuel Properties worksheet contains estimates of the physical properties of gasoline, diesel, 
and other types of fuels, as well as certain assumptions about the effects of reduced fuel use on 
different sources of petroleum feedstocks and on imports of refined fuels.  These fuel properties 
and assumptions about the response of petroleum markets to reduced fuel use are used to 
calculate the changes in vehicular carbon dioxide emissions as well as in “upstream” emissions 
(from petroleum extraction and refining and from fuel storage and distribution) that are likely to 
result from reduced motor fuel use. 
 

Table 20. Fuel Properties Worksheet (sources data shown as samples) 

 
 
A.3.6 Upstream Emissions 
 
The Upstream Emissions worksheet contains emission factors for greenhouse gas and criteria 
pollutant emissions from petroleum extraction and transportation, and from fuel refining, storage, 
and distribution. 
 

Table 21. Upstream Emissions Worksheet (sources data shown as samples) 

 
 
 
 
 
 
 
 

Category Model Characteristic Units Definition/Notes Source

Share of Total Assumed Fuel Mix percent estimated share of total fuel consumption by fuel type

USEPA, Regulatory Impact Analysis for Tier 2 
Emissions Standard, Table 19, p. 42; and estimate 
supplied by Ford Motor Company in comments on 
proposed 2005-07 Light Truck CAFE Rule

Energy Density BTU/unit amount of energy stored in a given system or region of 
space per unit volume, specified by fuel type

Mass Density grams/unit mass per unit volume, specified by fuel type

Carbon Content percent by 
weight

average share of carbon in fuel, specified by fuel type

SO-2 Emissions grams/unit Sulfur Oxides emissions rate of gasoline and diesel 
fuels

Share of Fuel Savings Leading to
Lower Fuel Imports

percent assumed value for share of fuel savings leading to 
lower fuel imports

Share of Fuel Savings Leading to
Reduced Domestic Fuel Refining

percent assumed value for share of fuel savings leading to 
reduced domestic fuel refining

Share of Reduced Domestic
Refining from Domestic Crude

percent assumed value for share of reduced domestic refining 
from domestic crude

Share of Reduced Domestic
Refining from Imported Crude

percent assumed value for share of reduced domestic refining 
from imported crude
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Wang, Michael, The Greenhouse Gases, Regulated 
Emissions, and Energy Use in Transportation (GREET) 
Model: Version 1.5 Technical Report, Argonne 
National Laboratory, August 1999, Table 3.3, p. 25 
(http://greet.anl.gov/pdfs/esd_3v1.pdf)

Energy Information Administration, Annual Energy 
Outlook 2003, Tables 1, 2, and 117; and Volpe 
assumptions

Category Model Characteristic Units Definition/Notes Source

Petroleum Extraction grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum extraction, specified by 
pollutant and fuel type

Petroleum Transportation grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum transportation, specified by 
pollutant and fuel type

Petroleum Refining grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum refining, specified by 
pollutant and fuel type

Fuel TS&D grams/mil BTU
total emissions by stage of fuel production and 
distribution from refined fuel transportation, storage, 
and delivery, specified by pollutant and fuel type

Subtotals grams/mil BTU subtotals from all stages of fuel prodcution and 
distribution

calculated

Argonne National Laboratory, The Greenhouse Gases, 
Regulated Emissions, and Energy Use in 
Transportation (GREET) Model, version 1.6, June 2001, 
Near-Term Output: Petroleum Fuels
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A.3.7 Monte-Carlo 
 
The Monte-Carlo worksheet contains parameters for setting up pseudo-random trials for 
uncertainty analysis. 
 

Table 22.  Monte-Carlo Worksheet 

 
 
A.3.8 Safety Values 
 
The Safety Values worksheet contains parameters for estimating additional fatalities resulting 
from decreases in vehicle weight. 
 

Table 23. Safety Values Worksheet 

 
 
  

Discount Rates (%) percent comma-separated list of discount rates to use during 
Monte-Carlo modeling

Fuel Path Randomization Parameters percent randomization parameters for the low, reference, or high 
fuel path

Rebound Effect Randomization 
Parameters

parameters for generating randomized rebound effect 
values

Carbon Dioxide Randomization 
Parameters

percent randomization parameters for the low, average, high or 
very high Carbon Dioxide path

Monopsony Randomization 
Parameters

dollars parameters for generating randomized monopsony cost 
values

Price Shock Randomization 
Parameters

dollars parameters for generating randomized price shock cost 
values

Military Security Randomization 
Parameters

dollars, percent parameters for generating randomized military security 
cost values

M
on
te
-C
ar
lo

Category Model Characteristic Units Definition/Notes Source
PC Threshold lbs
LT/SUV Threshold lbs
CUV/Minivan Threshold lbs
Change per 100 lbs percent change per 100 lbs below the weight threshold

Base per billion miles base fatalities per billion miles below the weight 
threshold

Adjustment for new FMVSS adjustment for new FMVSS below the weight threshold

Monetized Fatalities
Cost Value dollar social costs arising from vehicle fatalities

Discount Rate percent discount rate to apply to costs arising from vehicle 
fatalities

the boundary between small and large weigth effects 
by  safety class
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A.4 Emissions Rates File 
 
The emissions rates file contains vehicular criteria pollutant emission factors specified by vehicle 
age, fuel type (Gasoline, Reformulated Gasoline, Diesel, and Ethanol-85), and Mobile6 class 
(LDV, LDT12, LDT34, and HDV).  Covered pollutants include carbon monoxide (CO), volatile 
organic compounds (VOC), nitrogen oxides (NOX), and fine particulate matter (PM2.5, or 
particulate matter less than 2.5 microns in diameter).  Particulate matter includes sulfate 
particulates, elemental carbon, non-volatile organic carbon compounds, and airborne lead, as 
well as particulate emissions from brake and tire wear.  Because we are concerned with increased 
emissions from more intensive use of existing vehicles (rather than from a larger vehicle fleet), 
the emission factors we estimated included only the components associated with vehicle use, and 
omitted those associated with vehicle storage.  Emission components associated with increased 
vehicle use include exhaust emissions during vehicle start-up and operation, evaporative 
emissions during vehicle operation, cool-down (“hot soak”), and refueling, and particulate 
emissions from brake and tire wear. 
 

Table 24. Emissions Rates Worksheet 

  
 
  

Category Model Characteristic Units Definition/Notes Source
Vehicle Age age

LDV grams/mile
vehicle operation emission rate for MOBILE6 LDV 
class for conventional gasoline, reformulated 
gasoline, diesel, or ethanol-85 fuel types.

LDT12 grams/mile

vehicle operation emission rate for MOBILE6 LDT1 
and LDT2 classes for conventional gasoline, 
reformulated gasoline, diesel, or ethanol-85 fuel 
types.

LDT34 grams/mile

vehicle operation emission rate for MOBILE6 LDT3 
and LDT4 classes for conventional gasoline, 
reformulated gasoline, diesel, or ethanol-85 fuel 
types.

HDV grams/mile

vehicle operation emission rate for MOBILE6 
HDV2b class for conventional gasoline, 
reformulated gasoline, diesel, or ethanol-85 fuel 
types.
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U.S. Environmental Protection Agency, MOBILE 
Motor Vehicle Emission Factor Model, version 
6.1/6.2, October 2004.
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A.5 Scenarios File 
 
The scenarios file provides one or more worksheets that begin with “SCEN_” and are identified 
as CAFE program scenarios, which are defined in terms of the design and stringency of the 
CAFE program.  The system numbers these scenarios as 0, 1, 2 …, based on their order of 
appearance.  The first worksheet is assigned to Scenario 0, and is identified as the baseline 
scenario to which all others are compared.  Each scenario defines the CAFE program as it relates 
to the following “regulatory classes”: 
 

Table 25. Regulatory Classes 
Reg. Class Includes 
0 Unregulated vehicles 
1 Passenger automobiles (domestic) 
2 Passenger automobiles (imported) 
3 Nonpassenger automobiles 

 
The “Regulatory Class” column on the vehicles worksheet discussed above is used to indicate 
whether the vehicle is regulated as a passenger or nonpassenger automobile.  The vehicle origin 
is further used to differentiate between regulatory classes 1 and 2 (domestic or imported).  
Vehicles from one regulatory class may also be reassigned into another via the Regulatory 
Declassification section of the scenario as shown in Table 26. 
 

Table 26. Regulatory Declassification Codes 
Code Description 
<blank> Specifies that regulatory merging does not apply. 
RC1 Specifies that all passenger automobiles (domestic and imported) 

should be merged into regulatory class 1. 
RC3 Specifies that all vehicles should be merged into regulatory class 3. 

 
Table 27 shows an example of a CAFE scenario definition worksheet. 
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Table 27. Scenario Definition Worksheet (Sample) 

 
 
  

2008 2009 2010 2011 2012 … 2024 2025 2026
RC1 RC1 RC1 RC1 … RC1 RC1

2008 2009 2010 2011 2012 … 2024 2025 2026
1 1 1 1 … 1 1

2008 2009 2010 2011 2012 … 2024 2025 2026
Fnc Type 1 1 2 6 … 206 206

Coefficients
A 27.50 27.50 31.20 36.18     … 58.32     61.07     
B 24.00 28.09     … 43.58     45.61     
C 51.41 0.00053 … 0.00039 0.00037 
D 1.91   0.00588 … 0.00129 0.00121 
E … 42.06     42.06     
F … 31.51     31.51     
G … 0.00053 0.00053 
H … 0.00201 0.00201 

Alt. Minimum
mpg 27.5 27.5 … 27.5 27.5

% average 92% 92% … 92% 92%

2008 2009 2010 2011 2012 … 2024 2025 2026
Fnc Type 1 1 2 6 … 206 206

Coefficients
A 23.10 23.50 27.10 29.96     … 48.09     50.39     
B 21.10 22.35     … 28.83     30.19     
C 56.41 0.00045 … 0.00042 0.00040 
D 4.28   0.01474 … 0.00353 0.00334 
E … 35.41     35.41     
F … 25.25     25.25     
G … 0.00045 0.00045 
H … 0.00960 0.00960 

Alt. Minimum
mpg

% average

2008 2009 2010 2011 2012 … 2024 2025 2026
Include AC N N N Y … Y Y

Passenger Auto
CO2 Adj (g/mi) (1.6)       … (5.0)       (5.0)       
Cost ($) 21         … 51         50         

Nonpassenger Auto
CO2 Adj (g/mi) (1.4)       … (7.2)       (7.2)       
Cost ($) 15         … 51         50         

Adjustment for
Improvements in
Air Conditioning

CAFE Scenario Definition

Applicability of Multi-Fuel Vehicles

Model Year

Scenario Description Preferred Alternative

Regulatory Declassification

Passenger
Automobile Standards

Nonpassenger
Automobile Standards
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Each section in Table 27 contains the following: 

• Scenario Description:  A short name describing the key features of the scenario. 

• Regulatory Declassification:  Specifies whether vehicles from one regulatory class should 
be merged with vehicles from another regulatory class. 

• Passenger Automobile Standards:  The CAFE functional or flat standards to use during 
modeling of the scenario.  The “Fnc Type” subsection determines the functional form the 
system will use for the specific scenario.  Presently, the supported functional forms are:  
1, for flat standards; 2 for a logistic area-based functional form; 6, for a linear area-based 
functional form, and 206, for a dual-linear area-based functional form.  The 
“Coefficients” subsection contains corresponding coefficient values.  The “Alt. 
Minimum” sub-section applies to non-flat standard scenarios and represents the 
alternative minimum CAFE standards to apply to manufacturers whose required 
functional CAFE standard is below a specific minimum (mpg), or less than the specific 
percentage of the industry average (% average).  In the example scenario in Table 27, 
function type “206” is used for model year 2024, indicating that passenger automobiles 
should use a dual-linear area-based functional form, with the coefficients specified in 
fields A through H. 

• Nonpassenger Automobile Standards:  Same as the Passenger Automobile Standards 
section above, but applies to nonpassenger automobiles. 

• Adjustments for Improvements in Air Conditioning:  Provides functionality for including 
AC adjustments during compliance and effects calculations on a scenario basis.  The 
“Include AC” subsection determines during which model years the AC adjustments 
should be used for compliance.  The “CO2 Adj (g/mi)” and “Cost ($)” values, under the 
“Passenger Auto” and “Nonpassenger Auto” subsections, specify the AC adjustment 
factor and the cost of the AC adjustment respectively. 
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A.6 EIS Parameters File 
 
The EIS parameters file contains additional modeling parameters required to perform 
supplemental analysis necessary for the Environmental Impact Statement (EIS).  The file 
contains a series of worksheets, the contents of which are summarized below. 
 
A.6.1 Fleet Data and Sales Data 
 
The Fleet Data worksheet provides historic data of vehicles remaining on the road, specified by 
model year for each vehicle age, for the car and truck fleets.  The period of years covered is 
between 1975 and 2007. 
 

Table 28. Fleet Data Worksheet (Sample) 

 
 
 

1975 1976 1977 1978 1979 1980 1981 1982 … 2006 2007
1 7,459,274 9,452,325 10,267,394 10,573,362 10,277,491 8,707,110 8,127,671 7,303,353 … 7,476,857 7,765,778
2 7,395,419 9,371,408 10,110,566 10,358,469 10,119,116 8,712,739 8,141,874 7,332,088 … 7,439,284 7,726,754
3 7,206,478 9,096,899 9,823,405 10,165,079 9,950,999 8,635,812 8,045,038 7,310,447 … 7,387,435 7,672,901
4 6,911,003 8,797,199 9,649,940 10,029,281 9,887,960 8,571,932 8,043,169 7,213,789 … 7,312,291 7,594,853
5 6,608,778 8,632,878 9,552,440 9,911,813 9,781,534 8,511,328 7,882,011 7,082,456 … 7,208,591 7,487,147
… … … … … … … … … … … …
25 243,184 346,009 445,606 495,961 589,311 394,720 383,262 341,428 … 226,184 234,925
26 212,919 300,888 392,570 448,988 528,824 338,916 289,038 257,489 … 170,578 177,169
27 187,363 267,571 356,875 401,147 461,134 0 0 0 … 0 0
28 169,579 268,922 320,266 349,590 0 0 0 0 … 0 0
29 162,788 245,921 280,102 0 0 0 0 0 … 0 0
30 150,873 220,318 0 0 0 0 0 0 … 0 0
31 135,272 0 0 0 0 0 0 0 … 0 0
32 0 0 0 0 0 0 0 0 … 0 0
33 0 0 0 0 0 0 0 0 … 0 0
34 0 0 0 0 0 0 0 0 … 0 0
35 0 0 0 0 0 0 0 0 … 0 0
36 0 0 0 0 0 0 0 0 … 0 0

1975 1976 1977 1978 1979 1980 1981 1982 … 2006 2007
1 1,716,731 2,415,823 2,879,854 3,143,823 3,368,587 1,950,450 1,861,330 1,996,118 … 7,623,624 7,485,061
2 1,739,671 2,448,104 2,858,443 3,269,424 3,415,518 1,907,867 1,864,288 1,986,850 … 7,463,489 7,327,837
3 1,735,045 2,381,056 2,965,957 3,265,480 3,429,755 1,884,684 1,859,372 2,014,784 … 7,357,755 7,224,024
4 1,667,717 2,458,341 2,976,576 3,264,937 3,388,922 1,859,864 1,875,581 1,987,197 … 7,217,541 7,086,359
5 1,717,860 2,458,364 2,967,591 3,210,082 3,367,079 1,870,570 1,843,863 1,958,795 … 7,041,317 6,913,337
… … … … … … … … … … … …
25 266,538 382,567 473,109 536,874 579,713 272,646 292,428 315,962 … 1,166,146 1,144,951
26 229,689 329,210 415,832 505,596 502,617 246,500 255,923 276,519 … 1,020,570 1,002,020
27 197,691 289,805 399,388 452,733 452,792 215,595 223,836 241,850 … 892,615 876,392
28 173,875 270,615 354,133 399,354 395,270 188,206 195,400 211,126 … 779,219 765,056
29 162,660 242,343 320,112 348,306 344,744 164,148 170,423 184,138 … 679,613 667,261
30 145,220 216,331 278,970 303,540 300,436 143,051 148,520 160,472 … 592,267 581,503
31 129,439 188,345 242,881 264,273 261,570 124,545 129,306 139,712 … 515,648 506,276
32 112,706 163,997 211,483 230,110 227,756 108,445 112,591 121,652 … 448,989 440,829
33 97,897 142,448 183,694 199,873 197,829 94,196 97,796 105,667 … 389,992 382,904
34 85,203 123,978 159,876 173,957 172,178 81,982 85,115 91,965 … 339,424 333,254
35 74,048 107,746 138,944 151,181 149,635 71,248 73,972 79,925 … 294,984 289,623
36 64,239 93,473 120,538 131,155 129,813 61,810 64,173 69,337 … 255,909 251,257

Vehicle
Age

Vehicle
Age

Truck Fleet (by Model Year)

Car Fleet (by Model Year)
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The Sales Data worksheet contains projected vehicle production for sale in the U.S. between 
model years 2005 and 2060.  The Sales worksheet is used to estimate additional car and truck 
fleet values,,beyond what is available on the Fleet Data worksheet. 
 

Table 29. Sales Data Worksheet (Sample) 

 
 
A.6.2 No CAFE Data 
 
The No CAFE Data worksheet contains estimated fuel economy levels and fuel shares covering 
the years between 1975 and 2060, assuming the absence of the CAFE program.  Data is provided 
for gasoline and diesel fuel types and is separated by passenger cars and light trucks.  The values 
are flatlined after 1977, all the way to 2060.  The fuel share of additional fuel types (E85, 
electricity, and hydrogen) is assumed to be 0. 
 

Table 30. No CAFE Data Worksheet (Sample) 

 
 
 

2005 7,698,885 8,125,438 15,824,323
2006 7,809,903 7,875,145 15,685,047
2007 7,704,630 7,474,079 15,178,708
2008 6,614,097 5,830,264 12,444,360
2009 5,158,841 4,659,383 9,818,224
2010 5,467,937 5,328,596 10,796,533
2011 6,417,840 6,185,476 12,603,316
2012 7,490,112 7,204,277 14,694,389
2013 8,329,210 7,752,341 16,081,551
2014 8,347,886 7,525,188 15,873,074
2015 8,602,032 7,556,467 16,158,499
2016 8,680,343 7,514,833 16,195,176
2017 8,688,595 7,117,727 15,806,322
2018 8,620,452 6,955,959 15,576,410
2019 8,711,840 6,866,818 15,578,658
2020 8,993,485 6,902,454 15,895,939
… … … …
2059 13,862,229 9,591,650 23,453,879
2060 13,985,445 9,676,907 23,662,353
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1975 15.8 15.8 - - - 99.69% 0.31% - - - 13.7 13.7 - - - 99.69% 0.31% - - -
1976 17.5 17.5 - - - 98.89% 1.11% - - - 14.4 14.4 - - - 99.69% 0.31% - - -
1977 18.3 18.3 - - - 98.09% 1.91% - - - 15.6 15.6 - - - 99.69% 0.31% - - -
1978 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
1979 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
1980 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
1981 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
1982 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
…
2059 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -
2060 18.3 18.3 - - - 98.09% 1.91% - - - 15.2 15.2 - - - 99.69% 0.31% - - -

…………

Model
Year

Passenger Cars Light Trucks
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A.6.3 Overcompliance Data 
 
The Overcompliance Data worksheet contains additional parameters used when considering the 
effect of voluntary overcompliance.  The worksheets contains growth rates by fleet type 
(passenger cars and light trucks) and fuel type (gasoline, diesel, e85, electricity, and hydrogen), 
to estimate additional fuel economy growth beyond the last model year covered during the main 
compliance modeling.  For this analysis, the last year examined was 2025, and the growth rates 
are specified for model years between 2026 and 2060.  Different growth rates are provided for 
the baseline alternative and the action alternatives. 
 

Table 31. Overcompliance Data Worksheet (Sample) 
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1975
1976
…
2024
2025
2026 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2027 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2028 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2029 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2030 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2031 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2032 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2033 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2034 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2035 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
…
2059 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%
2060 0.90% 0.90% 0.90% 0.90% 0.90% 1.10% 1.10% 1.10% 1.10% 1.10% 0.80% 0.80% 0.80% 0.80% 0.80% 0.35% 0.35% 0.35% 0.35% 0.35%

… … … …

… … … …

Action Alternatives Growth Rates for Voluntary Overcompliance
Passenger Cars Light Trucks

Model
Year

Baseline Growth Rates for Voluntary Overcompliance
Passenger Cars Light Trucks
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A.7 EIS Tailpipe Emissions 
 
The EIS tailpipe emissions file contains pollutant emission factors necessary for EIS analysis.  
Emission factors are specified in grams per mile by vehicle age, fuel type (Gasoline, Diesel, and 
Ethanol-85), and fleet type (LDV and LDT).  Different pollutant values are provided for model 
years covering the period between 1975 and 2011.  After 2011, these values are assumed to hold 
steady.  The included pollutants are:  acetaldehyde, acrolein, benzene, butadiene, CH4, CO, 
diesel PM10, formaldehyde, MTBE, N2O, NOx, PM, and VOC. 
 

Table 32. EIS Tailpipe Emissions Worksheet (Sample for Gasoline - LDV only) 

 
 
  

1975 1976 1977 1978 1979 1980 1981 1982 … 2010 2011
1 30.68 30.68 30.68 30.48 30.22 15.49 17.30 17.45 1.15 1.74
2 34.85 34.85 34.85 34.62 34.33 21.49 22.53 22.25 1.47 1.75
3 42.14 42.14 42.14 41.91 41.56 28.10 25.40 25.38 1.84 1.77
4 48.75 48.75 48.75 48.48 48.30 26.46 29.82 29.94 2.24 1.78
5 55.51 55.51 55.51 54.98 44.75 26.92 33.50 33.60 2.63 3.00
6 61.64 61.64 61.64 50.58 44.57 28.07 37.12 37.25 2.99 3.03
7 56.27 56.27 56.27 49.70 46.10 30.34 40.40 40.61 3.34 3.61
8 54.77 54.77 54.77 50.81 48.16 33.22 43.61 34.98 3.67 3.64
9 55.39 55.39 55.39 52.68 50.49 36.17 37.21 37.33 3.98 3.94
10 57.16 57.16 57.16 55.02 52.97 32.90 39.38 39.50 4.28 3.98
11 59.31 59.31 59.31 57.40 53.07 35.34 41.32 41.44 4.56 4.90
12 61.66 61.66 61.66 57.23 55.47 37.72 42.30 32.22 4.84 4.95
13 60.98 60.98 60.98 59.21 57.49 39.66 32.46 32.67 5.11 5.01
14 62.85 62.85 62.85 61.19 59.38 32.00 32.78 32.86 5.36 5.07
15 64.94 64.94 64.94 63.15 58.82 33.56 32.91 32.94 5.61 5.14
16 67.00 67.00 67.00 62.42 60.80 34.87 33.33 33.63 5.86 5.74
17 66.15 66.15 66.15 64.32 62.21 36.23 34.03 34.34 6.10 5.82
18 67.98 67.98 67.98 65.81 63.53 37.86 34.75 35.06 6.34 5.91
19 69.50 69.50 69.50 67.03 65.36 39.54 35.47 35.72 6.57 5.99
20 70.96 70.96 70.96 69.16 67.36 41.28 36.19 36.50 6.80 6.09
21 73.92 73.92 73.92 72.05 70.20 44.05 36.99 37.27 7.03 6.91
22 76.97 76.97 76.97 75.04 73.66 46.49 37.80 38.08 7.26 7.02
23 80.12 80.12 80.12 78.68 76.74 49.30 38.64 38.51 7.49 7.13
24 83.97 83.97 83.97 81.92 80.22 52.28 39.21 39.26 7.72 7.24
25 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.34
26 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.44
27 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.53
28 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.61
29 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.67
30 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
31 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
32 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
33 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
34 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
35 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70
36 78.90 78.90 78.90 77.79 76.98 51.21 42.97 42.36 7.96 7.70

…

Vehicle
Age

Gasoline - LDV (by Model Year)
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Appendix B Model Outputs 
 
The system produces eight types of formatted output files, all as Microsoft Excel workbooks.  
The system places all files in the “reports” folder, located in the user selected output path (ex: 
C:\cafe\demo-run\demo\reports).  Table 33 lists the available output types and their contents.  
As discussed earlier, the first scenario appearing in the scenarios file is assigned to Scenario 0 
and is treated as the baseline.  Wherever applicable, output files for all other scenarios report 
absolute and relative changes compared to this baseline.29 
 

Table 33. Output Files 
Output File Contents 

Technology Utilization Summary 
(one per scenario) 

Contains industry-wide technology application and penetration rates for 
each model year and technology analyzed.  The results are disaggregated by 
regulatory class, as well as combined over the entire fleet. 

Industry Compliance Summary 
(one per scenario) 

Contains industry-wide summary of compliance model results, where each 
worksheet tab represents a single model year analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

Industry Effects Summary 
(one per scenario) 

Contains industry-wide summary of energy and emissions effects, where 
each worksheet tab represents a single model year analyzed. 

Industry Effects Details 
(one per scenario) 

Contains a more detailed view of industry-wide energy and emissions 
effects, where the results are disaggregated by regulatory class.  Each 
worksheet tab represents a single model year analyzed. 

Industry Societal Costs Details 
(one per scenario and societal cost) 

Contains details of undiscounted and discounted industry-wide societal 
costs for each calendar and model year.  The results are presented by 
regulatory class, as well as combined over the entire fleet.  The system 
produces multiple individual output files for each socially valued owner and 
societal costs attribute. 

Manufacturer Compliance Summary 
(one per scenario and manufacturer) 

Contains manufacturer-level summary of compliance model results, where 
each worksheet tab represents a single model year analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire 
manufacturer’s fleet.  The system produces multiple individual output files 
for each manufacturer. 

Vehicle Details Report 
(one per scenario) Contains disaggregate vehicle-level summary of compliance model results. 

Optimized Industry Report 
(one per optimization run) 

Provides industry-wide and manufacturer-specific technology costs, fines, 
and benefits, as well as carbon dioxide and fuel savings, and benefit-cost 
ratios, for all iterations from industry optimization.  This report also graphs 
the socially optimized functional form (aka, optimized shape) for the entire 
industry by model year, and displays benefit-cost, marginal benefit:cost, net 
benefits, and optimized shape charts. 

 
The remainder of this section shows sample output files for a scenario based on reformed 
passenger automobile standards and reformed nonpassenger automobile standards.  This scenario 
addresses model years spawning 17 years (2009-2025), however, only model year 2017 is 
displayed in most screenshots.  The scenario assumes regulatory merging of all passenger 
automobiles into RC1 (domestic passenger autos), while nonpassenger automobiles are regulated 

                                                
29 For example, if the baseline scenario involves a flat 27.5 mpg standard for passenger automobiles and Scenario 2 
examines a reformed standard with a higher average required value of CAFE standard, 
Industry_Compliance_Summary_Sn2.xls might report total technology costs of $2.2b, of which about $2.0b might 
be attributable to the increase in the overall standard. 
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independently.  Also, because the output files produced by the system are extensive, the text 
shows only portions of some files.  Furthermore, although the system produces output specific to 
each represented vehicle model, only the more summarized output files are shown here. 
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B.1 Technology Utilization Summary 
 

Table 34. Technology Utilization Summary (Sample) 

 
 
  

 

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025
1. LUB1 48%   49%   52%   61%   60%   59%   63%   77%   81%   86%   86%   85%   85%   85%   85%   85%   85%   
2. EFR1 8%     14%   23%   40%   52%   59%   66%   79%   84%   87%   89%   89%   89%   89%   89%   89%   90%   
3. LUB2_EFR2 - %     - %     - %     - %     - %     - %     - %     - %     11%   20%   32%   42%   55%   62%   70%   76%   77%   
4. CCPS 5%     5%     6%     7%     6%     6%     6%     7%     8%     8%     10%   10%   11%   11%   11%   11%   11%   
5. DVVLS 8%     10%   10%   11%   12%   12%   11%   12%   13%   13%   13%   13%   13%   13%   13%   13%   12%   
6. DEACS 2%     2%     3%     4%     4%     4%     4%     4%     4%     3%     3%     3%     1%     0%     0%     0%     0%     
7. ICP 35%   33%   30%   25%   24%   22%   23%   15%   12%   9%     6%     5%     3%     2%     2%     2%     2%     
8. DCP 24%   26%   30%   39%   42%   45%   47%   55%   60%   63%   65%   64%   67%   67%   67%   67%   65%   
9. DVVLD 6%     7%     10%   14%   22%   29%   32%   36%   40%   44%   50%   51%   57%   61%   62%   63%   62%   
10. CVVL 2%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     
11. DEACD 0%     0%     1%     2%     1%     1%     2%     1%     1%     1%     1%     1%     0%     0%     0%     0%     0%     
12. SGDI 7%     9%     12%   16%   22%   26%   28%   31%   34%   38%   46%   48%   59%   66%   69%   76%   76%   
13. DEACO 5%     5%     5%     7%     7%     7%     9%     10%   8%     8%     7%     5%     4%     4%     3%     3%     2%     
14. VVA 4%     5%     5%     5%     8%     9%     11%   11%   9%     9%     11%   10%   10%   9%     9%     9%     9%     
15. SGDIO 0%     0%     0%     0%     1%     1%     2%     2%     2%     2%     3%     5%     6%     6%     6%     6%     6%     
16. TRBDS1_SD 1%     1%     1%     1%     3%     3%     4%     5%     6%     7%     8%     8%     10%   8%     6%     5%     3%     
17. TRBDS1_MD 2%     4%     7%     10%   16%   20%   22%   23%   24%   24%   28%   27%   29%   28%   23%   15%   11%   
18. TRBDS1_LD 1%     1%     1%     1%     1%     1%     2%     2%     1%     1%     1%     1%     2%     2%     2%     2%     2%     
19. TRBDS2_SD - %     - %     - %     - %     - %     0%     0%     0%     1%     1%     3%     3%     3%     5%     5%     4%     4%     
20. TRBDS2_MD - %     - %     - %     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     1%     0%     
21. TRBDS2_LD - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
22. CEGR1_SD - %     - %     - %     - %     0%     1%     1%     1%     1%     2%     2%     4%     6%     11%   13%   19%   23%   
23. CEGR1_MD - %     - %     - %     0%     0%     0%     0%     2%     2%     4%     5%     8%     8%     10%   12%   19%   21%   
24. CEGR1_LD - %     - %     - %     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     - %     0%     
25. CEGR2_SD - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     1%     1%     1%     2%     3%     2%     
26. CEGR2_MD - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     0%     2%     3%     4%     5%     5%     
27. CEGR2_LD - %     - %     - %     - %     - %     - %     - %     - %     0%     1%     1%     2%     3%     4%     5%     5%     5%     
28. ADSL_SD - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     1%     1%     2%     2%     2%     3%     3%     
29. ADSL_MD - %     - %     - %     - %     - %     - %     - %     - %     - %     1%     1%     2%     3%     3%     3%     3%     5%     
30. ADSL_LD - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     0%     0%     
31. 6MAN 2%     2%     2%     2%     2%     2%     3%     3%     3%     2%     2%     1%     0%     0%     0%     - %     - %     
32. HETRANSM - %     - %     - %     - %     - %     - %     - %     - %     1%     1%     2%     3%     4%     4%     5%     6%     6%     
33. IATC 30%   34%   37%   35%   27%   19%   14%   11%   8%     3%     3%     0%     0%     0%     0%     0%     - %     
34. NAUTO 29%   32%   34%   32%   38%   29%   25%   21%   18%   12%   7%     3%     0%     0%     0%     0%     - %     
35. DCT 3%     7%     12%   27%   37%   41%   41%   37%   33%   22%   14%   8%     3%     1%     0%     0%     - %     
36. 8SPD 0%     0%     0%     0%     0%     12%   22%   32%   31%   31%   25%   20%   13%   12%   11%   10%   6%     
37. HETRANS - %     - %     - %     - %     - %     - %     - %     - %     8%     24%   39%   53%   60%   63%   63%   61%   62%   
38. SHFTOPT - %     - %     - %     - %     - %     - %     - %     - %     19%   36%   51%   63%   82%   89%   87%   85%   82%   
39. EPS 26%   26%   29%   33%   36%   40%   45%   53%   54%   57%   63%   70%   80%   85%   89%   91%   91%   
40. IACC1 31%   32%   34%   37%   38%   40%   45%   49%   53%   56%   58%   65%   79%   83%   86%   89%   91%   
41. IACC2 - %     - %     - %     - %     - %     5%     12%   17%   25%   32%   43%   54%   65%   71%   79%   84%   86%   
42. MHEV 1%     2%     2%     3%     2%     3%     3%     3%     5%     7%     12%   20%   26%   29%   33%   35%   33%   
43. ISG 0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     
44. SHEV1 3%     2%     2%     2%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     3%     2%     2%     
45. SHEV1_2 - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     0%     0%     0%     0%     0%     0%     0%     
46. SHEV2 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     0%     0%     0%     3%     4%     6%     
47. PHEV1 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     0%     0%     1%     2%     3%     
48. PHEV2 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
49. EV1 0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     
50. EV2 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
51. EV3 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
52. EV4 0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     0%     
53. FCV - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
54. MR1 4%     8%     15%   26%   34%   43%   49%   65%   69%   73%   75%   76%   76%   76%   76%   76%   75%   
55. MR2 2%     2%     4%     7%     8%     10%   18%   25%   29%   41%   57%   62%   65%   66%   67%   67%   67%   
56. MR3 1%     1%     1%     2%     2%     3%     8%     13%   13%   16%   18%   23%   26%   30%   34%   40%   45%   
57. MR4 - %     - %     - %     - %     - %     0%     1%     2%     2%     3%     3%     5%     8%     9%     11%   14%   20%   
58. MR5 - %     - %     - %     - %     - %     - %     - %     - %     0%     1%     1%     2%     3%     3%     5%     8%     14%   
59. ROLL1 37%   42%   58%   70%   78%   81%   89%   95%   96%   98%   99%   100% 100% 100% 100% 100% 100% 
60. ROLL2 0%     0%     0%     0%     0%     0%     0%     0%     18%   36%   52%   64%   76%   87%   89%   92%   92%   
61. ROLL3 - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     - %     
62. LDB 53%   51%   53%   57%   58%   60%   63%   71%   71%   72%   73%   76%   78%   81%   83%   84%   86%   
63. SAX 0%     1%     1%     1%     4%     3%     4%     5%     5%     7%     7%     7%     8%     8%     9%     10%   12%   
64. AERO1 21%   29%   47%   59%   68%   77%   87%   94%   95%   98%   100% 100% 100% 100% 100% 100% 100% 
65. AERO2 - %     - %     4%     10%   22%   29%   38%   46%   50%   58%   73%   80%   88%   92%   92%   92%   92%   

Technolog Utilization Summary for the Industry (Scenario 2 -- Preferred Alternative)

Technology Penetration Rates for All Vehicles
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B.2 Industry Compliance Summary 
 

Table 35. Industry Compliance Summary (Sample) 

 
 
  

                                

Domestic Auto Imported Auto Light Trucks Unregulated Total
9,987,667 - 5,818,655 - 15,806,322

39.97 - 29.41 - 35.30
39.97 - 29.41 - 35.30
38.70 - 29.04 - 34.48
39.56 - 29.53 - 35.16
3,197 - 4,292 - 3,600

45 - 54 - 48

- - - - - 
1.43 - 0.10 - 0.77
1.43 - 0.10 - 0.77
1.46 - 0.25 - 0.87
1.56 - 0.27 - 0.93
-12 - -11 - -12

- - - - - 

Domestic Auto Imported Auto Light Trucks Unregulated Total
768.53$            - $                    826.29$            - $                    789.79$            
44.86$              - $                    8.47$                - $                    31.47$              

811.81$            - $                    837.47$            - $                    821.26$            
- $                    - $                    - $                    - $                    - $                    

7,675.84$          - $                    4,807.87$          - $                    12,483.72$        
448.07$            - $                    49.30$              - $                    497.38$            

8,108.12$          - $                    4,872.98$          - $                    12,981.10$        
- $                    - $                    - $                    - $                    - $                    

228.25$            - $                    44.23$              - $                    160.51$            
12.56$              - $                    0.33$               - $                    8.06$               

240.36$            - $                    45.33$              - $                    168.57$            
- $                    - $                    - $                    - $                    - $                    

2,279.67$         - $                    257.36$            - $                    2,537.03$         
125.47$            - $                    1.90$               - $                    127.37$            

2,400.66$         - $                    263.75$            - $                    2,664.41$         
- $                    - $                    - $                    - $                    - $                    

Domestic Auto Imported Auto Light Trucks Unregulated Total
33 - 10 - 43
- - - - - 
- - - - - 

18 - 11 - 30
- - - - - 
- - - - - 

Average Fuel Economy (with AC; mpg)*

Average Fuel Economy (with AC)

Credits Transferred or Traded In

Total Credits Earned (millions of vehicle-mpg)
Credits Transferred or Traded Out (m. veh-mpg)
Credits Transferred or Traded In (m. veh-mpg)
Changes vs. Baseline

Total Credits Earned
Credits Transferred or Traded Out

Changes vs. Baseline

Average Fines Incurred
Average Technology Costs

Total Increase in Sales Revenue
Total Fines Owed
Total Incurred Technology Costs
Average Loss of Value to Consumer
Average Price Increase Per Vehicle

Credit Transfers/Trading by Regulatory Class

Compliance Summary for the Industry (Scenario 2, Model Year 2017)

Revenue by Regulatory Class

Fuel Economy Standards by Regulatory Class

Value of Final CAFE Standard

Value of Final CAFE Standard (mpg)

Average Curb Weight

Average Fuel Economy

Total Loss of Value to Consumer

Value of Preliminary CAFE Standard (mpg)
Prodcution for Sale

Average Technology Costs (RPE)

Average Curb Weight (lb.)

Average Fuel Economy (mpg)

Average Area

Value of Preliminary CAFE Standard
Prodcution for Sale

Changes vs. Baseline
Average Area (sq. ft.)

Total Loss of Value to Consumer ($m)

Average Price Increase Per Vehicle (RPE)
Average Fines Incurred (RPE)

Total Increase in Sales Revenue ($m)
Total Fines Owed ($m)

Average Loss of Value to Consumer ($)
Total Incurred Technology Costs ($m)
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B.3 Industry Effects Summary 
 
The summary of effects for each scenario is organized into sections.  The first section presents 
calculated levels of energy consumed by fuel type (in MMBTU, thousands of gallons, megawatt 
hours, and thousands cubic feet) during the full useful life of all vehicles sold in each model 
year.  For gasoline, diesel, and ethanol-85 fuel types, fuel consumption is specified in gallons of 
appropriate fuel.  For electricity and hydrogen, fuel consumption is specified in gasoline 
equivalent gallons.  Full useful life travel and average fuel economy levels are also presented to 
provide a basis for comparison. 
 
The second section presents estimates of full fuel cycle carbon dioxide and criteria pollutant 
emissions by fuel type.  As shown in Table 36 below, carbon dioxide emissions are reported in 
thousand metric tons of carbon-equivalent emissions (one metric ton of carbon dioxide is 
equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are reported in short tons 
(one ton equals 2,000 pounds). 
 
The third section presents additional fatalities by safety class.  Changes in fatalities, lifetime 
VMT, and average vehicle curb weight are shown for each safety class. 
 
The third section of the effects summary presents monetized consumer and social costs and 
benefits of each scenario.  These effects include the following: 

• Pretax Fuel Expenditures:  Savings in pretax cost to vehicle users of vehicle fuel. 

• Fuel Tax Revenues:  Reduction in total (federal and state) fuel tax revenues. 

• Travel Value:  The value derived from additional driving due to the “rebound effect”. 

• Refueling Time Value:  Savings in the value of vehicle occupants’ time during refueling. 

• Loss of Value:  Loss of value to consumer resulting from the reduction in travel range of 
electric vehicles. 

• Petroleum Market Externalities:  Reduction in costs of economic externalities resulting 
from crude petroleum imports. 

• Congestion Costs:  The additional cost of highway congestion from added driving due to 
the “rebound effect”. 

• Accident Costs:  Additional injury and damage costs of highway crashes. 

• Noise Costs:  The additional cost of highway noise from added driving due to the 
“rebound effect”. 

• Fatality Costs:  Additional costs resulting from fatal crashes, due to decreases in vehicle 
weight. 

• Emissions Damage Costs:  The change in damage costs from air pollutant emissions (by 
species). 

 
In all cases, these costs and benefits are calculated for the fleet of vehicles sold in each model 
year over their full useful lives, discounted using the rate specified in the benefits model 
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parameters file, and reported in thousands of constant year-2003 dollars.  The primary text 
discusses these types of costs and benefits in greater detail, and Appendix A (Model Inputs) 
discusses corresponding input assumptions. 
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Table 36. Industry Effects Summary (Sample) 

 
 
  

                    

Gasoline Diesel Ethanol-85 Electricity Hydrogen Total
Lifetime Energy Consumption (MMBTU) 14,052,029,420 20,187,790 146,900,998 3,677,267 - 14,222,795,475

Fuel Consumption (k gal.) 121,959,096 155,905 1,785,075 31,915 - 123,931,991
Electricity Use (mW-h) - - - 1,077,745 - 1,077,745
Hydrogen Use (Mcf) - - - - - - 

Lifetime VMT (k mi.) 3,404,703,811 4,456,934 22,828,494 6,361,400 - 3,438,350,639
Rated Fuel Economy (mpg) 34.90 35.73 15.99 284.74 - 34.68
On Road Fuel Economy (mpg) 27.92 28.59 12.79 199.32 - 27.74
Changes vs. Baseline

Lifetime Energy Consumption -324,969,383 -63,392 72,922 -23,213 - -324,983,066
Fuel Consumption -2,820,445 -490 886 -201 - -2,820,250
Electricity Use - - - -6,803 - -6,803
Hydrogen Use - - - - - - 

Lifetime VMT 12,698,514 1,893 21,009 777 - 12,722,193
Rated Fuel Economy 0.92 0.13 0.01 1.82 - 0.90
On Road Fuel Economy 0.73 0.10 0.01 1.27 - 0.72

Gasoline Diesel Ethanol-85 Electricity Hydrogen Total
Carbon Dioxide (mmT) 1,331 2 16 1 - 1,350
Carbon Monoxide (tons) 15,283,602 17,419 448,526 275 - 15,749,822
Volatile Organic Compounds (tons) 740,904 449 15,170 13 - 756,536
Nitrous Oxides (tons) 807,359 1,753 15,940 494 - 825,546
Particulate Matter (tons) 65,541 66 486 74 - 66,168
Sulfur Oxides (tons) 146,497 176 725 884 - 148,281
Changes vs. Baseline

Carbon Dioxide -31 -0 0 -0 - -31
Carbon Monoxide 52,185 7 422 -2 - 52,613
Volatile Organic Compounds -6,354 -0 13 -0 - -6,341
Nitrous Oxides -2,970 -0 14 -3 - -2,959
Particulate Matter -425 -0 0 -0 - -425
Sulfur Oxides -3,388 -1 0 -6 - -3,394

Cars CUVs/Minivans Trucks/SUVs Cars CUVs/Minivans Trucks/SUVs
Changes in Fatalities 61.45 -54.93 -2.74 4.07 -8.67 5.38
Lifetime VMT (k mi.) 1,714,185,957 907,783,948 816,380,734 8,907,630 2,804,266 1,010,297
Average Curb Weight (lbs.) 3,144 3,874 4,427 -5 -28 -10

Undiscounted Discounted Undiscounted Discounted
Consumer Valued Costs

Retail Fuel Costs 431,570,873 275,370,728 -9,834,544 -6,361,524
Travel Value -70,254 -45,203 -70,254 -45,203
Refueling Time Value -455,254 -299,800 -455,254 -299,800
Loss of Value - - - - 
Total Consumer Costs 431,045,365 275,025,726 -10,360,051 -6,706,526

Socially Valued Costs
Lifetime Pretax Fuel Expenditures 385,061,843 310,377,240 -8,771,396 -7,123,855
Fuel Tax Revenues 46,509,030 38,010,578 -1,063,147 -875,841
Travel Value -70,254 -57,076 -70,254 -57,076
Refueling Time Value -455,254 -373,607 -455,254 -373,607
Loss of Value - - - - 
Petroleum Market Externalities 20,235,282 16,455,843 -466,823 -382,297
Congestion Costs 180,804,385 147,530,664 684,300 560,567
Accident Costs 86,757,848 70,641,318 313,232 256,180
Noise Costs 3,438,351 2,802,692 12,722 10,414
Fatality Costs 23,922 30,411 4,940 4,696
Emissions

Carbon Dioxide 40,781,944 32,440,110 -924,135 -741,877
Carbon Monoxide - - - - 
Volatile Organic Compounds 1,210,458 921,357 -10,146 -8,502
Nitrous Oxides 5,448,607 4,161,547 -19,530 -16,823
Particulate Matter 19,850,409 15,277,063 -127,496 -107,027
Sulfur Oxides 5,782,978 4,703,278 -132,354 -108,391

Subtotals
Retail Fuel Costs 431,570,873 348,387,817 -9,834,544 -7,999,695
Total Social Costs 748,870,518 604,910,839 -9,962,195 -8,087,596

Fatalities by Vehicle Type

Modeling Effects Summary for the Industry (Scenario 2, Model Year 2017)

Changes vs. Baseline

Emissions by Fuel Type

Energy Consumption by Fuel Type

Owner and Societal Costs (k $)

Changes vs. Baseline
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B.4 Industry Effects Details 
 

Table 37. Industry Effects Details (Sample) 

 
  

                        

Domestic Auto Imported Auto Light Trucks Unregulated Domestic Auto Imported Auto Light Trucks Unregulated
Energy Consumption for Gasoline

Energy Consumption (MMBTU) 7,433,169,914 - 6,618,859,507 - -270,094,583 - -54,874,800 - 
Fuel Consumption (k gal.) 64,513,292 - 57,445,803 - -2,344,180 - -476,264 - 
Lifetime VMT (k mi.) 2,042,449,733 - 1,362,254,078 - 10,971,766 - 1,726,748 - 
Rated Fuel Economy (mpg) 39.57 - 29.64 - 1.59 - 0.28 - 
On Road Fuel Economy (mpg) 31.66 - 23.71 - 1.27 - 0.22 - 

Energy Consumption for Diesel
Energy Consumption (MMBTU) 3,526,655 - 16,661,135 - 0 - 0 - 
Fuel Consumption (k gal.) 27,235 - 128,669 - -21 - -469 - 
Lifetime VMT (k mi.) 977,896 - 3,479,038 - 108 - 1,785 - 
Rated Fuel Economy (mpg) 44.88 - 33.80 - 0.04 - 0.14 - 
On Road Fuel Economy (mpg) 35.91 - 27.04 - 0.03 - 0.11 - 

Energy Consumption for Ethanol-85
Energy Consumption (MMBTU) 30,603,435 - 116,297,563 - -694 - 73,616 - 
Fuel Consumption (k gal.) 371,879 - 1,413,196 - -8 - 895 - 
Lifetime VMT (k mi.) 5,965,067 - 16,863,428 - 3,823 - 17,187 - 
Rated Fuel Economy (mpg) 20.05 - 14.92 - 0.01 - 0.01 - 
On Road Fuel Economy (mpg) 16.04 - 11.93 - 

Energy Consumption for Electricity
Energy Consumption (MMBTU) 3,677,267 - - - -23,213 - - - 
Fuel Consumption (k GEG) 31,915 - - - -201 - - - 
Electricity Use (mW-h) 1,077,745 - - - -6,803 - - - 
Lifetime VMT (k mi.) 6,361,400 - - - 777 - - - 
Rated Fuel Economy (mi/GEG) 284.74 - - - 1.82 - - - 
On Road Fuel Economy (mi/GEG) 199.32 - - - 1.27 - - - 

Energy Consumption for Hydrogen
Energy Consumption (MMBTU) - - - - - - - - 
Fuel Consumption (k GEG) - - - - - - - - 
Hydrogen Use (Mcf) - - - - - - - - 
Lifetime VMT (k mi.) - - - - - - - - 
Rated Fuel Economy (mi/GEG) - - - - - - - - 
On Road Fuel Economy (mi/GEG) - - - - - - - - 

Domestic Auto Imported Auto Light Trucks Unregulated Domestic Auto Imported Auto Light Trucks Unregulated
Emissions from Gasoline Use

Carbon Dioxide (mmT) 704 - 627 - -26 - -5 - 
Carbon Monoxide (tons) 8,209,965 - 7,073,637 - 43,496 - 8,689 - 
Volatile Organic Compounds (tons) 393,536 - 347,368 - -5,280 - -1,074 - 
Nitrous Oxides (tons) 415,512 - 391,847 - -2,495 - -475 - 
Particulate Matter (tons) 32,785 - 32,756 - -357 - -68 - 
Sulfur Oxides (tons) 77,493 - 69,004 - -2,816 - -572 - 

Emissions from Diesel Use
Carbon Dioxide (mmT) 0 - 2 - -0 - -0 - 
Carbon Monoxide (tons) 3,027 - 14,392 - 0 - 7 - 
Volatile Organic Compounds (tons) 73 - 376 - -0 - -0 - 
Nitrous Oxides (tons) 283 - 1,471 - -0 - -0 - 
Particulate Matter (tons) 10 - 56 - -0 - -0 - 
Sulfur Oxides (tons) 31 - 145 - -0 - -1 - 

Emissions from Ethanol-85 Use
Carbon Dioxide (mmT) 3 - 13 - -0 - 0 - 
Carbon Monoxide (tons) 102,099 - 346,427 - 66 - 356 - 
Volatile Organic Compounds (tons) 2,503 - 12,667 - 1 - 12 - 
Nitrous Oxides (tons) 2,332 - 13,609 - 1 - 13 - 
Particulate Matter (tons) 116 - 370 - 0 - 0 - 
Sulfur Oxides (tons) 151 - 574 - -0 - 0 - 

Emissions from Electricity Use
Carbon Dioxide (mmT) 1 - - - -0 - - - 
Carbon Monoxide (tons) 275 - - - -2 - - - 
Volatile Organic Compounds (tons) 13 - - - -0 - - - 
Nitrous Oxides (tons) 494 - - - -3 - - - 
Particulate Matter (tons) 74 - - - -0 - - - 
Sulfur Oxides (tons) 884 - - - -6 - - - 

Emissions from Hydrogen Use
Carbon Dioxide (mmT) - - - - - - - - 
Carbon Monoxide (tons) - - - - - - - - 
Volatile Organic Compounds (tons) - - - - - - - - 
Nitrous Oxides (tons) - - - - - - - - 
Particulate Matter (tons) - - - - - - - - 
Sulfur Oxides (tons) - - - - - - - - 

Modeling Effects Details for the Industry (Scenario 2, Model Year 2017)

Changes vs. Baseline
Energy Consumption by Fuel Type and Regulatory Class

Changes vs. Baseline
Emissions by Fuel Type and Regulatory Class
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B.5 Industry Societal Costs Details 
 

Table 38. Industry Societal Costs Details (Sample for Total Social Costs) 

 
 
  

MY: 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025
CY: 2009 29.4 - - - - - - - - - - - - - - - - 

2010 32.3 36.7 - - - - - - - - - - - - - - - 
2011 32.4 36.6 43.6 - - - - - - - - - - - - - - 
2012 31.7 36.2 43.0 50.7 - - - - - - - - - - - - - 
2013 31.5 36.0 43.1 50.7 56.0 - - - - - - - - - - - - 
2014 30.6 35.5 42.4 50.4 55.5 55.5 - - - - - - - - - - - 
2015 29.7 34.6 41.9 49.7 55.3 55.1 57.0 - - - - - - - - - - 
2016 28.2 33.2 40.4 48.7 54.1 54.4 56.2 57.3 - - - - - - - - - 
2017 26.8 31.7 39.1 47.2 53.2 53.5 55.7 56.7 56.2 - - - - - - - - 
2018 25.1 30.0 37.2 45.5 51.4 52.5 54.6 56.1 55.5 55.2 - - - - - - - 
2019 23.3 28.0 35.0 43.1 49.4 50.6 53.4 54.8 54.8 54.3 54.7 - - - - - - 
2020 21.1 26.0 32.8 40.7 46.8 48.6 51.5 53.6 53.5 53.6 53.9 55.7 - - - - - 
2021 18.4 23.5 30.4 38.0 44.1 46.0 49.4 51.6 52.3 52.3 53.0 54.7 56.2 - - - - 
2022 15.7 20.6 27.6 35.4 41.4 43.6 47.0 49.8 50.6 51.4 52.0 54.1 55.5 57.4 - - - 
2023 13.2 17.5 24.0 31.9 38.3 40.7 44.2 47.1 48.4 49.4 50.8 52.8 54.6 56.4 58.1 - - 
2024 11.1 14.8 20.5 27.9 34.8 37.8 41.5 44.5 46.1 47.5 49.0 51.7 53.5 55.7 57.3 59.2 - 
2025 9.3 12.5 17.3 23.8 30.3 34.2 38.5 41.6 43.4 45.1 47.1 49.9 52.3 54.4 56.5 58.2 60.5
2026 7.7 10.5 14.6 20.0 25.7 29.7 34.8 38.6 40.6 42.5 44.6 47.8 50.4 53.1 55.1 57.3 59.5
2027 6.4 8.7 12.2 17.0 21.7 25.3 30.3 35.0 37.8 39.8 42.2 45.4 48.4 51.3 54.0 56.1 58.7
2028 5.3 7.2 10.2 14.2 18.3 21.3 25.7 30.3 34.1 36.9 39.4 42.8 45.9 49.2 52.0 54.8 57.2
2029 4.5 6.0 8.5 11.8 15.3 18.0 21.6 25.8 29.6 33.4 36.6 40.1 43.3 46.7 50.0 52.9 56.1
2030 3.8 5.1 7.0 9.7 12.7 14.9 18.1 21.5 25.0 28.8 32.9 37.0 40.3 43.8 47.1 50.4 53.7
2031 3.2 4.3 5.8 8.0 10.4 12.3 15.0 18.0 20.7 24.2 28.2 33.1 37.1 40.6 44.1 47.4 51.1
2032 2.7 3.6 4.9 6.7 8.6 10.1 12.3 14.8 17.3 20.1 23.7 28.4 33.2 37.4 40.9 44.4 48.1
2033 2.3 3.1 4.1 5.6 7.2 8.3 10.1 12.2 14.3 16.8 19.7 23.9 28.5 33.5 37.7 41.2 45.0
2034 2.0 2.6 3.6 4.7 6.0 6.9 8.3 10.0 11.7 13.9 16.5 19.9 24.0 28.8 33.8 38.1 41.9
2035 1.5 2.2 3.0 4.1 5.1 5.8 7.0 8.2 9.6 11.4 13.6 16.6 20.0 24.2 29.0 34.1 38.6
2036 1.4 1.8 2.6 3.4 4.3 4.9 5.8 6.9 7.9 9.3 11.1 13.7 16.6 20.1 24.4 29.3 34.6
2037 1.2 1.6 2.0 3.0 3.7 4.2 4.9 5.8 6.6 7.6 9.1 11.2 13.7 16.7 20.2 24.6 29.7
2038 1.1 1.4 1.8 2.3 3.2 3.5 4.2 4.8 5.5 6.4 7.5 9.1 11.2 13.8 16.8 20.4 24.9
2039 0.9 1.2 1.6 2.1 2.5 3.0 3.5 4.1 4.6 5.3 6.2 7.5 9.1 11.2 13.8 16.9 20.6
2040 0.8 1.1 1.4 1.8 2.2 2.4 3.0 3.5 3.9 4.4 5.2 6.2 7.5 9.2 11.3 13.9 17.1
2041 0.7 0.9 1.2 1.6 1.9 2.1 2.3 3.0 3.3 3.8 4.3 5.2 6.2 7.5 9.2 11.3 14.0
2042 0.6 0.8 1.1 1.4 1.7 1.8 2.1 2.3 2.8 3.2 3.7 4.3 5.2 6.2 7.5 9.2 11.5
2043 0.5 0.7 0.9 1.2 1.5 1.6 1.8 2.0 2.2 2.7 3.1 3.7 4.3 5.2 6.2 7.5 9.3
2044 0.5 0.6 0.8 1.1 1.3 1.4 1.6 1.8 1.9 2.1 2.7 3.1 3.6 4.3 5.2 6.2 7.6
2045 - 0.5 0.7 0.9 1.1 1.2 1.4 1.6 1.7 1.8 2.0 2.6 3.1 3.6 4.3 5.2 6.3
2046 - - 0.6 0.8 1.0 1.1 1.2 1.4 1.5 1.6 1.8 2.0 2.6 3.1 3.6 4.3 5.2
2047 - - - 0.7 0.9 1.0 1.1 1.2 1.3 1.4 1.6 1.8 2.0 2.6 3.0 3.6 4.3
2048 - - - - 0.7 0.8 0.9 1.1 1.1 1.2 1.4 1.5 1.7 2.0 2.6 3.0 3.7
2049 - - - - - 0.7 0.8 0.9 1.0 1.1 1.2 1.4 1.5 1.7 1.9 2.6 3.1
2050 - - - - - - 0.7 0.8 0.9 1.0 1.1 1.2 1.3 1.5 1.7 1.9 2.6
2051 - - - - - - - 0.7 0.8 0.8 0.9 1.0 1.2 1.3 1.5 1.7 1.9
2052 - - - - - - - - 0.6 0.7 0.8 0.9 1.0 1.2 1.3 1.5 1.7
2053 - - - - - - - - - 0.6 0.7 0.8 0.9 1.0 1.2 1.3 1.5
2054 - - - - - - - - - - 0.6 0.7 0.8 0.9 1.0 1.2 1.3
2055 - - - - - - - - - - - 0.6 0.7 0.8 0.9 1.0 1.2
2056 - - - - - - - - - - - - 0.6 0.7 0.8 0.9 1.0
2057 - - - - - - - - - - - - - 0.6 0.7 0.8 0.9
2058 - - - - - - - - - - - - - - 0.6 0.7 0.8
2059 - - - - - - - - - - - - - - - 0.6 0.7
2060 - - - - - - - - - - - - - - - - 0.6
2061 - - - - - - - - - - - - - - - - - 
2062 - - - - - - - - - - - - - - - - - 
2063 - - - - - - - - - - - - - - - - - 
2064 - - - - - - - - - - - - - - - - - 
2065 - - - - - - - - - - - - - - - - - 
2066 - - - - - - - - - - - - - - - - - 
2067 - - - - - - - - - - - - - - - - - 
2068 - - - - - - - - - - - - - - - - - 
2069 - - - - - - - - - - - - - - - - - 
2070+ - - - - - - - - - - - - - - - - - 

Total 457.1 517.3 606.9 705.9 767.6 754.9 767.5 769.3 748.9 731.6 722.6 732.3 738.1 747.9 755.5 763.7 776.5

Total Social Costs Details for the Industry (Scenario 2 -- Preferred Alternative)

Undiscounted Total Social Costs for All Vehicles (b $)
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Table 39. Industry Societal Costs Details (Sample for Retail Fuel Costs) 

 
 
  

MY: 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025
CY: 2009 17.5 - - - - - - - - - - - - - - - - 

2010 19.2 21.8 - - - - - - - - - - - - - - - 
2011 19.5 22.1 26.0 - - - - - - - - - - - - - - 
2012 19.0 21.7 25.4 29.5 - - - - - - - - - - - - - 
2013 19.2 22.0 26.1 30.2 32.8 - - - - - - - - - - - - 
2014 18.9 21.8 25.9 30.3 32.8 32.3 - - - - - - - - - - - 
2015 18.3 21.3 25.6 30.1 32.8 32.3 33.0 - - - - - - - - - - 
2016 17.5 20.5 24.8 29.4 32.2 32.0 32.6 32.9 - - - - - - - - - 
2017 16.6 19.7 24.0 28.7 31.8 31.7 32.6 32.8 32.1 - - - - - - - - 
2018 15.7 18.6 22.9 27.6 30.8 31.0 32.1 32.5 31.8 31.1 - - - - - - - 
2019 14.5 17.5 21.6 26.3 29.6 30.0 31.3 31.9 31.5 30.8 30.4 - - - - - - 
2020 13.2 16.2 20.3 24.8 28.2 28.9 30.3 31.2 30.9 30.5 30.0 30.6 - - - - - 
2021 11.4 14.6 18.7 23.1 26.4 27.3 28.9 29.9 30.0 29.7 29.5 30.0 30.3 - - - - 
2022 9.9 12.9 17.1 21.5 24.9 25.9 27.7 28.9 29.2 29.2 29.1 29.9 30.1 30.8 - - - 
2023 8.3 11.0 14.9 19.4 22.9 24.1 26.0 27.4 27.9 28.0 28.3 29.1 29.6 30.2 30.9 - - 
2024 7.0 9.3 12.8 17.1 20.9 22.4 24.4 25.9 26.6 27.0 27.5 28.5 29.2 30.1 30.6 31.2 - 
2025 5.9 7.8 10.8 14.6 18.2 20.3 22.5 24.2 25.0 25.6 26.3 27.5 28.4 29.3 30.2 30.7 31.5
2026 4.9 6.6 9.1 12.3 15.6 17.7 20.4 22.4 23.4 24.1 24.9 26.3 27.3 28.6 29.5 30.3 31.1
2027 4.1 5.5 7.7 10.4 13.2 15.2 17.9 20.4 21.7 22.7 23.6 25.1 26.4 27.7 28.9 29.8 30.8
2028 3.4 4.6 6.4 8.7 11.1 12.8 15.2 17.7 19.6 20.9 22.0 23.6 24.9 26.5 27.8 28.9 30.1
2029 2.9 3.9 5.3 7.3 9.3 10.8 12.9 15.1 17.2 19.0 20.4 22.2 23.6 25.3 26.8 28.0 29.4
2030 2.4 3.2 4.4 6.0 7.7 8.9 10.6 12.6 14.4 16.3 18.2 20.2 21.8 23.4 25.0 26.4 28.0
2031 2.0 2.7 3.6 5.0 6.3 7.3 8.8 10.4 12.0 13.7 15.7 18.1 19.9 21.7 23.3 24.8 26.5
2032 1.7 2.3 3.1 4.1 5.2 6.0 7.3 8.6 9.9 11.4 13.2 15.6 17.8 19.9 21.6 23.2 24.9
2033 1.5 1.9 2.6 3.5 4.3 5.0 6.0 7.1 8.2 9.5 11.0 13.1 15.3 17.8 19.8 21.5 23.2
2034 1.3 1.6 2.2 2.9 3.7 4.1 4.9 5.9 6.8 7.9 9.1 10.9 12.9 15.3 17.8 19.7 21.6
2035 1.0 1.4 1.9 2.5 3.1 3.5 4.1 4.8 5.6 6.5 7.6 9.1 10.8 12.9 15.3 17.7 19.8
2036 0.9 1.1 1.6 2.1 2.6 2.9 3.4 4.0 4.6 5.3 6.2 7.5 8.9 10.8 12.9 15.2 17.8
2037 0.8 1.0 1.3 1.8 2.2 2.5 2.9 3.4 3.8 4.4 5.1 6.2 7.4 8.9 10.7 12.8 15.3
2038 0.7 0.9 1.1 1.5 1.9 2.1 2.5 2.8 3.2 3.6 4.2 5.0 6.1 7.3 8.9 10.7 12.9
2039 0.6 0.8 1.0 1.3 1.5 1.8 2.1 2.4 2.7 3.0 3.5 4.1 5.0 6.0 7.3 8.8 10.7
2040 0.5 0.7 0.9 1.1 1.3 1.4 1.8 2.0 2.3 2.5 2.9 3.4 4.1 4.9 6.0 7.3 8.8
2041 0.5 0.6 0.8 1.0 1.2 1.3 1.4 1.8 1.9 2.2 2.4 2.9 3.4 4.0 4.9 5.9 7.3
2042 0.4 0.5 0.7 0.9 1.0 1.1 1.2 1.4 1.7 1.8 2.1 2.4 2.8 3.3 4.0 4.9 6.0
2043 0.4 0.5 0.6 0.8 0.9 1.0 1.1 1.2 1.3 1.6 1.7 2.0 2.3 2.8 3.3 4.0 4.9
2044 0.3 0.4 0.5 0.7 0.8 0.9 1.0 1.1 1.1 1.2 1.5 1.7 2.0 2.3 2.7 3.3 4.0
2045 - 0.4 0.5 0.6 0.7 0.8 0.8 0.9 1.0 1.1 1.2 1.5 1.7 2.0 2.3 2.7 3.3
2046 - - 0.4 0.5 0.6 0.7 0.7 0.8 0.9 0.9 1.0 1.1 1.4 1.7 1.9 2.3 2.7
2047 - - - 0.5 0.5 0.6 0.6 0.7 0.8 0.8 0.9 1.0 1.1 1.4 1.6 1.9 2.3
2048 - - - - 0.5 0.5 0.6 0.6 0.7 0.7 0.8 0.9 1.0 1.1 1.4 1.6 1.9
2049 - - - - - 0.4 0.5 0.6 0.6 0.6 0.7 0.8 0.9 1.0 1.1 1.4 1.6
2050 - - - - - - 0.4 0.5 0.5 0.6 0.6 0.7 0.7 0.8 0.9 1.0 1.4
2051 - - - - - - - 0.4 0.5 0.5 0.5 0.6 0.7 0.7 0.8 0.9 1.0
2052 - - - - - - - - 0.4 0.4 0.5 0.5 0.6 0.6 0.7 0.8 0.9
2053 - - - - - - - - - 0.4 0.4 0.5 0.5 0.6 0.6 0.7 0.8
2054 - - - - - - - - - - 0.4 0.4 0.4 0.5 0.6 0.6 0.7
2055 - - - - - - - - - - - 0.4 0.4 0.4 0.5 0.6 0.6
2056 - - - - - - - - - - - - 0.3 0.4 0.4 0.5 0.5
2057 - - - - - - - - - - - - - 0.3 0.4 0.4 0.5
2058 - - - - - - - - - - - - - - 0.3 0.4 0.4
2059 - - - - - - - - - - - - - - - 0.3 0.4
2060 - - - - - - - - - - - - - - - - 0.3
2061 - - - - - - - - - - - - - - - - - 
2062 - - - - - - - - - - - - - - - - - 
2063 - - - - - - - - - - - - - - - - - 
2064 - - - - - - - - - - - - - - - - - 
2065 - - - - - - - - - - - - - - - - - 
2066 - - - - - - - - - - - - - - - - - 
2067 - - - - - - - - - - - - - - - - - 
2068 - - - - - - - - - - - - - - - - - 
2069 - - - - - - - - - - - - - - - - - 
2070+ - - - - - - - - - - - - - - - - - 

Total 281.6 319.3 372.4 428.3 459.8 447.4 450.5 447.4 431.6 415.5 403.3 403.3 399.9 401.5 401.6 401.2 403.8

Retail Fuel Costs Details for the Industry (Scenario 2 -- Preferred Alternative)

Undiscounted Retail Fuel Costs for All Vehicles (b $)



DRAFT – December 2011 

74 

B.6 Manufacturer Compliance Summary 
 
The Manufacturer Compliance Summary output file is identical in structure to the Industry 
Compliance Summary.  To protect potential manufacturer Confidential Business Information, a 
sample of this output file is not provided.  
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B.7 Vehicles Report 
 
For each included scenario, the model produces an output file providing results at the level of 
individual vehicle model types specified in the market data input file.  This vehicle-level report 
includes separate worksheets (tabs) for each model year, each containing the following 
information: 
 

Table 40. Vehicles Report (Contents) 

 
 

  

Group Column Contents
Unique vehicle ID per manufacturer.
The manufacturer of the vehicle.
Name of the vehicle model.
The nameplate of the vehicle.

No. ID number of the vehicle's engine.
Fuel Engine fuel type.
Type Engine type (configuration, cylinders,  displacement).
HP Engine horsepower.
ID# ID number of the vehicle's transmission.
Type Type of the transmission.
Initial (mpg) Initial fuel economy.
Initial (fuel) Initial fuel type of the vehicle.
Final (mpg) Final fuel economy.
Final (mpg-AC) Final fuel economy, with AC adjustment.
Final Final fuel type of the vehicle.
Reg Class The regulatory class assignment of the vehicle.
Technology Class The technology class of the vehicle.
Safety Class The safety class of the vehicle.

Redesign state of the vehicle.
Refresh state of the vehicle.

Initial Initial sales volume (units).
Final Final sales volume (units).
Initial Initial MSRP ($).
Final Intial Price ($).
Initial Initial curb weight.
Final Final curb weight.

Vehicle footprint.
Incurred Tech Cost Unit technology cost ($).
Price Increase Unit price increase ($).
Loss Of Value Unit loss of value to consumer ($).
Incurred Tech Cost Total technology cost ($k).
Increase in Sales Rev. Total increase in revenue ($k).
Loss Of Value Total loss of value to consumer ($k).

Usage of each technology by the vehicle.

Model
Manufacturer

No.

Name Plate

Transmission

Regulatory
Classification

Engine

Curb Weight (lb)

Fuel Econ. (mpg)

Total Sales

Area (sf)

MSRP ($)

Technology Utilization/Applicability

Refresh State
Redesign State

Unit Costs ($)

Total Costs ($k)



DRAFT – December 2011 

76 

B.8 Optimized Industry Report 
 
Appendix C (below) discusses use of the model to estimate the “optimal” stringency of CAFE 
standards.  This operating mode involves incrementally increasing the stringency of the 
standards over a range, estimating corresponding costs, fuel savings, CO2 emission reductions, 
and benefits at each iteration.  Table 41 shows a sample of industry-level reporting.  Average 
required CAFE levels for each iteration are shown in the “Standards” section, with resultant 
average achieved fuel economy levels shown under “CAFE”, and resultant incremental costs 
(relative to the baseline standards) shown under “Tech Costs”.  Estimated optimal stringencies 
(e.g., for MY2017, index number 56, producing an average required CAFE of 42.6 mpg) are 
shown in the “Optimized” section. 
 

Table 41. Optimized Industry Report - Data (Sample) 

 
 

Optimized A B C D E F G H Stnd Index
2009 27.5
2010 27.5
2011 31.2 24.0 51.4 1.9
2012 35.9 27.9 0.0 0.0
2013 36.8 28.5 0.0 0.0
2014 37.8 29.0 0.0 0.0
2015 39.2 29.9 0.0 0.0
2016 41.1 31.0 0.0 0.0
2017 46.4 34.9 0.0 0.0 41.1 31.0 0.0 0.0 42.6 56
2018 48.5 36.5 0.0 0.0 41.1 31.0 0.0 0.0 44.6 65
2019 49.7 37.5 0.0 0.0 41.1 31.0 0.0 0.0 45.7 70
2020 51.0 38.4 0.0 0.0 41.1 31.0 0.0 0.0 46.8 75
2021 51.5 38.8 0.0 0.0 41.1 31.0 0.0 0.0 47.3 77
2022 51.8 39.0 0.0 0.0 41.1 31.0 0.0 0.0 47.6 78
2023 52.3 39.4 0.0 0.0 41.1 31.0 0.0 0.0 48.0 80
2024 53.1 40.0 0.0 0.0 41.1 31.0 0.0 0.0 48.8 83
2025 53.6 40.4 0.0 0.0 41.1 31.0 0.0 0.0 49.3 85

Standards 0 1 2 3 4 5 6 7 8 9
2009
2010
2011
2012
2013
2014
2015
2016
2017 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8
2018 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8
2019 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8
2020 38.6 38.6 38.6 38.6 38.6 38.6 38.6 38.6 38.6 38.6
2021 39.7 39.7 39.7 39.7 39.7 39.7 39.7 39.7 39.7 39.7
2022 40.0 40.0 40.0 40.0 40.0 40.0 40.0 40.0 40.0 40.0
2023 40.3 40.3 40.3 40.3 40.3 40.3 40.3 40.3 40.3 40.3
2024 40.7 40.7 40.7 40.7 40.7 40.7 40.7 40.7 40.7 40.7
2025 41.3 41.3 41.3 41.3 41.3 41.3 41.3 41.3 41.3 41.3

CAFE
2009
2010
2011
2012
2013
2014
2015
2016
2017 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8 37.8
2018 42.5 42.5 42.5 42.5 42.5 42.5 42.5 42.5 42.5 42.5
2019 44.5 44.5 44.5 44.5 44.5 44.5 44.5 44.5 44.5 44.5
2020 45.6 45.6 45.6 45.6 45.6 45.6 45.6 45.6 45.6 45.6
2021 46.8 46.8 46.8 46.8 46.8 46.8 46.8 46.8 46.8 46.8
2022 47.3 47.3 47.3 47.3 47.3 47.3 47.3 47.3 47.3 47.3
2023 47.5 47.5 47.5 47.5 47.5 47.5 47.5 47.5 47.5 47.5
2024 47.9 47.9 47.9 47.9 47.9 47.9 47.9 47.9 47.9 47.9
2025 48.8 48.8 48.8 48.8 48.8 48.8 48.8 48.8 48.8 48.8

Tech Costs
2009
2010
2011
2012
2013
2014
2015
2016
2017 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
2018 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0 9,135.0
2019 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9 10,519.9
2020 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6 11,608.6
2021 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7 12,876.7
2022 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2 13,552.2
2023 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4 13,973.4
2024 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6 14,835.6
2025 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4 15,659.4
Total 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0 102,161.0
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The optimized industry report also produces graphs of numerous measures (e.g., incremental 
costs, incremental benefits) versus stringency.  Figure 8 below shows a sample graph in which 
net benefits (relative to baseline standards) are plotted versus average required CAFE levels for 
each model year during MY2009-2025. 
 

 
Figure 8. Optimized Industry Report - Net Benefits Graph (Sample) 
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Appendix C “Optimization” of CAFE Standards 
 
The modeling system contains algorithms that may be used to “optimize” the average stringency 
(that is, the average required fuel economy) of an attribute-based system by estimating the 
stringency at which a given condition is met.  “Optimizing” the stringency, in the current 
modeling system, is done either by estimating the stringency level at which net societal benefits 
are maximized (maximum net benefits), or by finding the level where the absolute value of net 
benefits is minimized, after the maximum has occurred (total cost equals total benefits).30  
Optimization of CAFE Standards may be set up and run using directions provided in Appendix E 
below. 
 
Using the functional form defined in the scenarios file, the optimized stringency for either the 
passenger car or light truck fleet is determined for the entire industry, and for each year, by 
adjusting the entire function at a user-specified increment, for a given number of iterations above 
and below the initial shape.31  To ensure the correct “carry-over” of technology costs and 
improvements, the model years are optimized sequentially.  At the end of each model year, the 
system re-runs the entire passenger car or light truck fleet using the optimized stringency, then 
carries the costs and improvements into the next year. 
 
With the varying functional form, the stringency is slightly altered between new iterations (or 
trials).  As the system examines each trial, it performs typical compliance modeling.  At the end 
of each iteration, the model calculates and saves the final technology costs, fines owed, benefits, 
fuel savings, and benefit-cost ratios for each manufacturer and industry overall.  Once all 
iterations have been processed, the modeling system calculates the stringency by finding the first 
iteration that satisfies the net-benefit-maximizing or absolute-value-of-net-benefit-minimizing 
criterion. 
 
Below, Figure 9 illustrates how the model maximizes net benefits.  The plot on the left shows 
curves specifying fuel economy targets for three iterations (i.e., stringency levels) examined 
under a sample optimization.  For each of these iterations, colored points in the plot on the right 
show the corresponding stringency (in terms of average required fuel economy) and the 
calculated net benefits (in $m).  The black line in the plot on the right shows stringency and net 
benefits for all other iterations included in the optimization.  In this example, the least stringent 
of the three highlighted iterations, shown in red, produces net benefits of about $2,700m at a 
stringency of 31.2 mpg.  As stringency increases, net benefits reach a peak or maximum, shown 
in green, of about $3,100m at a stringency of 31.7 mpg.  The corresponding curve is shown in 
green in the plot on the left.  As stringency increases beyond this point, more expensive 

                                                
30 Use of the term “optimize” was first applied in this model in reference to the concept of estimating the “socially 
optimal” stringency—that is, the stringency producing the greatest increase in benefits relative to the increase in 
costs, where both benefits and costs are measured on a societal basis, excluding economic transfers such as fuel 
taxes and civil penalties.  This approach involves maximizing net benefits.  Considering public comments, NHTSA 
also required the availability to examine stringencies at which total costs equal total benefits (or, within the scope of 
available technologies, most nearly equal).  As currently used, the term “optimize” refers to either approach. 
31 The model currently optimizes stringency for only one fleet (i.e., passenger car or light truck) in a single model 
run.   
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technologies are required, such that net benefits decrease.  By the point stringency reaches 31.2 
mpg, shown in blue, net benefits fall to about $2,800m. 
 

            
Figure 9. Maximizing Net Benefits 

 
This example also illustrates a scenario in which net benefits stop decreasing before total costs 
equal total benefits (when total costs equal total benefits, net benefits equal zero).  In this 
example, all available technologies are exhausted when stringency reaches 32.5 mpg, at which 
point net benefits are about $500m. Once technologies are exhausted, no additional cost or 
benefits will be realized – the manufacturer’s fleet will remain static. Above this stringency, civil 
penalties are incurred.  However, as economic transfers, civil penalties are not counted as costs 
to society.  Therefore, net benefits do not change as stringency increases beyond 32.5 mpg. 
 
The last step of the modeling process is to use the optimized standard (i.e., the standard defined 
by the user-specified shape and then shifted vertically by the model to produce the optimized 
stringency) to obtain the corresponding fleet (i.e., the fleet that reflects estimated manufacturer 
responses at the optimized stringency) for the model year.  As under standard (i.e., non-
optimizing) modeling exercises, this step is necessary to properly carry over added technologies 
from one model year to the next. 
 
As originally designed, the model only performed optimization by accounting for each 
manufacturer separately, and then using the industry-wide sum of manufacturer-specific results 
to estimate optimal stringency.  In the current version, the model also provides an optional 
setting to merge the fleet (i.e., combine the vehicles of all individual manufacturers into a single 
group) throughout the optimization process.  As explained below, under some circumstances, 
this option can provide more stable optima than when accounting for each manufacturer 
separately.  The effect of this setting is illustrated below for a hypothetical fleet involving two 
manufacturers:  “OEM1,” a “laggard” which produces a fleet of vehicles with generally low 
baseline fuel economy relative to fuel economy targets; and “OEM2,” a “front runner” which 
produces a fleet of vehicles with generally high baseline fuel economy relative to fuel economy 
targets. Typically, a manufacturer with a “laggard” fleet will experience application of 
technologies to its fleet at a lower stringency than that of a manufacturer with a more fuel 
efficient fleet. This will result in a different shape net benefits curve, as well as a different 
placement of the peak of maximum net benefits. 
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Below, Figure 10 shows net benefits (attributable separately to OEM1 and OEM2) on the y axis, 
with stringency (in terms of the average required fuel economy) on the x axis.  As stringency 
increases (moving from left to right on the chart), OEM1, shown in orange, begins to be 
impacted by new standards when the average stringency (i.e., the average fuel economy required 
of the industry) reaches 29.0 mpg.32  For OEM1, net benefits increase as stringency increases 
past 29.0 mpg, peak when stringency reaches 31.9 mpg, decline as stringency continues to 
increase, and stabilize when stringency increases beyond past 32.8 mpg, at which point OEM1 
exhausts all available technology applications.  For OEM2, shown in blue, net benefits do not 
begin to increase until stringency increases past 34.3 mpg.  Subsequently, net benefits 
attributable to OEM2 peak when stringency reaches 40.1 mpg, decline as stringency continues to 
increase, and stabilize when stringency increases beyond past 41.2 mpg, at which point OEM2 
exhausts all available technology applications. 
 

 
Figure 10. Net Benefits versus Stringency for Hypothetical 2-Manufacturer Fleet 

 
Figure 11 shows the corresponding total net benefits for the industry (i.e., the sum of net benefits 
attributable to both OEM1 and OEM2) as a dashed line superimposed on the net benefits 
attributable separately to OEM1 and OEM2.  In this example, the significant difference between 
OEM1 and OEM2 in terms of baseline performance as compared to targets causes the total net 
benefits for the industry to exhibit two distinct peaks, one at 32.8 mpg and one at 40.1 mpg.  

                                                
32 At stringencies of about 29.0-30.2 mpg, net benefits attributable to OEM1 are negative.  This indicates the market 
forecast for OEM1 fell short of the baseline standards, and that for OEM1, standards of 29.0-30.2 mpg (again, in 
terms of average fuel economy required of the industry) would require technology beyond that required under the 
market forecast for OEM1, but not as much as would be required under the baseline standards. 
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Below 34.3 mpg, OEM2 is unaffected, such that results for OEM1 account for all of the net 
benefits for the industry.  Above 34.3 mpg, the net benefits attributable to OEM2 are augmented 
by approximately $500m in net benefits attributable to OEM1 once OEM1 has exhausted 
available technologies (at 32.8 mpg).33  In this example, relative sales volumes are such that the 
“OEM2 peak” at 40.1 mpg is dominant.  However, if OEM1’s market share had been somewhat 
greater than in this example, the “OEM1” peak at 32.8 mpg would have been dominant. 
 

 
Figure 11. Sum of Net Benefits Attributable to OEM1 and OEM2 

 
For the same hypothetical fleet, Figure 12 demonstrates the effect of selecting the “Merge the 
fleet before optimizing” setting when running the model.  With distinctions between OEM1 and 
OEM2 removed, the baseline average fuel economy of the merged fleet exceed are 30.2 mpg and 
technologies are not required until average stringency reaches 30.3 mpg. This higher average 
fuel economy is because the relatively high performance of OEM2’s fleet balances the relatively 
low performance of OEM1’s fleet.  Net benefits subsequently increase, peak at 33.8 mpg, and 
then decline (except for a slight secondary peak at 34.2 mpg) until all technology options are 
exhausted when stringency reaches 34.4 mpg. 
 

                                                
33 If a manufacturer exhausts available technologies without achieving compliance with a given standard, the model 
calculates the resultant civil penalties.  However, because civil penalties are economic transfers, the model does not 
add these to estimated costs; therefore, the plot of net benefits attributed to an individual manufacturer becomes flat 
at stringencies beyond the point where the manufacturer exhausts available technology options. 
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Figure 12. Net Benefits for Hypothetical Merged Fleet 

 
Figure 13 compares the net benefits obtained with the merged fleet to those obtained for the 
underlying individual manufacturers, and for the industry as represented maintaining the 
distinction between the two manufacturers.  Without merging the fleet, the model obtains a net 
benefits plot that has two widely separated peaks.  Because the relative heights of these peaks 
could be impacted differently by relatively modest changes in model inputs (including 
manufacturers’ market shares and sometimes other inputs), these widely separated peaks lead to 
unstable (albeit correctly calculated) results.  For example, relatively modest changes in model 
inputs such as manufacturer sales volumes or economic factors (e.g., discount rate, rebound 
effect, fuel price) can change which peak is dominant, thereby causing a significant change in 
estimated optimized stringency.  The merged fleet produces a much more stable peak that falls 
between the two peaks obtained without applying this option. 
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Figure 13. Comparison of Net Benefits with and without Merging of Fleet 
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Appendix D Monte Carlo Analysis 
 
Uncertainty analysis (e.g., Monte-Carlo simulation) may be performed, such that all included 
scenarios are examined under varying discount rates, technology costs and fuel consumption 
effects, pretax fuel prices, rebound effect, and fuel-related externalities (monopsony, price shock, 
military security, and carbon dioxide costs).  Monte-Carlo analysis may be set up and run using 
directions provided in the CAFE Model Software Manual document. 
 
The results of the analysis are located in the output folder selected during modeling.  Unlike 
other model runs, Monte-Carlo simulation does not produce formatted Excel reports.  Instead, 
plain text Monte-Carlo log files can be found under the “MC-logs” subdirectory.  As with regular 
modeling runs, however, the per-scenario logs are numbered in order of appearance, starting at 0, 
with the first scenario (0) being the baseline to which all others are compared.  The following 
files are generated at the end of the Monte-Carlo simulation: 

• MC_trials.csv:  Contains pseudo-randomly generated Monte-Carlo trials used as input to 
the analysis.  The contents of the file are summarized in Table 42. 

• MC_tech_costs.csv:  Specifies the sales-weighted average technology costs for each 
technology, adjusted by the randomized cost scales from the MC_trials.csv file. The 
average costs for a technology are computed across all vehicle technology classes that 
were used during modeling as follows: 
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where SALESi represent the sales of vehicle i, COSTi,t is the base (unadjusted) cost of 
technology t as it applies to vehicle i, and SCALEt is the randomized value specifying the 
amount by which to scale the technology cost of technology t. 

• MC_tech_fcs.csv:  Specifies the sales-weighted average technology fuel consumption 
improvements for each technology, adjusted by the randomized fuel consumption scales 
from the MC_trials.csv file. The average fuel consumption improvements for a 
technology are computed across all vehicle technology classes that were used during 
modeling as follows: 
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where SALESi represent the sales of vehicle i, FCi,t is the base (unadjusted) fuel 
consumption improvement of technology t as it applies to vehicle i, and SCALEt is the 
randomized value specifying the amount by which to scale the technology fuel 
consumption improvement of technology t. 

• MC_Sn*_data.csv:  Includes the results of pseudo-randomly generated Monte-Carlo 
trials for all scenarios.  The log file for the results of the baseline scenario (0) provides 
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the totals accrued during that scenario.  The log files for the results of non-baseline 
scenarios (Sn1, Sn2, …) contain changes compared to the baseline.  The contents of the 
file are summarized in Table 43. 

 
Table 42. MC_Trials.csv Contents 

 
 

Table 43. MC_Sn*_data.csv Contents 

 
 
  

Column Contents
Index Unique index of the trial.

FuelPriceEstimates Randomized pretax fuel prices; the probabilities are: 50% for 
average fuel prices and 25% for and high prices.

DiscountRate Value of the discount rate examined with each trial.
ReboundEffect Randomized value of the rebound effect.

CO2Estimates Randomized carbon dioxide cost estimates; the probabilites are: 
25% for low, average, high, and very high cost estimates.

MonopsonyCost Randomized value of the monopsony cost.
PriceShockCost Randomized value of the price shock cost.
MilitarySecurityCost Randomized value of the military security cost.

Cost(Technology) Randomized value specifying the amount by which to scale the 
technology costs for each technology.

FC(Technology) Randomized value specifying the amount by which to scale the 
technology fuel consumption improvement for each technology.

Column Contents
Index Unique index of the trial.
DiscountRate Value of the discount rate examined with each trial.

AvePrice_MFR*(MY) Average regulatory costs accumulated by the manufacturers for 
each model year.

TechCost_MFR*(MY) Total technology costs accumulated by the manufacturers for 
each model year.

TechCost(MY) Total technology costs accumulated by the entire industry for 
each model year.

SocialBenefits(MY) Discounted social benefits accumulated by the entire industry for 
each model year.

FuelSavings(MY) Fuel savings accumulated by the entire industry for each model 
year.

BCRatio(MY) Ratio of social benefits to total technology costs for each model 
year.
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Appendix E CAFE Model Software Manual 
 
E.1 Warnings 
 
This software was developed for analysis by U.S. Department of Transportation staff of potential 
fuel economy requirements. 
 
This software uses input files containing detailed information regarding vehicles manufactured 
for sale in the United States and creates output files containing similarly detailed information 
regarding such vehicles.  If input files containing information in any way (e.g., based on 
entitlement under 5 U.S.C 552 to confidential treatment) protected from disclosure to the public 
are used, some output files created by this software must also be protected from disclosure to the 
public. 
 
E.2 Notice 
 
Some of the icons and/or images used by the CAFE Compliance and Effects Modeling System 
may have been obtained from www.kde-look.org and are the sole property of their respective 
owners. 
 
To the best of our knowledge, all images are distributed under the GNU GPL or the GNU LGPL 
licenses.  If any of the icons violate the original author's copyright or terms of use, please contact 
the current administrators of the CAFE Model project. 
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E.3 Installation and System Requirements 
 
The CAFE Compliance and Effects Modeling System (abbreviated: CAFE Model) runs on IBM-
compatible computers using the Microsoft® Windows operating system.  Although the software 
does not have strict hardware requirements, beyond what is needed to run the operating system, a 
1 GHz or faster Intel compatible processor, with at least 2 GB of physical memory (RAM) is 
strongly recommended.  The software has been developed and tested on computers using 
Windows XP/7 and Windows Server 2003/2008, but may operate properly on machines using 
older versions of Windows (e.g., Windows 2000), or newer versions (e.g., Windows 8), as long 
as a compatible Microsoft® .NET Framework is installed. 
 
Because the software makes extensive use of Microsoft® Excel files for input and output, Excel 
must be installed on the system.  To provide a means of protecting confidential business 
information (CBI) contained in input and output files (if the user is relying on CBI), the software 
makes use of encryption algorithms available in Excel 2003.  These algorithms are not available 
in older versions of Excel.  Unencrypted files, however, may be used with such versions. 
 
The software uses the Microsoft® .NET Framework, version 3.5.  If the Framework is not 
already present, it must be installed.  Instructions for downloading and installing the .NET 
framework are available on the Internet at 
http://www.microsoft.com/download/en/details.aspx?id=22. 
 
Based on the characteristics of machines used in the development of this software, the following 
table provides a summary of system requirements: 
 

Table 44.  CAFE Model System Requirements 
Intel compatible processor (1 GHz or faster recommended) 
512 MB RAM (2 GB recommended) 
10 MB hard drive space for installation 
(additional disk space will be required during runtime) 
Microsoft® Windows XP/Vista/7 
Microsoft® Windows Server 2003/2008 
Microsoft® .NET Framework 3.5 
Microsoft® Office 2003 or later. 

 
Once the system requirements have been met, the latest version of the CAFE Model may be 
obtained by contacting NHTSA or Volpe Center staff. 
 
The current version of the software is packaged in a way that does not require installation.  To 
operate the model, place the “CAFE Model.exe” file on the desktop and execute it34. 
 
  

                                                
34 The CAFE Model files provided may be in a zip archive, which will need to be extracted using a zip utility such 
as WinZip (www.winzip.com) or 7Zip (www.7-zip.org). 
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E.4 CAFE Model Graphical User Interface 
 
The CAFE Model Graphical User Interface (GUI) provides users with a set of tools necessary to 
set up and run multiple modeling test scenarios, which are commonly referred to as CAFE Model 
sessions.  Each CAFE Model session can be configured independently, each with its own set of 
model inputs and settings.  Once configured, the session may be saved for future runs, or 
executed immediately.35  When the model runs, the system displays the progress of the 
compliance modeling process in each session's window. 
 
The model GUI consists of two primary screens:  the main CAFE Model window and the 
Modeling Settings window.  The CAFE Model window is used for managing the modeling 
sessions, while the Modeling Settings window is used to configure them. 
 
To run the modeling system, click on the CAFE Model executable file located on the desktop.  
When the application launches, a Warnings dialog box is displayed (Figure 14).  The user must 
read and understand the warnings listed prior to using the modeling system. 
 

 
Figure 14. Warnings Dialog Box 

 
After clicking the OK button in the Warnings dialog box, the main CAFE Model window, 
described below, opens. 
 
  

                                                
35 It is recommended that users save the sessions prior to running them in order to assign a meaningful title to each 
session. 
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E.4.1 CAFE Model Window 
 
The main CAFE Model window (Figure 15) is used to create, configure, and manage CAFE 
modeling sessions.  The main window also controls the model operation, allowing users to start 
and stop modeling simulation, as well as to generate modeling reports. 
 

 
Figure 15. CAFE Model Window 

 
When the model first starts up, most of the menu items and toolbar icons are disabled, until a 
new session is created, or an existing one is opened. 
 
The model GUI is operated using a simple, easy to use file-menu (Figure 16), with most 
commonly used shortcuts also available on the model toolbar (Figure 17).  For user convenience, 
most of the menu entries may also be controlled using keyboard shortcuts. 
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Figure 16. CAFE Model File Menu 

 

 
Figure 17. CAFE Model Toolbar 

 
Some of the most commonly used file menus are: 

• File > New Session:  Creates a new CAFE Model Session and displays the Modeling 
Settings window to the user. 

• File > Open Session:  Opens an existing CAFE Model Session. 

• File > Close Session:  Closes the active CAFE Model Session. 

• File > Save Session:  Saves the active CAFE Model Session. 

• File > Start Modeling:  Begins the modeling process for the active CAFE Model Session. 

• File > Stop Modeling:  Suspends the modeling process of the active CAFE Model 
Session. 

• File > Exit:  Exits the CAFE Model.  If any of the modeling sessions are still opened, 
they will be closed prior to exiting the model. 

• View > Modeling Settings:  Displays the Modeling Settings window, where all modeling 
options and settings may be configured. 

• View > Optimization Settings:  Displays the Manage Optimization window, where 
additional options for Optimization modeling can be configured. 

• View > Monte-Carlo Settings:  Displays the Manage Monte-Carlo window, where 
additional options for Monte-Carlo modeling can be configured. 

• View > Output Location:  Opens the Windows Explorer and browses to the location 
where the output files and reports of the active session are saved. 
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E.4.2 Modeling Settings Window 
 
The Modeling Settings window contains multiple panels for configuring all of the runtime 
options available to the model.  The user can use this window to set up a new session, or 
modifying an existing one, before starting the modeling process.  Each of the available 
configuration panels is outlined in the sections below. 
 
E.4.2.1 General Compliance Settings Panel 
 
The General Compliance Settings panel (Figure 18) is used to specify what type of modeling the 
user would like to run.  Each model is tailored to different type of analysis, using its own set of 
assumptions and configuration settings.  Presently, four model types are available: 

• Standard Compliance Model:  The Standard Compliance Model is the default mode of 
operation for the CAFE modeling system.  This model type is used to evaluate 
technology costs and benefits in response to the required CAFE standards defined in the 
modeling scenarios. 

• Compliance Model with EIS:  This model type is similar to the Standard Compliance 
Model, except additional analysis necessary for the Environmental Impact Statement is 
performed. 

• Optimization Model:  This model type should be used to perform sensitivity analysis and 
optimize the shape of the required CAFE standard. 

• Monte-Carlo Model:  The Monte-Carlo Model is a specialized CAFE modeling type, 
which is used for running customized Monte-Carlo simulations necessary for uncertainty 
analysis. 
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Figure 18. General Compliance Settings Panel 
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E.4.2.2 Input Settings Panel 
 
On the Input Settings panel (Figure 19), the user can select the input data files for use with the 
modeling system.  To protect Confidential Business Information (CBI), some of the input files 
may be password protected.  The CAFE Model, therefore, provides an option for users to enter 
an input password prior to loading such files. 
 

 
Figure 19. Input Settings Panel (1) 
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When selecting input files, the model will attempt to verify that an appropriate file was selected.  
If incorrect file path is entered, an error message will be displayed (Figure 20). 
 

 
Figure 20. Input Settings Panel (2) 
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E.4.2.3 Output Settings Panel 
 
The Output Settings panel (Figure 21) is used to configure the location where modeling results 
will be saved and which modeling reports the CAFE Model should generate.  If input data 
contained CBI, it may be necessary to protect outputs produced by the model.  The system 
provides the ability to password protect the Excel reports that the model generates, however, the 
modeling logs are not encrypted. 
 

 
Figure 21. Output Settings Panel (1) 
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When password protecting the Excel reports, “strong encryption” option may be used for 
improved security (Figure 22). 
 

 
Figure 22. Output Settings Panel (2) 

 
The modeling system is configured to generate eight different report types (Figure 23)36: 

• Technology Utilization Summary:  Provides industry-wide technology application and 
penetration rates for each model year and technology analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

• Industry Compliance Summary:  Provides industry-wide summary of compliance model 
results, where each worksheet tab represents a single model year analyzed.  The results 
are disaggregated by regulatory class, as well as combined over the entire fleet. 

• Industry Effects Summary:  Provides industry-wide summary of energy and emissions 
effects, where each worksheet tab represents a single model year analyzed. 

• Industry Effects Details:  Provides a more detailed view of industry-wide energy and 
emissions effects, where the results are disaggregated by regulatory class.  Each 
worksheet tab represents a single model year analyzed. 

• Industry Societal Costs Details:  Provides details of undiscounted and discounted 
industry-wide societal costs for each calendar and model year.  The results are presented 

                                                
36 Note:  The Monte-Carlo Model does not support any of the modeling reports provided on the Output Settings 
panel.  Selecting any of the reports during Monte-Carlo modeling will have no effect. 
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by regulatory class, as well as combined over the entire fleet.  When this option is 
selected, multiple output files are generated for each socially valued owner and societal 
costs attribute. 

• Manufacturer Compliance Summary:  Provides manufacturer-level summary of 
compliance model results, where each worksheet tab represents a single model year 
analyzed.  The results are disaggregated by regulatory class, as well as combined over the 
entire manufacturer’s fleet.  When this option is selected, a separate output file is 
generated for each manufacturer. 

• Vehicle Details Report:  Presents disaggregate vehicle-level summary of compliance 
model results. 

• Optimized Industry Report:  Provides industry-wide and manufacturer-level technology 
costs, fines, and benefits, as well as carbon dioxide and fuel savings, and benefit-cost 
ratios, for all iterations from industry optimization.  This report also graphs the socially 
optimized functional form (aka, optimized shape) for the entire industry by model year, 
and displays benefit-cost, marginal benefit:cost, net benefits, and optimized shape charts. 
Note:  The Optimized Industry report is automatically generated whenever the 
Optimization Model is run.  This report is not selectable in the model GUI. 

 

 
Figure 23. Output Settings Panel (3) 

 
E.4.2.4 Runtime Settings Panel 
 
The Runtime Settings panel (Figure 24) provides additional modeling options to further 
customize the model behavior, beyond what is available in the input files: 
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• Operate in “Maximum Technology” mode:  Specifies that the model should operate in 
“maximum technology” mode, where each manufacturer is assumed to be unwilling to 
pay CAFE fines, all vehicle refresh and redesign schedules are ignored, and all 
technologies are available for application immediately and without being subject to 
phase-in constraints. 

• Allow Voluntary Overcompliance:  Specifies that the model should continue to apply 
technologies after reaching compliance during a given model year, as long as the 
application of additional technologies is cost effective. 

• Allow Credit Transfers and Carry Forward:  Specifies whether the model should be able 
to transfer credits between fleets (PC and LT) within the same manufacturer and model 
year, and whether the model should be able to carry past credits forward for up to five 
years within the same fleet and manufacturer. 

• Merge the Fleet for Modeling:  Specifies whether to merge the entire industry into a 
single large manufacturer before beginning the modeling process. 

 
Some of the options loaded from a parameters input file may be overridden using the Runtime 
Settings panel as well.  If an “override” option is checked off (not selected), a default value from 
the input file is used.  If an override option is checked on (selected), that value will be used in 
place of what was loaded from the parameters file.  In Figure 24 below, the options for 
overriding the rebound effect and the discount rate are selected, and set to 20% and 7% 
respectively. 
 
The following options from the parameters file may be overridden: 

• Override Fuel Price Estimates:  Specifies whether to use the low, average, or high fuel 
price estimates from the parameters input file.  By default, average fuel price estimates 
are used. 

• Override CO2 Estimates:  Specifies whether to use low, average, high, or very-high 
carbon dioxide cost estimates from the parameters input file.  By default, average CO2 
cost estimates are used. 

• Override Rebound Effect:  Overrides the Rebound Effect value read in from the 
parameters file with a user defined value.  Valid values are between -1.00 and 1.00. 

• Override Discount Rate:  Overrides the Discount Rate value read in from the parameters 
file with a user defined value.  Valid values are between 0.00 and 1.00. 

• Override Value of Travel Time per Vehicle:  Overrides the Value of Travel Time per 
Vehicle value read in from the parameters file with a user defined value. 

• Override Military Security Cost:  Overrides the Military Security component of 
economic costs read in from the parameters file with a user defined value. 

• Scale Consumer Benefits During Effects Calculations:  Specifies whether the model 
should scale the private consumer benefits by a specific percentage during the effects 
calculations.  Valid values are between 0.00 and 1.00. 
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Figure 24. Parameters Overrides Panel 
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E.4.3 Manage Optimization Window 
 
The Manage Optimization window (Figure 25) provides additional options necessary for 
configuring the system for optimization modeling. 
 
The first set of options determines the type of optimization – that is, which fleet the model 
should optimize: 

• Cars:  Forces the modeling system to optimize vehicles regulated as passenger 
automobiles only.  If the market data input file contains any vehicles regulated as light 
trucks, the value of CAFE standard for those vehicles will be kept at a constant value 
throughout optimization. 

• Trucks:  Forces the modeling system to optimize vehicles regulated as light trucks only.  
If the market data input file contains any vehicles regulated as passenger automobiles, the 
value of CAFE standard for those vehicles will be kept at a constant value throughout 
optimization. 

• Auto-detect:  Allows the model to automatically determine whether to optimize 
passenger automobiles or light trucks.  This option is useful if the market data input file 
contains only one class of vehicles (e.g., cars-only or trucks-only).  If the market data file 
includes a mixed fleet of vehicles (passenger autos and light trucks), this option should 
not be used. 

 
The next set of options determines the optimization mode the model should use when identifying 
the optimum value of the CAFE standard: 

• Optimize based on maximum Net Benefits:  Specifies that the optimization model should 
optimize the value of CAFE standard based on the difference between the discounted 
social benefits and technology costs, by maximizing that difference. 

• Optimize by minimizing Net Benefits, after the maximum has occurred:  Specifies that 
the optimization model should optimize the value of CAFE standard based on the 
difference between the discounted social benefits and technology costs, by finding the 
lowest positive difference after the maximum difference has occurred. 

 
Additional optimization options are: 

• Iterations above optimum:  Indicates the number of iterations to examine above the 
initially calibrated shape of the target function, by moving the asymptotes upward in 
GPM space.  Increasing the asymptotes produces a less stringent value of CAFE 
standard.  Valid values are between 0 and 1000. 

• Iterations below optimum:  Indicates the number of iterations to examine below the 
initially calibrated shape of the target function, by pushing the asymptotes down in GPM 
space.  Decreasing the asymptotes produces a less stringent value of CAFE standard.  
Valid values are between 0 and 1000. 

• Increment by:  Specifies the value by which to increment the target function in GPM 
space.  Valid values are between 0.00001 and 0.1. 
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• Begin optimizing starting with the specified year:  Specifies the first model year to 
optimize. 

 

 
Figure 25. Manage Optimization Window 
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E.4.4 Manage Monte-Carlo Window 
 
The Manage Monte-Carlo window (Figure 26) provides additional options necessary for 
configuring the system for Monte-Carlo modeling.  During modeling, the system may 
automatically generate a new set of trial pairs to use for analysis, or use an input file that was 
previously generated during an earlier run.  When generating trial pairs, each new trial pair may 
consist of multiple Monte-Carlo trials – one for each discount rate analyzed. 
 
Upon completion of the modeling process, the system may also be configured to generate 
Monte-Carlo log files. 
 

 
Figure 26. Monte-Carlo Model Settings Panel 
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E.5 CAFE Model Usage Examples 
 
This section provides examples for configuring and running the CAFE Model sessions using 
various model types. 
 
E.5.1 Example 1 – Configuring for Standard Compliance Modeling 
 
This example demonstrates the steps necessary for configuring the modeling system to perform a 
regular Compliance Model run. 

• Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

• Select File > New Session to create a new modeling session.  The Modeling Settings 
window appears.  Note the errors at the bottom of the window; these indicate that the 
input files have not been selected. 

• On the General Compliance Settings panel, select the Standard Compliance Model as 
in Figure 27 below. 

 

 
Figure 27. Select Standard Compliance Model 
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• Click on the Input Settings panel to select the input files to use for modeling (Figure 28).  
Note that once all the input files have been selected appropriately, the error messages 
disappear. 

 

 
Figure 28. Select Input Files 
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• On the Output Settings panel, select the location for output files and all of the available 
modeling reports (Figure 29). 

 

 
Figure 29. Select Output Location and Modeling Reports 
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• The Runtime Settings panel is not used for this exercise. 

• Click the Save button to save the modeling settings and load the input files (Figure 30). 
 

 
Figure 30. Save Modeling Settings 
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• Once loading completes, click the Close button to return the main CAFE Model 
window.  A new Compliance Model session, titled “Session 1” has now been created 
(Figure 31). 

 

 
Figure 31. New Compliance Model Session Created 
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• Save the new session by selecting File > Save Session As....  Enter “demo.cmsd” in the 
dialog box that appears, and click the Save button (Figure 32). 

 

 
Figure 32. Save New Session 
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• After the session has been saved, notice the title of the session has changed to “demo” 
(Figure 33). 

 

 
Figure 33. “demo” Session Saved 
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• Select File > Start Modeling to start the compliance modeling process.  As the model 
runs, the progress of the Compliance Model is displayed in the session window (Figure 
34). 

 

 
Figure 34. Modeling Progress from the Compliance Model 
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• After modeling has completed, the “Modeling Completed!” message appears at the 
bottom of the main CAFE Model window (Figure 35). 

 

 
Figure 35. Compliance Model Completed 

 

• Select View > Output Location to open Windows Explorer and browse to the location 
where model outputs for the “demo” session are saved. 

• Exit the session by selecting File > Close Session. 

• Exit the CAFE Model by selecting File > Exit, or proceed to the next example. 
 
  



DRAFT – December 2011 

112 

E.5.2 Example 2 – Configuring for Optimization Modeling 
 
This example demonstrates how the take an existing session created in Example 1 – Configuring 
for Standard Compliance Modeling, and modify it to run the Optimization Model. 

• Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

• Select File > Open Session to open an existing modeling session.  Select “demo.cmsd” 
in the dialog box that appears, and click the Open button (Figure 36). 

 

 
Figure 36. Open “demo” Session 
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• Once the session has been loaded, select View > Modeling Settings to bring up the 
Modeling Settings window.  There select the Optimization Model as in Figure 37. 

 

 
Figure 37. Select Optimization Model 
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• Under the Input Settings panel, select a market data file containing data for the light 
truck fleet only, as well as a scenarios file required for optimization modeling (Figure 
38). 

 

 
Figure 38. Select Scenarios File for Optimization 
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• On the Output Settings panel, deselect all report types except for “Industry Compliance 
Summary” and “Industry Effects Summary” (Figure 39). 

o **Note:  the Optimized Industry Report is generated automatically as long as the 
“Do not generate any modeling reports” option is not selected. 

 

 
Figure 39. Select Reports for Optimization Modeling 

 

• Click the Save button to save the updated modeling settings; then click Close, once 
saving completes. 
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• Select View > Optimization Settings to bring up the Manage Optimization window, 
then configure the system for optimization modeling as specified in Figure 40.  (**Note:  
with this version of the model, the system has been modified from using linear/additive 
stringency increments to multiplicative stringency increments.  Hence, setting the 
increment incorrectly may lead to undesired behavior.) 

 

 
Figure 40. Configure Optimization Model Settings 

 

• Click the Save button to save the Optimization Model settings; then click Close. 
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• To prevent overwriting results from the “demo” session, select File > Save Session As... 
to save the modified session with a new name.  For this example, the optimization session 
was saved as “demo-opt.cmsd” (Figure 41). 

 

 
Figure 41. Save Modified Session 
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• Select File > Start Modeling to start the optimization modeling process.  As the model 
runs, the progress of the Optimization Model is displayed in the session window (Figure 
42). 

 

 
Figure 42. Modeling Progress from the Optimization Model 

 

• After optimization modeling has completed, the “Modeling Completed!” message 
appears at the bottom of the main CAFE Model window.  Select File > Exit to exit the 
model. 
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